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Walk-Through Examples
The AFT Fathom Walk-Through Examples are designed to get new users trained to use AFT Fathom cor-
rectly in the shortest amount of time. If you are using AFT Fathom for the first time, start with the Beginner 
- Three Reservoir Example because it offers an in-depth explanation of how to use AFT Fathom. Other-
wise, choose an example from the table below that you wish to learn more about. For examples using the 
AFT Fathom Add-on Modules, see the AFT Fathom Modules Overview.

Completed versions of the example model files are included with the default installation: C:\AFT Product-
s\AFT Fathom 13\Examples

Example Complexity Fluid Pipes Pumps Description

Beginner - Three 
Reservoir Beginner Water 3 -

A new AFT Fathom user 
should start here. Get in-
depth instructions of 
model building by solving 
a classic three reservoir 
flow problem. Learn how 
to define a fluid in Analysis 
Setup, place pipes and 
junctions on the Work-
space, define pipes and 
junctions, use the Model 
Data window, run a model, 
use the Output window, 
generate graphs in the 
Graph Results window, 
and view results in the 
Visual Report window.

Sizing a Pump Beginner Water 2 1

Learn how to size a pump 
to get the desired flowrate 
and head through an open 
system. Explore the dif-
ferences between the Siz-
ing and Pump Curve 
features in the Pump junc-
tion. See how to interpret 
results, select a pump 
curve, and generate a 
Pump vs. System curve 
graph.

Control Valve Beginner Water 2 -

Learn about the Control 
Valve junction and how to 
use the Valve Summary 
tab in the Output window. 
See how to use the results 
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Example Complexity Fluid Pipes Pumps Description

to adjust the pipe size until 
reaching a desired min-
imum pressure drop 
across the control valve.

Heat Transfer in a 
Pipe Beginner Water 1 -

Learn how to enable heat 
transfer calculations in 
Analysis Setup and how to 
use the Convective Heat 
Transfer model on the 
Heat Transfer tab of the 
Pipe Properties window. 
See how to use the Output 
Control window to display 
relevant heat transfer out-
put parameters.

Heat Exchanger 
System Beginner Water 7 1

Learn how to define a 
Resistance Curve in a 
Heat Exchanger junction 
and how to size a pump in 
a closed system. See how 
to use the Pump Summary 
and Heat Exchanger Sum-
mary tabs in the Output 
window and how to gen-
erate a Pump vs. System 
Curve in the Graph Res-
ults window.

Spray Discharge 
System Beginner Water 11 -

Learn how to define the 
Spray Discharge junction 
using the Cd Spray Loss 
Model. See how to use the 
Output Control window to 
display the discharged 
flow rate parameter. Fin-
ally, learn how to enable 
the Isometric Grid on the 
Workspace, route pipes 
on the grid, and rotate junc-
tions.

Pump Sizing and 
Selection with Flow 

Control Valves
Beginner Water 9 1

Learn how to resolve the 
Reference Pressure 
Needed window that may 
appear when modeling 
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Example Complexity Fluid Pipes Pumps Description

pumps and flow control 
valves in series. See how 
to use the results to select 
a pump curve for the sys-
tem.

Freon Delivery Sys-
tem with Heat 

Transfer
Beginner R11 and 

R123 7 1

Learn how to enable heat 
transfer, use a NIST 
REFPROP fluid, and use 
the Convective Heat 
Transfer model in a Heat 
Exchanger junction. See 
how to view and interpret 
temperature results in the 
Pipes section of the Out-
put window.

Cooling System Beginner Water 20 2

Learn how to import pump 
curve data to evaluate the 
performance of different 
pump curves. See how to 
use the Pump Summary 
tab in the Output window 
to view the power con-
sumed by the pumps.

Housing Project Beginner Water 25 -

Learn how to use Scenario 
Manager and Global Pipe 
Edit to rapidly change 
pipes sizes to analyze dif-
ferent system con-
figurations. Also see how 
Assigned Flow junctions 
and Special Conditions 
work.

Beginner - Cost 
Calculation Beginner Water 10 1

Learn how to add, con-
nect, and use both engin-
eering and cost libraries. 
See how to define the 
Cost Settings panel in Ana-
lysis Setup, include 
objects in the cost cal-
culations, and view the 
Cost Report in the Output 
window.

Non-Newtonian Beginner Phosphate 2 1 Learn how to use and com-
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Example Complexity Fluid Pipes Pumps Description

Phosphates Pump-
ing

pare the Homogeneous 
Scale-up, Power Law, and 
Bingham Plastic non-New-
tonian viscosity models in 
a simple system.

NFPA Firewater 
System Beginner Water 71 -

Learn how to enable 
NFPA calculations in the 
Miscellaneous group in 
Analysis Setup. Explore 
how to use Groups to cre-
ate an NFPA Report. See 
where to find the NFPA 
Report in the Output win-
dow.

Crude Oil Pipeline Intermediate Viscous 
Fluid 3 1

Learn how to specify a 
User Defined Fluid. See 
how results change when 
using the Viscosity Cor-
rection on the Optional tab 
of the Pump Properties 
window. Explore the sens-
itivity of junction elevation 
of pump speed as it 
relates to pressure in the 
system.

Hot Water System Intermediate Water 24 3

Learn how to add, con-
nect, and use a library to 
define a pump curve. See 
how to use Global Junc-
tion Edit to rapidly apply 
changes. Explore how to 
use the Pump Con-
figurations feature and 
Scenario Manager to ana-
lyze the performance 
effects of impeller size and 
pump speed.

Plant Cooling Cost 
Calculation Intermediate Water 34 4

Explore how to create cost 
libraries for pipe materials, 
pipe fittings and losses, 
and junctions. Learn how 
to use the Library Man-
ager window to connect lib-
raries. See how to 
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Example Complexity Fluid Pipes Pumps Description

interpret the Cost Report 
in the Output window.

Non-Newtonian 
Mill Discharge 

Slurry
Intermediate

Mill Dis-
charge 
Slurry

1 -

Learn how to use raw rhe-
ological data to define the 
Bingham Plastic, Power 
Law, and Homogeneous 
Scale-up viscosity models. 
See how the various vis-
cosity models produce dif-
ferent results using the 
Multi-Scenario Output fea-
ture.

Flow Induced Vibra-
tion Calculations Intermediate Water 7 -

Learn how to analyze the 
cause and concerns of 
Flow Induced Vibration 
(FIV) using the Excel 
Export Manager and Vibra-
tion Analysis Spread-
sheet.

Beginner - Three Reservoir 

Summary

This example provides an overview of AFT Fathom's layout and structure. The basic features will be 
used to build a three-pipe, four-junction model to solve the classic three-reservoir problem.

Topics Covered

 l Drawing the system with pipes and junctions
 l Entering pipe and junction properties
 l Completing Analysis Setup

Required Knowledge

No previous experience with AFT Fathom is required to complete this example. It begins with the most 
basic elements of laying out the pipes and junctions and solving the system hydraulics with the Newton-
Raphson methodology.



Walk-Through Examples

- 10 -

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Beginner - Three Reservoir.fth

 Step 1. Start AFT Fathom

ØTo start AFT Fathom, click Start on the Windows taskbar, choose AFT Fathom 13, and launch the pro-
gram. (This refers to the standard menu items created by setup. You may have chosen to specify a dif-
ferent menu item during installation).

As AFT Fathom starts, the  start-up screen, as shown in Figure 1, appears with several options before to 
start building a model. Some of the actions available are:

 l Open a recent model, browse to a model file, or browse to an Example
 l Activate an Add-on Module
 l Select ASME Water or a recently used fluid to be the Working Fluid
 l Review or modify Modeling Preferences

 l Select a Unit System
 l Filter units to include Common Only or Common Plus Selected Industries
 l Choose a Grid Style
 l Select a default Pipe Material

 l Access other Resources, such as Quick Start Guides, Help Files, and Video Tutorials

Note: If you are working through the Metric Units version of the Examples, be sure to specify either 
Metric Only or Both with Metric Defaults as the unit set by modifying the Modeling Preferences.
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Figure 1: AFT Fathom 13 Start-Up Window

After clicking the Start Building Model button on the start-up window, the Workspace window is initially 
always the active (large) window, as seen in Figure 2. The  tabs such as "Workspace" in the AFT Fathom 
window represent the Primary Windows. Each Primary Window contains its own toolbar that is displayed 
directly beneath the Primary Window tabs.

AFT Fathom supports dual monitor usage. You can click and drag any of the primary window tabs off of 
the main AFT Fathom window.  Once you drag one of the primary windows off of the AFT Fathom win-
dow, you can move it anywhere you like on your screen, including onto a second monitor in a dual mon-
itor configuration. To add the primary window back to the main Fathom primary tab window bar, simply 
click the X button in the upper right of the primary window.

To ensure that your results are the same as those presented in this documentation, this example should 
be ran using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

The Workspace window

The Workspace window is the primary vehicle for building your model. This window has three main 
areas: the Toolbox, the Quick Access Panel, and the Workspace itself. The Toolbox is the bundle of tools 
on the far left. 

The Quick Access Panel is on the right. It is possible to minimize the Quick Access Panel by clicking on 
the thumbtack pin in the upper right of the Quick Access Panel in order to allow for greater Workspace 
area.  

The Workspace takes up the rest of the window.

Quick-Access-Panel.html
WorkspaceWindow.html
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You will build your pipe flow model on the Workspace using the Toolbox tools. At the top of the Toolbox is 
the Pipe Drawing Tool and Annotation Tool. The Pipe Drawing tool, on the upper left, is used to draw new 
pipes on the Workspace. The Annotation tool allows you to create annotations and auxiliary graphics.

Below the two drawing tools are twenty-three icons that represent the different types of junctions avail-
able in AFT Fathom. Junctions are objects that connect pipes and also influence the pressure or flow 
behavior of the pipe system. The twenty-three junction icons can be dragged from the Toolbox and 
dropped onto the Workspace.

When you pass your mouse pointer over any of the Toolbox tools, a tooltip identifies the tool's function.

 
Figure 2: The Workspace window is where the model is built

 Step 2. Complete the Analysis Setup

ØNext, click Analysis Setup on the Toolbar that runs across the top of the AFT Fathom window. This 
opens Analysis Setup (see Figure 3). Analysis Setup contains seven groups (additional groups will be dis-
played if the GSC, XTS or ANS modules are active). Each group needs to be completed (indicated with 
a green checkmark next to the group name) before AFT Fathom allows you to run the Solver.

Analysis Setup can also be accessed by clicking on the Status Light on the Quick Access Panel. Once 
the Analysis Setup is complete, the Model Status light turns from red to green.

Quick-Access-Panel.html
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Figure 3: The Analysis Setup tracks the model’s status and allows users to specify required parameters

A. Define the Modules Group

Although Analysis Setup initially opens to the Fluid panel of the Fluid Properties group, the first group, 
Modules, always has a green check when you start AFT Fathom because there are no modules activated 
by default. No further input is required here for this example.

B. Define the Fluid Properties Group

Next is the Fluid Properties group. This group allows you to specify your fluid properties (density, 
dynamic viscosity, and optional vapor pressure), viscosity model, heat transfer, and fluid corrections. 
Start by clicking on Fluid to open the Fluid panel (see Figure 4).

You can model the fluid properties using the following data sources:

 1. AFT Standard: This fluid model uses fluid data from the AFT Standard library. These fluid prop-
erties are either temperature dependent or dependent on the solids concentration. Type in the 
desired condition (e.g., temperature), click the Calculate Properties button and the required prop-
erties are calculated. Users can add their own fluids to this option. This model supports heat trans-
fer analysis if specific heat and thermal conductivity data is included. Custom fluids are created by 
opening the Library Manager window from the Library menu or by clicking the Edit Fluid List button 
on the Fluid panel.

 2. User Specified Fluid: This fluid model allows you to directly type in the density, viscosity and 
vapor pressure. You cannot perform heat transfer analysis with a User Specified Fluid fluid.

 3. User Library Fluid: This fluid model allows you to select user created fluids that are stored in the 
user's Fluid Library. You can perform heat transfer analysis with a User Library Fluid fluid if 
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specific heat, thermal conductivity, enthalpy data has been included in the fluid properties.
 4. ASME Steam/Water: This fluid model obtains water data from the ASME Steam tables built into 

AFT Fathom. It also supports steam data, which can be used in AFT Fathom if incompressible.
 5. NIST REFPROP: This fluid model allows you to select a single fluid or create a mixture of fluids 

from the REFPROP list. These fluid properties are pressure and temperature dependent, 
although some are temperature dependent only. This fluid model supports heat transfer analysis.

 6. Chempak Fluid: This fluid model allows you to select a single fluid or create a mixture of fluids 
from the Chempak list. These fluid properties are pressure and temperature dependent, although 
some are temperature dependent only. This fluid model supports heat transfer analysis. Chempak 
is an optional add-on.

After selecting ASME Steam/Water, NIST REFPROP, or Chempak Fluid, you must then select a Fluid 
Phase: Liquid or Gas.  Then, upon entering a pressure, AFT Fathom will display a temperature range 
applicable to liquid or gas, depending upon which was selected.

Note: Because heat transfer has a significant impact on compressible flow fluid properties and AFT 
Fathom calculates flow on an incompressible basis, heat transfer is disabled when Gas is selec-
ted as the Fluid Phase.

ØSelect AFT Standard, by clicking the radio button next to the name. Then choose Water (liquid) from 
the list and click Add to Model. The properties for AFT Standard water are given only as a function of tem-
perature. Enter 21 deg. C in the temperature box and click the Calculate Properties button.

ØCheck the groups on the left side of Analysis Setup and you should now see the second group is 
checked complete with green checkmarks.

Figure 4: The Fluid panel lets you enter physical properties

On the Viscosity Model panel, users can specify how AFT Fathom will treat viscosity. By default, New-
tonian is the viscosity model selected. AFT Fathom offers a variety of non-Newtonian models. However, 
for this example, the default selection of Newtonian will suffice.

On the Heat Transfer/Variable Fluids panel, users can specify variable fluid properties or enable heat 
transfer. For models with variable fluid properties, the values for density and viscosity are default fluid 
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properties. You can then enter different property values, if desired, for any pipe in the Pipe Properties win-
dow. Fluids that allow heat transfer can be modeled by choosing the Heat Transfer with Energy Balance 
option. In this case, you will be required to also enter heat transfer information for the pipes and tem-
perature for some of the junctions. By default, Constant Fluid Properties is selected and will suffice for 
this example.

On the Laminar and Non-Newtonian Corrections panel, users can specify the type of corrections that 
the solver will apply when flow is laminar or if a non-Newtonian viscosity model is selected. The default 
selections are applicable for most cases, so no input is required for this example.

C. Define the Pipes and Junctions Group

In order to fully define this group, there needs to be pipes and junctions on the Workspace. To lay out the 
classic three-reservoir model, you will place the three reservoir junctions and a branch junction on the 
Workspace. Then you will connect the junctions with pipes.

To go back to the Workspace and save the inputs made in Analysis Setup, click OK.

I.  Place the first reservoir

ØTo start, click on and drag a reservoir junction from the Toolbox and drop it on the Workspace. 
Figure 5 shows the Workspace with one reservoir.

Objects and ID numbers

Items placed on the Workspace are called objects. All objects are derived directly or indirectly from the 
Toolbox. AFT Fathom uses three types of objects: pipes, junctions, and annotations. 

All pipe and junction objects on the Workspace have an associated ID number. For junctions, this num-
ber is, by default, placed directly above the junction and prefixed with the letter J. Pipe ID numbers are 
prefixed with the letter P. You can optionally choose to display either or both the ID number and the name 
of a pipe or junction. You also can drag the ID number/name text to a different location to improve vis-
ibility.

The reservoir you placed on the Workspace will take on the default ID number of 1. You can change this 
to any desired number greater than zero and up to 99,999.

Editing on the Workspace

Once on the Workspace, junction objects can be moved to new locations and edited with the features on 
the Edit menu. Cutting, copying, and pasting are all supported.
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Figure 5: Three Reservoir Problem with one reservoir placed

II. Place the second and third reservoirs

The remaining two reservoirs can be created the same way as the first one or they can be derived from 
the existing reservoir.

ØTo create a second reservoir from the existing one, select junction J1 by clicking it with the mouse. 
A red outline will surround the junction. Choose Duplicate from the Edit menu and move the J2 junction to 
the right of J1. Your Workspace should appear similar to that shown in Figure 6.

If you like, you can Undo the Duplicate operation and then Redo it to see how these editing features 
work. To undo an operation, click on the undo button on the Toolbar or choose Undo from the Edit menu. 
To redo an operation, choose Redo from the Edit menu. 

ØTo create the third junction, select one of the two reservoirs on the Workspace and once again 
choose Duplicate from the Edit menu. Arrange the three junctions, numbered J1, J2, and J3, as shown in 
Figure 7.
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Figure 6: Three Reservoir Problem with two reservoirs placed

 
Figure 7: Three Reservoir Problem with three reservoirs placed

III. Place a branch junction
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ØTo add a Branch junction, select a Branch from the Toolbox and place it on the Workspace as shown 
in Figure 8. The Branch will be assigned the default number J4.

Note: The relative location of objects in AFT Fathom is not important. Distances and heights are 
defined through dialog boxes. The relative locations on the Workspace establish the con-
nectivity of the objects, but have no bearing on the actual length or elevation relationships.

ØBefore continuing, save the work you have done so far. Choose Save As from the File menu and 
enter a file name (Three Reservoir Problem, perhaps) and AFT Fathom will append the .fth extension to 
the file name.

 
Figure 8: Three Reservoir Problem with all junctions placed

IV. Draw a pipe between J1 and J4

Now that you have four junctions, you need to connect them with pipes.

ØTo create a pipe, click the Pipe Drawing tool icon. The pointer will change to a crosshair when you 
move it over the Workspace. Draw a pipe above the junctions, similar to that shown in Figure 9.

The pipe object on the Workspace has an ID number (P1) shown near the center of the pipe. 

ØTo place the pipe between J1 and J4, use the mouse to grab the pipe in the center, drag it so that its 
left endpoint falls within the J1 Reservoir icon, then drop it there (see Figure 10). Next, grab the right end-
point of the pipe and stretch the pipe, dragging it until the endpoint terminates within the J4 Branch icon 
(see Figure 11).
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Figure 9: Three Reservoir Problem with first pipe drawn

 
Figure 10: Three Reservoir Problem with first pipe inlet end connected



Walk-Through Examples

- 20 -

 
Figure 11: Three Reservoir Problem with first pipe connected

Reference positive flow direction

Located on the pipe is an arrow that indicates the reference positive flow direction for the pipe. AFT 
Fathom assigns a flow direction corresponding to the direction in which the pipe is drawn. You can 
reverse the reference positive flow direction by choosing Reverse Direction from the Arrange menu or 
selecting the reverse direction button on the Workspace Toolbar.

In general, the reference positive flow direction indicates which direction is considered positive. 
However, when used with pumps and certain other junction types the pipes must be in the correct flow dir-
ection because that is how AFT Fathom determines which side is suction and which is discharge. If the 
reference positive direction is the opposite of that obtained by the Solver, the output will show the flow 
rate as a negative number.

V. Add the remaining pipes

A faster way to add a pipe is to draw it directly between the desired junctions.

ØActivate the pipe drawing tool again (double-click to allow pipe drawing tool to stay active). Position 
the cursor on the J4 Branch. Press and hold the left mouse button. Stretch the pipe to the J2 Reservoir 
then release the mouse button. Then draw a third pipe from the J4 Branch to the J3 Reservoir. Your 
model should now look similar to Figure 12. In Figure 12, the J3 label has been moved slightly to the left 
(using drag-and-drop) so it is more visible.

At this point all the objects in the model are graphically connected. Save the model by selecting Save 
from the File menu or Toolbar.
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Note: It is generally desirable to lock your objects to the Workspace once they have been placed. This 
prevents accidental movement and disruption of the connections. You can lock all the objects 
by choosing Select All from the Edit menu, then selecting Lock Object from the Arrange menu. 
The lock button on the Toolbar will appear depressed indicating it is in an enabled state, and will 
remain so as long as any selected object is locked. Alternatively, you can use the grid feature 
enabled from the Arrange menu or the User Options under the Tools menu bar and specify that 
the pipes and junctions snap to grid.

 
Figure 12: Three Reservoir Problem with all objects connected

VI. Define the pipes and junctions

To fully define the Pipes and Junctions group in Analysis Setup, all pipes and junctions must be con-
nected and have the proper input data. 

Object status

Every pipe and junction has an object status. The object status tells you whether the object is defined 
according to AFT Fathom's requirements. To see the status of the objects in your model, click the flood-
light icon on the Workspace Toolbar (alternatively, you could choose Show Object Status from the View 
menu). Each time you click the floodlight, Show Object Status is toggled on or off.

When Show Object Status is on, the ID numbers for all undefined pipes and junctions are displayed in 
red on the Workspace. Objects that are completely defined have their ID numbers displayed in black. 
(These colors are configurable through User Options from the Tools menu.)
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Because you have not yet defined the pipes and junctions in this sample problem, all the objects' ID num-
bers will change to red when you turn on Show Object Status.

Undefined Objects window

The Undefined Objects window lists all undefined pipes and junctions and further displays the items that 
are not yet defined.

VII. Define Reservoir J1

ØTo define the first reservoir, open the J1 Reservoir Properties window (see Figure 13) by double-
clicking the J1 icon. Enter a reservoir Liquid Surface Elevation of 90 meters. You can assign any unit of 
length found in the adjacent dropdown list of units.

Note: You can also open an object's Properties window by selecting the object (clicking on it) and then 
either pressing the Enter key or clicking the Open Pipe/Jct Window icon on the Toolbar.

ØEnter a Liquid Surface Pressure of 0 barG (0 kPa (g)) and a Pipe Depth of 0 meters.

Note: You can specify preferred units for many parameters (such as meters for length) in the User 
Options window.

You can give the object a name, if desired, by entering it in the Name field at the top of the window. In Fig-
ure 13, the name of this reservoir is Supply Tank A. By default the junction’s name is the junction type. 
The name can be displayed on the Workspace, Model Data or in the Output.

Most junction types can be entered into a custom library allowing the junction to be used multiple times or 
shared between users. To select a junction from the custom library, choose the desired junction from the 
Library list. The current junction will get the properties from the library junction.

The Copy Data From Jct list will show all the junctions of the same type in the model. This will copy the 
selected parameters from an existing junction in the model to the current junction.

The pipe table on the Pipe Depth & Loss Coefficients tab allows you to specify entrance and exit loss 
factors for each pipe connected to the reservoir (in this case there is one). You can enter standard losses 
by selecting the option buttons at the right. The default selection is the Custom option with loss factors 
specified as zero. To later change the loss factors, click within the pipe table and enter the loss. You can 
also specify a depth for the pipe.

The Optional tab allows you to enter different types of optional data. You can select whether the junction 
number, name, or both are displayed on the Workspace. Some junction types also allow you to specify 
an initial pressure as well as other junction specific-data. The junction icon graphic can be changed, as 
can the size of the icon.

Design Alerts can be entered for most junctions, which are applied to the pressure loss calculations for 
the junction in order to give additional safety margin to the model.

Each junction has a tab for Notes, allowing you to enter text describing the junction or documenting any 
assumptions.

The Status tab will list undefined parameters of the junction.
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The highlight feature displays all the required information in the Properties window in light blue as shown 
in Figure 13. The highlight is on by default. You can toggle the highlight off and on by double-clicking any-
where in the window or by pressing the F2 key. The highlight feature can also be turned on or off by 
selecting it on the User Options menu.  For the remainder of the examples, we will keep the highlight fea-
ture turned off.

ØClick OK. If Show Object Status is turned on, you should see the J1 ID number turn black again, telling 
you that J1 is now completely defined.

 
Figure 13: Properties window for Reservoir J1

The Inspection feature

You can check the input parameters for J1 quickly, in read-only fashion, by using the Inspection feature. 
Position the mouse pointer on J1 and hold down the right mouse button. An information box appears, as 
shown in Figure 14.

Inspecting is a faster way of examining the input in an object than opening the Properties window.
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Figure 14: Inspecting from the Workspace with right mouse button

VIII. Define junctions J2, J3, and J4

 1. J2 Reservoir
 a. Liquid Surface Elevation = 60 meters
 b. Liquid Surface Pressure = 0 barG
 c. Pipe Depth = 0 meters (default)

 2. J3 Reservoir
 a. Liquid Surface Elevation = 30 meters
 b. Liquid Surface Pressure = 0 barG
 c. Pipe Depth = 0 meters (default)

ØOpen the J4 Branch Properties window (see Figure 15). In this window, all three connecting pipes 
should be displayed in the pipe table area. You could associate loss factors with each pipe by clicking 
within the pipe table and entering the data.

ØEnter an elevation of zero meters for the J4 Branch junction (an elevation must be defined for all 
junctions). You could also click the Optional tab then specify a flow source or sink at the junction; for now 
leave this as zero. Click OK. All the junctions have now been defined.

ØSave the model again before proceeding.
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Figure 15: Properties window for Branch J4

IX. Define Pipe P1

Data for pipes and junctions can be entered in any order. In this example, we did the junctions first. The 
next step is to define all the pipes. To open the Pipe Properties window, double-click the pipe object on 
the Workspace.

ØFirst open the Pipe Properties window for Pipe P1 (see Figure 16). For Pipe P1, enter a length of 
300 meters, select the Pipe Material as Steel - ANSI, Size of 8 inch , and Type as STD (schedule 40). 
Click OK. Pipe P1 is now defined.

The Pipe Properties window

The Pipe Properties window offers control over all important flow system parameters that are related to 
pipes.

The Inspect feature also works within the Pipe Properties window. To Inspect a connected junction, pos-
ition the mouse pointer on the connected junction's ID number and hold down the right mouse button. 
This is helpful when you want to quickly check the properties of connecting objects. (You can also use 
this feature in junction Properties windows for checking connected pipe properties.)

By double-clicking the connected junction number, you can jump directly to the junction's Properties win-
dow. Or you can click the Jump button to jump to any other part of your model.
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Figure 16: Properties window for Pipe P1

X. Define Pipes P2 and P3

Both pipes have a Pipe Material of Steel - ANSI, Size of 8 inch, and Type of STD (Schedule 40).

 1. P2 Length = 600 meters
 2. P3 Length = 900 meters

The Pipes and Junctions group should now be complete. Everything is ready to submit to the Solver. 

ØBefore running the model, save it  one more time. It is also a good idea to review the input using the 
Model Data window.

D. Define the remaining groups in Analysis Setup

Open Analysis Setup once more to confirm that all groups are defined. No inputs or alterations are 
required to complete the last three groups: Steady Solution Control, Environmental Properties, and Mis-
cellaneous. All seven groups should have a green checkmark next to its name. Click OK.

D. Review input in the Model Data window

The Model Data window is shown in Figure 17. To change to this window, you can select it from the 
Primary Window tabs, Window menu, or pressing CTRL+M. The Model Data window gives you a text-
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based perspective of your model. Selections can be copied to the clipboard and transferred into other 
Windows programs, saved to a formatted file, printed to an Adobe PDF, or printed out for review.

Data is displayed in three general areas. The top is called the general area, the middle the pipe area and 
the bottom the junction area. 

The Model Data window allows access to all Properties windows by double-clicking the appropriate ID 
number in the far left column of the table. You may want to try this right now.

 
Figure 17: The Model Data window shows all input in text form

 Step 3. Run the Solver

ØClick Run Model from the Toolbar or from the Analysis Menu. During execution, the Solution Pro-
gress window is displayed (see Figure 18). You can use this window to pause or cancel the Solver's activ-
ity. When the solution is complete, the Output, Visual Report, and Graphs Results windows can be 
accessed directly from the Solution Progress window.  Click the Output button and the text-based Output 
window will appear (see Figure 19). The information in the Output window can be reviewed visually, 
saved to file, exported to a spreadsheet-ready format, copied to the clipboard, printed to an Adobe PDF 
file, and printed out on the printer.
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Figure 18: The Solution Progress window displays the convergence progress

 
Figure 19: The Output window displays output in text form
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 Step 4. Review the output

The Output window is similar in structure to the Model Data window. Three areas are shown, and you can 
minimize or enlarge each area by clicking the arrow next to the General, Pipes, and Junctions tabs or 
from the View menu.

A. Specify output control

By default, AFT Fathom has a predefined set of Output Control parameters that are specified and the 
default units used depend on which unit set was selected when first running AFT Fathom (see Figure 1).  
A default title is also assigned in the Output Control.  

ØOpen Output Control from the Tools menu (Figure 20). Click the General tab, enter a new title (if you 
like you can title this Classic Three-Reservoir Problem), then click OK to accept the title and other default 
data.

In addition, this window allows you to select the specific output parameters you want in your output. You 
also can choose the units for the output. 

 
Figure 20: The Output Control window lets you customize the output

B. Modify the output format
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If you selected the default AFT Fathom Output Control, the Pipe Results table will show volumetric flow 
rate in the second column (Figure 19) with units of m3/hr (cubic meters per hour).

 l ØSelect Output Control from the Tools menu or Toolbar. On the right side of the Pipe tab is 
the list of selected output parameters. Click Volumetric Flow Rate and change the units by select-
ing m3/min (cubic meters per minute) from the list at the bottom.

 l ØClick OK to display changes to the current results. You should see the volumetric flow rate 
results, still in the second column, in units of m3/min. Notice the Velocity results in the third 
column.

 l ØSelect Output Control from the Tools menu one more time. The reorder icons on the left 
side of the Output List allows you to reorder parameters in the list.

 l ØSelect the Velocity parameter and use the Reorder scroll bar to move it up to the top of the 
parameter list.

 l ØClick OK to display the changes to the current results. You will see in the Pipe Results 
table that the first column now contains Velocity and the third column contains the volumetric flow 
rate. The Output Control window allows you to obtain the parameters, units and order you prefer in 
your output. This flexibility will help you work with AFT Fathom in the way that is most meaningful 
to you, reducing the possibility of errors.

 l ØLastly, double-click the column header Velocity in the Output window Pipe Results 
Table. This will open a window in which you can change the units again if you prefer. These 
changes are extended to the Output Control parameter data you have previously set.

C. View the Output on the Workspace with Workspace Layers

 l ØReturn to the Workspace window by choosing it from the Window menu, clicking on the Work-
space tab on the tool bar, or by pressing CTRL+W. Workspace Layers allows you to integrate 
your text results with the graphic layout of your pipe network.

 l ØSelect the Workspace Layers tab at the bottom right of the screen within the Quick Access 
Panel. Select the layer named All Objects Layer and then select the single gear icon above to edit 
the Layer Settings. Alternatively, while hovering over the layer name, the Layer Settings icon will 
be revealed to the right. Select the Pipe Parameters tab and search for Volumetric Flow Rate with 
the Filter or within the Pipe Parameters list. Double click Volumetric Flow Rate to add it to the 
Workspace Layer. Select the Junction Parameters tab and search for both Junction Name and the 
Pressure Static Inlet. After adding these parameters to the display list, press Close. Rearrange the 
labels as desired for readability.
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Figure 21: The Layer Settings window selects visible parameters for the Workspace Layers

 
Figure 22: The Workspace window displays input and output data utilizing Workspace Layers

D. Graph the results
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ØChange to the Graph Results window by clicking the Graph Results tab. The Graph Results window 
offers full-featured Windows plot preparation.

The Graph Parameters menu will automatically be displayed in the Quick Access Panel on the far right of 
the Graph Results Window and is where you are to specify which graphs to generate.  

The Profile graph tab in the Graph Parameters menu will also be selected by default on Quick Access 
Panel. Make sure the Plot Single Path option is selected from the Pipes drop-down menu. Select pipes 1 
and 2 from the pipes list. Choose Pressure Static from the Parameter drop-down menu. Make sure 
meters is selected as the Length Units and bar as the Pressure Static units (see Figure 23). Then click 
Generate. The Show Junction Locations feature  is located on the Graph Results toolbar and can be 
turned on by clicking the icon.

A graph appears showing the static pressure along the flow-path defined by pipes 1 and 2 in Figure 24.

You can use the other buttons in the Graph Results window to change the graph appearance and to save 
and import data for cross-plotting. The Graph Results window can be printed, saved to file, copied to the 
clipboard, or printed to an Adobe PDF file. The graph’s x-y data can be exported to file or copied to the 
clipboard.

Note that the graph guide, located at the top right of the Graph Results window and represented with the 
What Would You Like to Do? icon, can guide you through the development of your graph. This feature 
can be hidden by clicking on the icon.

 
Figure 23: The Graph Control window controls the Graph Results content
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Figure 24: The Graph Results window offers full-featured plot generation

Conclusion

You have now used AFT Fathom's Primary Windows and functions to build a simple model. Review the 
rest of the Fathom Help File contents for more detailed information on each of the windows and func-
tions.
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Sizing a Pump 

Summary

This example will walk you through a simple calculation to size a pump.

A pump is to be used to transfer water from a supply reservoir to a holding reservoir at the top of a hill. 
The system consists of a supply reservoir, a pump, a discharge reservoir, and two pipes.

The first pipe from the supply reservoir to the pump is 3 meters long, and the second pipe leading from 
the pump to the discharge reservoir is 300 meters long. Both pipes are 4 inch, Steel - ANSI, STD (Sched-
ule 40) pipes. Constant fluid properties are assumed.

The supply reservoir has a liquid surface pressure of 0 barG (0 kPa (g)), and the liquid surface is at an 
elevation of 3 meters. The discharge reservoir has a liquid surface pressure of 0 barG (0 kPa (g)), and 
the liquid surface is at an elevation of60 meters. The pipes for both reservoirs connect to the reservoirs at 
a depth of 3 meters.

What is the head requirement for a pump to supply flow in this system at 115 m3/hr?

Topics Covered

 l Specifying a pump in the Pump Properties Window
 l Defining pipe fittings and losses lumped into a pipe
 l Sizing a pump
 l Entering pump curve data

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Sizing a Pump.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

Figure 1: Workspace for Sizing a Pump Example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties. The required information is highlighted in blue. 
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Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 4 inch 
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Lengths = 

Pipe Length (meters)

1 3

2 300

The pipe model also allows for fittings and losses like valves or elbows. Select the Fittings & Losses tab 
for P2, and type in 25 for the Total K Factor. Now click OK to close the Pipe Properties window and 
accept your changes.

Note: A red ampersand (&) will now appear next to the pipe number for pipe P2. This indicates that Fit-
tings & Losses are entered in the Pipe Properties window. This symbol can be edited or hidden 
in User Options.

Junction Properties

 1. J1 Reservoir 
 a. Name = Lower Reservoir
 b. Liquid Surface Elevation = 3 meters
 c. Liquid Surface Pressure = 0 barG (0 kPa (g))
 d. Pipe Depth = 3 meters

 2. J2 Pump 
 a. Inlet Elevation = 0 meters
 b. Pump Model = Centrifugal (Rotodynamic)
 c. Analysis Type = Sizing
 d. Parameter = Volumetric Flow Rate
 e. Fixed Flow Rate = 115 m3/hr

 3. J3 Reservoir 
 a. Name = Upper Reservoir
 b. Liquid Surface Elevation = 60 meters
 c. Liquid Surface Pressure = 0 barG (0 kPa (g))
 d. Pipe Depth = 3 meters

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
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have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 5. Examine the Output

The Output window (Figure 2) contains all the data that was specified in the output control window. 
Because we were interested in the pump requirements for this system, select the Pump Summary tab in 
the General (top) window. The pump data can also be found in the Junction (bottom) window. We are 
primarily interested in the pump head (or pressure) requirement. This information can be found in the 
Pump Summary window.

 Select Output Control from the Common Toolbar or Tools menu to open the Output Control window. 
Click the General tab, enter the title Water Transfer System, then click OK to save the title.

For this system, the head requirement of the pump is 116.3 meters. Because the difference in elevation 
of the reservoirs was 57 meters this is the minimum head rise regardless of flow rate or pipe size. Coin-
cidentally, the friction loss was also approximately 59 meters. This can be seen in the dH column of the 
Pipe output window.

Figure 2: Output window for Pump Sizing Example
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 Step 6. Add a Pump Curve

Now that the pump head requirement has been identified as 116.3 meters at the design flow rate of 115 
m3/hr, a pump of the correct size can be purchased to meet this requirement. Once the actual pump has 
been identified, the pump characteristics can be added to the pump by adding the pump curve data to the 
pump junction.

Open the Pump Properties window and enter the following data:

 1. Pump Model = Centrifugal (Rotodynamic)
 2. Analysis Type = Pump Curve
 3. Enter Curve Data

 a. Flow Q Parameter = Volumetric
 b. Head/Pressure dH Parameter = Head

Volumetric Head

m3/hr meters

0 122

115 116

230 76

 c. Curve Fit Order = 2
 d. Click Generate Curve Fit Now
 e. Click OK

Note: This is a situation where a user could create a new scenario using the Scenario Manager to 
examine a what-if situation, without disturbing the basic model. For an example that illustrates 
how to use the Scenario Manager, see the Water to Housing Project example.
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Figure 3: The Pump Configuration Window is used to enter pump curve data

 Step 7. Re-evaluate the model

Re-run this model. Examine the Pump Summary in the General Output Section. The output (Figure 4) 
shows the pump operating at a flow rate of 114.7 m3/hr, and a head rise of 116.1 meters, which is accept-
ably close to the previous sizing calculation.
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Figure 4: Output when running with a pump curve

Change to the Graph Results window (e.g., using the Windows menu), and click on the Pump vs. System 
tab (Figure 5) in the Graph Parameters menu on the Quick Access Panel. Click Generate to graph a 
pump vs. system curve, as shown in Figure 6.

Figure 5: Select Graph Data for creating a pump vs. system curve
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Figure 6: Pump vs. system curve using selected pump

Conclusion

AFT Fathom can be used to size pumps. Once the actual pump has been selected, the model can be 
modified to include the actual pump curve data. Then the actual system properties and behavior can be 
calculated.
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Control Valve 

Summary

This will walk you through a simple calculation to calculate a pipe size for a control valve system. Water 
will be flowing from a reservoir on a hill down to another reservoir. The pipe must be sized correctly to 
allow 57 m3/hr to flow from one reservoir to the other. A control valve is used to control this flow, but the 
valve must have a minimum pressure drop of 0.65 bar (65 kPa) to operate correctly. Only STD (schedule 
40) pipes will be considered.

Topics Covered

 l Using flow control valves
 l Entering and changing pipe size data

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Control Valve.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

Figure 1: Workspace for Control Valve Problem

The system is in place but now we need to enter the properties of the objects. For this example, we need 
to find the correct pipe size but we are limited to STD (schedule 40) pipe sizes. We need to use our engin-
eering judgment to take an initial guess at the pipe size for 57 m3/hr. Let’s try 3 inch pipe. Specify the 
pipes as the following:

Pipe Properties

 1. All Pipes
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 3 inch
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 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Length = 30 meters

Junction Properties

 1. J1 Reservoir
 a. Name = Upper Reservoir
 b. Liquid Surface Elevation = 12 meters
 c. Liquid Surface Pressure = 0 barG
 d. Pipe Depth = 0 meters

 2. J2 Control Valve
 a. Inlet Elevation = 3 meters
 b. Valve Type = Flow Control (FCV)
 c. Control Setpoint = Volumetric Flow Rate
 d. Flow Setpoint = 57 m3/hr

 3. J3 Reservoir
 a. Name = Lower Reservoir
 b. Liquid Surface Elevation = 3 meters
 c. Liquid Surface Pressure = 0 barG
 d. Pipe Depth = 0 meters

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 5. Examine the Output

Open the Output Control window by selecting Output Control from the Output toolbar or Tools menu. This 
window allows the user to specify the output from the Fathom simulation. The window starts with a 
default set of output parameters which you are free to change.

In this example, we want to review the effects of changing the nominal pipe size. To simplify this, lets add 
this parameter to the output. 

 1. From the Pipes output list, select the parameter Nominal Size in the list on the left.
 2. Click Add (or double-click the parameter), which adds the parameter to the list on the right.



Control Valve

- 45 -

 3. Use the Reorder buttons (in the upper right) to move the Nominal Size up so that it becomes the 
second parameter in the list (see Figure 2).

 4. Click OK.

 
Figure 2: Output Control Window

The Output window contains all the data that was specified in the output control window. The output is 
shown in Figure 3. In the summary window, there is a Valve Summary tab. Select this tab. You can see 
that the flow control valve achieved the flow rate of 57 m3/hr but the pressure drop (dP) is only 0.08327 
bar (8.327 kPa) (see Figure 3). The pressure drop requirement is 0.65 bar (65 kPa) minimum. This pres-
sure drop is too low. The pipe size needs to be increased. 
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Figure 3: Output Window for Control Valve Example

 Step 6. Change Pipe Sizes

Go back to the Workspace and change the pipe properties to a new pipe size. By trial and error, you can 
determine that by using 4 inch for both pipes, a pressure drop of 0.6797 bar (67.97 kPa) can be obtained 
(see Figure 4). 

 
Figure 4: Output Window for modified Control Valve Example

Conclusion

To meet the system requirements, use 4-inch pipe.
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Heat Transfer in a Pipe 

Summary

The objective of this example is to demonstrate how to calculate heat transfer in a pipe. For this example 
we will specify a mass flow rate and an inlet temperature and calculate the outlet temperature and total 
heat loss for a 30 meter section of pipe.

Topics Covered

 l Modeling heat transfer in a single pipe

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Heat Transfer in a Pipe.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C
 d. This calculates the default fluid properties to use in the model to initialize the heat transfer 

calculations.
 3. Open the Heat Transfer/Variable Fluids panel:

 a. Heat Transfer = Heat Transfer With Energy Balance (Single Fluid)

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

Although one pipe is all that we are modeling, we still need junctions at each end to define the pressure 
and flow conditions for this pipe.

 
Figure 1: Workspace for Heat Transfer Problem

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties. The required information is highlighted in blue. 

Pipe Properties

Because heat transfer was selected on the Heat Transfer/Variable Fluids panel in Analysis Setup, the 
Pipe Properties window has an additional tab to define: Heat Transfer. We will use Convective Heat 
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Transfer for this example. Fathom allows you to perform a layered heat transfer analysis with internal and 
external convection coefficients and conduction through multiple insulation layers. For this example, we 
will consider the internal convection, conduction through the pipe wall, and external convection as affect-
ing heat transfer in our system. 

Pipe P1

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 6 inch
 b. Type = STD (schedule 40)
 c. Friction Model Data Set = Standard
 d. Length = 100 meters

 2. Heat Transfer tab
 a. Heat Transfer Model = Convective Heat Transfer
 b. Ambient Conditions

 i. Temperature = 0 deg. C
 ii. Fluid Velocity = 30 km/hr
 iii. Fluid = Air

 c. Fluid Internal
 i. Apply = Checked
 ii. Conductivity/Convection Data Source = Correlation
 iii. HT Area Ratio = 1
 iv. Convection Coefficient = Gnielinski

 d. Pipe Wall
 i. Apply = Checked
 ii. Conductivity/Convection Data Source = Material Library
 iii. Conductivity = From Library
 iv. Thickness = 0.7111999 cm
 v. HT Area Ratio = 1

 e. External
 i. Apply = Checked
 ii. Conductivity/Convection Data Source = Correlation
 iii. HT Area Ratio = 1
 iv. Convection Coefficient = Forced (Churchill-Bernstein)

The heat transfer window looks like Figure 2 below.
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Figure 2: Pipe properties window for Heat Transfer Problem

Junction Properties

Now that the pipe is defined, specify the junction properties:

 1. J1 Assigned Pressure
 a. Elevation = 0 meters
 b. Pressure = 3.45 bar (345 kPa)
 c. Temperature = 65 deg. C
 d. Pressure Specification = Stagnation

 2. J2 Assigned Flow
 a. Elevation = 0 meters
 b. Type = Outflow
 c. Flow Specification = Mass Flow Rate
 d. Flow Rate = 4.5 kg/sec

Note: The temperature at J2 will not be used by Fathom because the outlet temperature of the pipe is 
defined by the inlet temperature pipe due to the Assigned Pressure junction and the heat loss 
through the pipe. 

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.
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 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 5. Examine the Output

Open the Output Control window by selecting Output Control from the Output toolbar or Tools menu. 
From the Display Parameters tab, Pipes selection, double-click the parameters Heat Flux, Heat Rate, 
Temperature Inlet, and Temperature Outlet in the left list  to add these output parameters to this model. 
Click OK to return to the Output window.

The Output window contains all the data that was specified in the output control window. Because we 
added Inlet and Outlet temperatures to the output, we can see that the outlet temperature is 59.70 deg. 
C. The output is shown in Figure 3 below. 

Note: If the default Output Control parameters are being displayed, a warning will be shown stating 
the HGL, EGL, and head loss results may not be meaningful for variable density systems as 
can be seen in Figure 3. If all head output parameters are hidden using Output Control, this 
warning will no longer appear.

Figure 3: Output window for Heat Transfer Problem
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Heat Exchanger System 

Summary

This example will walk you through a simple calculation to size a pump for a closed loop heat exchanger 
system. First you will build the system with a fixed flow pump and then enter a pump curve that meets 
these requirements.

Topics Covered

 l Sizing a pump for a specific system
 l Entering a loss curve for a Heat exchanger
 l Graphing system curves versus pump curves

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Heat Exchanger System.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

 
Figure 1: Layout of Heat Exchanger Problem

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties. The required information is highlighted in blue. 

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 4 inch 
 d. Type = STD (schedule 40)
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 e. Friction Model Data Set = Standard
 f. Lengths = 

Pipe Length (meters)

1 60

2 5

3 30

4 30

5 60

6 5

7 60

Junction Properties

Specify each junction by entering the following properties in each corresponding Junction Properties win-
dow:

 1. J1 Heat Exchanger
 a. Inlet Elevation = 5 meters
 b. Loss Model = Resistance Curve
 c. Enter Curve Data =

Volumetric Pressure

m3/hr bar

0 0

25 0.35

50 1.4

 d. Curve Fit Order = 2
 e. Click Generate Curve Fit Now

 1. J2 & J7 Bend
 a. Inlet Elevation = 5 meters
 b. Type = Standard Elbow (knee, threaded)
 c. Angle = 90 Degrees

 2. J3 & J6 Bend
 a. Inlet Elevation = 0 meters
 b. Type = Standard Elbow (knee, threaded)
 c. Angle = 90 Degrees
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 3. J4 Assigned Pressure
 a. Elevation = 0 meters
 b. Pressure = 7 bar (700 kPa)
 c. Pressure Specification = Stagnation

 4. J5 Pump 
 a. Inlet Elevation = 0 meters
 b. Pump Model = Centrifugal (Rotodynamic)
 c. Analysis Type = Sizing
 d. Parameter = Volumetric Flow Rate
 e. Fixed Flow Rate = 25 m3/hr

 
Figure 2: Heat Exchanger Loss Curve Fit Specification

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the 
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results by clicking the Output button at the bottom of the Solution Progress window. 

 Step 5. Examine the Output

The Output window contains all the data that was specified in the output control window. Because we are 
interested in the pump requirements for this system, select the Pump Summary tab in the General (top) 
window. The pump data can also be found in the Junction window (bottom). If we are primarily interested 
in the head (or pressure) requirement, this is found in the summary window. 

For this system, the head requirement of the pump is 0.5359 bar (53.59 kPa) (5.472 meters). At the 
assigned flow rate of 25.00 m3/hr, the pressure drop across the heat exchanger was 0.3500 bar (35.00 
kPa) (3.574 meters) so the total pipe and elbow loss was approximately 0.1859 bar (18.59 kPa) (1.898 
meters). This output is shown in Figure 3a and Figure 3b.

 
Figure 3a: Pump Summary for Heat Exchanger Example

 
Figure 3b: Heat Exchanger Summary for Heat Exchanger Example

 Step 6. Add Pump Curve

Now that we know the general requirements of the pump, we can select an appropriate pump and enter 
this data. Open the Pump Properties window and enter the following data:

 1. Pump Model = Centrifugal (Rotodynamic)
 2. Analysis Type = Pump Curve
 3. Enter Curve Data

 a. Flow Q Parameter = Volumetric
 b. Head/Pressure dH Parameter = Head
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Volumetric Head

m3/hr meters

0 6

25 5.5

50 3.5

 c. Curve Fit Order = 2
 d. Click Generate Curve Fit Now

 Step 7. Re-evaluate the Model

Select Run Model from the toolbar or Analysis menu. Because the pump head at 25 m3/hr was slightly 
higher than required, the system will adjust with a slightly higher flow rate. The output of this run is shown 
in Figure 4.

Figure 4: Output window for Heat Exchanger Example with real pump data 

This system is a good example to demonstrate how to use the Graph Results Tab. Change to the Graph 
Results window by choosing it from the Window drop-down on the menu bar, clicking the Graph Results 
tab on the toolbar, or by pressing CTRL+G. Now the Graph Control window will be displayed on the 
Quick Access Panel as shown in Figure 5. Select Pump Curve vs. System Curve and Fathom auto-
matically selects the data you want to graph.
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Figure 5: Select Graph Data window for Heat Exchanger System

Click Generate to view this graph. This graph is shown in Figure 6. The red line shows the pump curve 
that we entered. This starts out with 6 meters of head available at 0 m3/hr and decreases slowly with 
increasing flow rate. The blue line is the overall system curve. The head requirement increases sig-
nificantly with flow rate. Most of the pressure loss (head loss) is through the heat exchanger but this 
graph also includes the pipe and elbow loss. The lines cross right at 25.06 m3/hr which is the operating 
point shown in the output in Figure 4.
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Figure 6: Pump Curve vs. System Curve for Heat Exchanger System
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Spray Discharge System 

Summary             

The objective of this example is to find the minimum supply pressure needed to supply a system of eight 
spray discharge heads with at least 25 m3/hr to each spray head. The system has one main supply line 
that branches into two supply lines that supply four sprayers each.

Topics Covered

 l Using spray discharge junctions
 l Iterating on a supply condition to reach a desired output condition
 l Using Isometric Pipe Drawing Mode

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Spray Discharge System.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

 
Figure 1: Workspace for Spray Discharge System

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties. The required information is highlighted in blue. 

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = Use table below
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Lengths = 
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Pipe Size Length (meters)

1 & 2 8 inch 150

3 4 inch 3

4 - 11 1-1/2 inch 3

Note: The Global Edit tool found in the Edit menu can be used to enter the data for pipes P4-P11 all at 
once. The Guide at the top right of the window can be used to walk you through how to global 
edit if needed.

Junction Properties

 1. J1 - J8 Spray Discharges
 1. Elevation = 3 meters
 2. Loss Model = Cd Spray (Discharge Coefficient)
 3. Geometry = Spray Nozzle
 4. Exit Properties = Pressure
 5. Exit Pressure = 0 barG (0 kPa (g))
 6. Cd (Discharge Coefficient) = 0.6
 7. Discharge Flow Area = 3.5 cm2

 2. J9 Assigned Pressure
 1. Elevation = 0.3 meters
 2. Pressure = 14 barG (1400 kPa (g))
 3. Pressure Specification = Stagnation

 3. J10 Branch
 1. Elevation = 3 meters

 4. J11 Branch & J12 Dead End
 1. Elevation = 0.3 meters

Note that the supply pressure is what we are trying to solve for, but we must supply a guess to start. We 
will need to iterate on the pressure at junction J9 to determine what the minimum pressure should be.

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 
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 Step 5. Examine the Output

Open Output Control by selecting Output Control from the toolbar or Tools menu. Click the Junctions but-
ton, then add Vol. Flow Rate Net At Junction to the shown junction output. This output will show the volu-
metric flow rate discharged from the spray nozzle. Click OK to save the changes and close Output 
Control.

The Output window contains all the data that was specified in the Output Control window. In the Junction 
output window at the bottom of the page there is a special tab for Spray Discharge, as shown in Figure 2. 
Select this tab and examine the flow rate out of each of these junctions. All flow rates are above 25 m3/hr 
so we must decrease the supply pressure and re-run the model. You should find that the supply pressure 
must be above 13.2 barG (1320 kPa-g) for the flow rate to meet the minimum flow rate at each spray 
nozzle.

This example may be solved directly using the GSC Module.

Note: The parameter Volumetric Flow Rate Through Junction is for junctions with a single inlet and 
outlet, and will thus display N/A for the Spray Discharge nozzles that aren't at the end of the 
branch. The parameter Volumetric Flow Rate Junction Net is used instead to display the total 
volumetric flow rate that is exiting each spray nozzle. 

 
Figure 2: Junction Output for Spray Discharge System with the supply pressure set to 14 barG (1400 kPa(g))

Figure 3 below displays the results for the final supply pressure of 13.2 barG (1,320 kPa(g)).
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Figure 3: Junction Output for Spray Discharge System with the supply pressure set to 13.2 barG (1320 kPa
(g))

 Step 6. Use the Isometric Grid

AFT Fathom allows the user to place pipe or junction objects anywhere in the Workspace. Objects are 
placed on a 2D grid by default, as was the case with this example. At times it may be convenient to 
demonstrate the three-dimensional nature of a system. For example, if you are building a model based 
on isometric reference drawings. AFT Fathom includes an isometric grid for these cases. The isometric 
grid has three gridlines that are offset by 60 degrees, representing the x, y, and z axes. Figure 4 shows 
the spray discharge system built on an isometric grid. The completed model file drawn in isometric can 
be seen in the Examples folder and is named Spray Discharge Isometric.

Figure 4: Spray discharge system with the isometric grid shown
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You can enable the isometric grid in AFT Fathom by going to the Arrange menu. Under Pipe Drawing 
Mode, there are three options: 2D Freeform (default), 2D Orthogonal, and Isometric.

Creating the spray discharge system on an isometric grid will demonstrate how to use this feature: 

 1. Go to the File menu and select New.
 2. Go to the Arrange menu again and under Pipe Drawing Mode, select Isometric
 3. Place a Spray Discharge junction, J1, on the Workspace. You will notice that placing junctions 

onto the Workspace follows the usual rules, however, the visual appearance of the icon is more 
complex than in a 2D grid. Due to the increased number of axes, the preferred icon and rotation 
must be selected to obtain visual consistency.

 4. Right click on J1 and select Customize Icon. Select the icon shown in Figure 5.

Note: If a junction in isometric mode has at least two pipes connected to it, the Auto-rotate Icon option 
can be selected instead of Customize Icon. Auto-rotate icon will automatically choose the icon 
orientation based on the connected pipes.

Figure 5: Right click on the junction to open the Customize Icon window and select the preferred icon and 
rotation

 5. Copy J1 for the other spray discharges, J2-J8, to maintain the preferred icon and rotation.
 6. Place the assigned pressure junction, J9, on the Workspace.
 7. Place two branch junctions, J10 and J11, on the Workspace.
 8. Place the dead end junction, J12, on the Workspace.
 9. Right click on J12 and select Customize Icon. Notice that you may need to use the Rotate button 

to get the preferred icon and rotation, as shown in Figure 6.
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Figure 6: Use the Rotate button to obtain the preferred icon and rotation

 10. Draw Pipes 1 and 2, as shown in Figure 4.
 11. Draw Pipe 3 from J11 to J10. A red-dashed preview line will show how the pipe will be drawn on 

the isometric grid. As you are drawing a pipe, you can change the preview line by clicking any 
arrow key on your keyboard or scrolling the scroll wheel on your mouse.

Figure 7 shows Pipe 3 being drawn with the preview line.

Figure 7: A preview line shows when drawing or adjusting pipes
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Note: You can hold the ALT key while adjusting a pipe by the endpoint to add an additional vertex. 
This can be used with the arrow key or mouse scroll wheel to change between different preview 
line options. 

 12. Draw Pipes 4-11, as shown in Figure 4.
 13. The grid can be shown or turned off in the Arrange menu. Figure 8 shows the completed model 

with the grid not shown.

Figure 8: Isometric spray discharge system with the grid not shown
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Pump Sizing and Selection with Flow Control Valves 

Summary

This example will demonstrate how to size and select pumps in a heat exchanger system with flow con-
trol valves. The system will pump water through a heat exchanger system from a supply tank at one elev-
ation and pressure to a receiving tank at a higher elevation and pressure. There will be two flow control 
valves operating in parallel. The control valves require a minimum pressure drop of 0.35 bar (35 kPa) in 
order to control the flow rate.

Topics Covered

 l Using flow control valves
 l Entering and changing pump data

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Pump Sizing and Selection with Flow Control Valves.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

 
Figure 1: Workspace for Pump Selection with Flow Control Valves Example

The system is in place but now the properties of the objects must be entered. 

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 2 inch
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 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Length =

Pipe Length (meters)

1 6

2 15

3 20

4 6

5 30

6 6

7 20

8 6

9 30

Junction Properties

 1. J1 Reservoir 
 a. Name = Supply Tank
 b. Liquid Surface Elevation = 1.5 meters
 c. Liquid Surface Pressure = 0.7 barG (70 kPa(g))
 d. Pipe Depth =1.5 meters

 2. J2 Pump
 a. Inlet Elevation = 0 meters
 b. Pump Model = Centrifugal (Rotodynamic)
 c. Analysis Type = Sizing
 d. Parameter = Volumetric Flow Rate
 e. Fixed Flow Rate = 50 m3/hr

 3. J3 Tee 
 a. Elevation = 0 meters
 b. Loss Model = Simple

 4. J4 & J7 Control Valve
 a. Inlet Elevation = 0 meters
 b. Valve Type = Flow Control (FCV)
 c. Control Setpoint = Volumetric Flow Rate
 d. Flow Setpoint = 25 m3/hr

 5. J5 & J8 Heat Exchanger
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 a. Inlet Elevation = 0 meters
 b. Loss Model = Resistance Curve
 c. Enter Curve Data = 

Volumetric Pressure

m3/hr bar

25 0.7

 d. Click Fill as Quadratic
 e. Curve Fit Order = 2
 f. Click Generate Curve Fit Now

 1. J6 Bend
 a. Inlet Elevation = 0 meters
 b. Type = Standard Elbow (knee, threaded)
 c. Angle = 90 Degrees

 2. J9 Reservoir 
 a. Name = Receiving Tank
 b. Liquid Surface Elevation = 3 meters
 c. Liquid Surface Pressure = 2 barG (200 kPa(g))
 d. Pipe Depth = 3 meters

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Resolve Reference Pressure Needed

Click Run Model on the toolbar or from the Analysis menu.

The Reference Pressure Needed window will appear (see Figure 2). This window is displayed when a 
model is constructed that does not have a unique solution. A common occurrence of this is when a model 
contains one or more sections that are completely bounded by known flow rates.  

In this case, because the pump has been designated as an assigned flow and the downstream control 
valves are flow control valves, there is no way to uniquely determine the pressure between the pump and 
the control valves without an additional reference pressure. The reference pressure is the pressure from 
which the other pressures in the system are derived. There can be more than one reference pressure, 
but there always has to be at least one.

For a more in-depth discussion of reference pressures, see the Fathom help file topic: Role of Pressure 
Junctions - Detailed Discussion

RoleofPressureJunctionsDetailedDiscussion.html
RoleofPressureJunctionsDetailedDiscussion.html
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Figure 2: Reference Pressure Needed window

Open the J7 Control Valve Property window, and make the following changes.

 1. Valve Type = Constant Pressure Drop (PDCV)
 2. Control Setpoint = Pressure Loss
 3. Pressure Drop = 0.35 bar (35 kPa)

 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 6. Examine the Output

We can look at the pump summary and see that the head at 50 m3/hr needs to be at least 55.35 meters 
(see Figure 3). The control valves both have enough pressure drop to control flow (see Figure 4).

Figure 3: Pump Summary window
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Figure 4: Valve Summary window

 Step 7. Enter a Pump Curve

Now we need to specify a real pump. We will enter in some pump data and create a pump curve with the 
curve fitting routines in Fathom. Use the Scenario Manager on the Quick Access Panel to create a child 
of the base scenario with a name of Pump Curve. Then in the Pump Curve scenario, open the Pump 
Properties window and enter the following data:

 1. J2 Pump
 a. Pump Model = Centrifugal (Rotodynamic)
 b. Analysis Type = Pump Curve
 c. Enter Curve Data = 

Volumetric Head

m3/hr meters

0 60

50 55

100 35

 c. Curve Fit Order = 2
 2. J7 Control Valve

 1. Valve Type = Flow Control (FCV)
 2. Control Setpoint = Volumetric Flow Rate
 3. Flow Setpoint = 25 m3/hr

Re-run the model and verify that the flow rate and pressure drop across the control valves is still within 
the limits.
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Freon Delivery System with Heat Transfer 

Summary

This example will model a Freon delivery system to supply Freon at 24 deg. C. As the engineer you will 
evaluate two candidate refrigerants (Refrigerant 11 and 123) to determine the best choice. We will also 
calculate the temperature of the hot water supply (i.e., heat exchanger Secondary Fluid) needed for the 
heat exchangers.

Topics Covered

 l Modeling heat transfer
 l Entering a resistance curve for a Heat Exchanger

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Freon Delivery System with Heat Transfer.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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 a. Fluid Library = NIST REFPROP
 b. Fluid = R11 (after selecting, click Add to Model)
 c. Fluid Phase = Liquid
 d. Pressure = 10.5 barG
 e. Temperature = -45 deg. C

 3. Open the Heat Transfer/Variable Fluids panel
 a. Select Heat Transfer With Energy Balance (Single Fluid)

This calculates the default fluid properties to use in the model to initialize the heat transfer calculations.

Note: When Heat Transfer is enabled the fluid properties in the Analysis Setup window are only used 
as an initial guess. The final fluid properties will be calculated by the Solver.

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

 
Figure 1: Model for Freon Delivery System

Now enter the properties for the pipes and the junctions. 

Pipe Properties
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 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 3 inch
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Lengths =

Pipe Length (meters)

1 - 2 3

3 - 6 1.5

7 9

 2. Fittings & Losses tab
 a. P3 - P6 only

 i. Click Specify Fittings & Losses
 ii. Bends tab
 iii. Standard Threaded, General, 90 deg. (C) Quantity = 1
 iv. Click OK

 3. Heat Transfer tab (Figure 2)
 a. Heat Transfer Model = Convective Heat Transfer
 b. Resistance Geometry = Radial
 c. Number of Insulation Layers = 1 External
 d. Ambient Conditions

 i. Temperature = 16 deg. C
 ii. Fluid Velocity = 8 km/hr
 iii. Fluid = Air

 e. Fluid Internal
 i. Apply = Checked
 ii. Conductivity/Convection Data Source = Correlation
 iii. HT Area Ratio = 1
 iv. Convection Coefficient = Gnielinski

 f. Pipe Wall
 i. Apply = Checked
 ii. Conductivity/Convection Data Source = Material Library
 iii. Conductivity = From Library
 iv. Thickness = 0.54864 cm
 v. HT Area Ratio = 1

 g. Insulation #1 (external)
 i. Apply = Checked
 ii. Conductivity/Convection Data Source = User Specified
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 iii. Conductivity = 0.7 W/m-K
 iv. Thickness = 3 cm
 v. HT Area Ratio = 1

 h. External
 i. Apply = Checked
 ii. Conductivity/Convection Data Source = Correlation
 iii. HT Area Ratio = 1
 iv. Convection Coefficient = Forced (Churchill-Bernstein)

Figure 2: Heat Transfer tab defined in the Pipe Properties window

Junction Properties

 1. J1 Reservoir 
 a. Name = Supply Reservoir
 b. Liquid Surface Elevation = 3 meters
 c. Liquid Temperature = -45 deg. C
 d. Update Density with Temperature = Checked
 e. Liquid Surface Pressure = 10.5 barG (1050 kPa(g))
 f. Pipe Depth = 0 meters

 2. J2 Pump
 a. Inlet Elevation = 0.5 meters
 b. Pump Model = Centrifugal (Rotodynamic)
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 c. Analysis Type = Pump Curve
 d. Enter Curve Data = 

Volumetric Head

m3/hr meters

0 7.5

45 7

115 4.5

 d. Curve Fit Order = 2
 3. J3 & J5 Branches

 a. Elevation = 0.5 meters
 4. J4 & J6 Heat Exchangers

 a. Inlet Elevation = 0.5 meters
 b. Loss Model tab

 i. Loss Model = Resistance Curve
 ii. Enter Curve Data = 

Volumetric Pressure

m3/hr bar

55 0.15

 iii. Click Fill As Quadratic
 iv. Curve Fit Order = 2
 v. Click Generate Curve Fit Now

 c. Thermal Data tab
 i. Thermal Model = Counter-Flow
 ii. Heat Transfer Area = 7.5 meters2
 iii. Overall Heat Transfer Coefficient = 2800 W/m2-K
 iv. Flow Rate =15 kg/sec
 v. Specific Heat = 4.2 kJ/kg-K
 vi. Inlet Temperature = 95 deg. C

Note: This secondary fluid inlet temperature will be the initial guess.

 5. J7 Reservoir 
 a. Name = Receiving Reservoir
 b. Liquid Surface Elevation = 3 meters
 c. Liquid Temperature = 24 deg. C
 d. Update Density with Temperature = Checked
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 e. Liquid Surface Pressure = 10.5 barG (1050 kPa(g))
 f. Pipe Depth = 0 meters

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 5. Examine the Output

When the Output is first shown, note that if the default Output Control parameters are being displayed, a 
warning will be shown stating the HGL, EGL and head loss results may not be meaningful for variable 
density systems. If all head output parameters are hidden using Output Control, this warning will no 
longer appear.

Open Output Control by selecting Output Control from the toolbar or Tools menu.  Select the Pipes button 
to display the pipe output parameters, and remove the Head Loss (dH) from the list of shown output by 
highlighting the parameter and selecting Remove under the table. Next add the Temperature Inlet and 
Temperature Outlet to the shown output by double-clicking those parameters in the list on the left. 

The Output window contains all the data that was specified in the output control window. The output from 
this model is shown in Figure 3. Now look at the outlet temperature of the last pipe (pipe 7). This is the 
temperature of the delivered Freon. The temperature is about 48.50 deg. C. This is significantly higher 
than the required temperature of 24 deg. C.

 
Figure 3: Pipe Output window for Freon Delivery System with water supply at 95 deg. C

Now iterate on the temperature of the secondary fluid in the heat exchangers to find the temperature 
required to produce an outlet temperature of 24.00 deg. C for pipe 7. The answer for this should be 57.8 
deg. C. The output for this run in shown in Figure 4.
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Figure 4: Output window for Freon Delivery System with water supply at 57.8 deg. C

Now change the fluid on the Fluid panel to R123 and repeat the analysis. For R123, the temperature 
water supply to the heat exchangers necessary to meet the temperature requirement should be higher, 
around 66.5 deg. C. If water supply temperature is the main criteria, Refrigerant 11 would be the best 
choice. 
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Cooling System 

Summary

The objective of this example is to determine how much flow will be delivered to the heat exchangers in 
the system. A secondary objective is to determine the best pump for the system.

Topics Covered

 l Modeling a closed loop system 
 l Using a pressure reducing valve
 l Generating a pump curve
 l Generating a resistance curve for a heat exchanger
 l Importing a pump curve to obtain pump data

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Cooling System.fth
 l Metric - Cooling System Pump A.txt
 l Metric - Cooling System Pump B.txt
 l Metric - Cooling System Pump C.txt

Note: If you open the completed Metric - Cooling System.fth model file, you will notice a child scen-
ario named Initial Model for ANS Quick Start Chapter 3. This child scenario is used as the 
starting point for a model in the ANS Quick Start Guide. This scenario can be disregarded when 
comparing your model to this completed model.

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Dowtherm J (after selecting, click Add to Model)
 c. Temperature = 65 deg. C

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

To add the segment into pipe P22, use the Pipe Segments tool on the Arrange menu.

 
Figure 1: Workspace window for Cooling System Problem

Pipe Properties
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 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = Use table below
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Lengths = Use table below

Pipe Size Length 
(meters)

1 6 inch 6

2, 7, 9-10, 20-
21 4 inch 1

3-6, 12-13, 
15-16, 18-19 4 inch 1.5

11, 14, 17 4 inch 3

8, 22 6 inch 60

Junction Properties

 1. J1 Reservoir 
 a. Liquid Surface Elevation = 3 meters
 b. Liquid Surface Pressure = 2.75 barG (275 kPa (g))
 c. Pipe Depth = 3 meters

 2. All Branches
 a. Elevation = 0.5 meters

 3. All Bends
 a. Inlet Elevation = 0.5 meters
 b. Type = Standard Elbow (knee, threaded)
 c. Angle = 90 Degrees

 4. J4 & J5 Pumps 
 a. Inlet Elevation = 0.5 meters
 b. Pump Model = Centrifugal (Rotodynamic)
 c. Analysis Type = Pump Curve
 d. Enter Curve Data = 

Volumetric Head

m3/hr meters

0 21.3
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Volumetric Head

m3/hr meters

115 18.3

230 12.2

 e. Curve Fit Order = 2
 5. All Control Valves

 a. Inlet Elevation = 0.5 meters
 b. Valve Type = Pressure Reducing (PRV)
 c. Control Setpoint = Pressure, Static
 d. Setpoint = 3.45 barG (345 kPa (g))

 6. All Heat Exchangers
 a. Inlet Elevation = 0.5 meters
 b. Loss Model = Resistance Curve
 c. Enter Curve Data = 

Volumetric Pressure

m3/hr bar

115 0.7

 d. Click Fill As Quadratic
 e. Curve Fit Order = 2

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 5. Examine the Output

The output is shown below in Figure 2. The pump summary shows that the head requirement for the 
pumps is 18.44 meters and 19.06 meters. The heat exchanger summary shows that the flow rates 
through the heat exchangers range from 66.60 m3/hr to 70.76 m3/hr. 
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Figure 2: Output Summary Windows for Cooling System example

 Step 6. Evaluate Other Pumps

The customer for this project wants an evaluation of three other pumps to determine which uses the least 
energy. The pump curve for each of these pumps is found in a text file. 

For each of the pumps follow the following set of steps:

 1. Create a child of the base scenario in the Scenario Manager on the Quick Access Panel for Pump 
A, Pump B, and Pump C.

 2. Load scenario Pump A, open the Pump Properties window, click Enter Curve Data
 3. Click Edit Table and select Import From File
 4. Change the file format to Text (*.txt) then select the data file Metric - Cooling System Pump 

A.txt and click Open. 
 5. Using the Comma Separator, click OK.
 6. With a Curve Fit Order of 2, click Generate Curve Fit Now, then click OK
 7. Select the second pump and set all the properties equal to the first pump. 

Run each scenario and take note of the overall pump power in the pump summary window. The data 
should match the following:

Pump J4 J5

A 4.340 kW 3.428 kW

B 5.198 kW 4.112 kW

C 4.970 kW 3.296 kW

From this data, Pump A is the best choice, because it consumes the least power.
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Housing Project 

Summary

The objective of this example is to model a pipeline system to supply water to a new housing devel-
opment. As the engineer you will evaluate the design to find the smallest pipe size that will still meet the 
water supply requirements.

No Fire Conditions: 

Each house requires 2.5 m3/hr at a minimum of 4.0 barG (400 kPa(g)).

Fire Conditions: 

Each house requires 0.5 m3/hr with no minimum pressure. One fire hydrant may be open at a time and 
requires 20 m3/hr at 6.2 barG (620 kPa(g)) static.

Topics Covered

 l Using Scenario Manager

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Housing Project - Initial.fth
 l Metric - Housing Project.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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 Step 2. Open the model

Open the Metric - Housing Project- Initial.fth model file listed above, which is located in the Examples 
folder in the AFT Fathom application folder. Save the file to a different folder.

The model should appear as shown in Figure 1.

Figure 1: Initial model for Housing Project example

 Step 3. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 16 deg. C

 Step 4. Define the Pipe and Junction Properties

The fire hydrants are both turned off to begin the problem. Select the Optional tab in the Assigned Flow 
Properties window and select Flow Off to close the hydrant. Do this for both hydrants.
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Pipe Properties

All the mains are to be the same size. We will try 3, 3 ½ , and 4 inches to see which one meets the require-
ments. Enter 3-inch pipe for the main and hydrant supply lines in the base case.

 1. Pipe Model tab
 a. Pipe Material = PVC - ASTM
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = Use table below
 d. Type = schedule 40
 e. Friction Model Data Set = Standard
 f. Lengths = Use table below

Pipe Size Length 
(meters)

1 3 inch 610

10 & 20 3 inch 90

101-105 
& 201-205 3 inch 60

199 & 299 3 inch 3

206 1 inch 45

108 & 207 1 inch 38

106, 110, 
208, & 210 1 inch 30

107, 109, 
& 209 1 inch 22

Junction Properties

 1. J1 Reservoir
 a. Name = West Lake
 b. Liquid Surface Elevation = 70 meters
 c. Liquid Surface Pressure = 0 barG (0 kPa (g))
 d. Pipe Depth = 0 meters

 2. Branches
 a. Elevation = Use table below
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Branch Elevation (meters)

203 -3

102-105 & 204 -1.5

101, 106, 202, & 205 0

201 & 206 1.5

 3. Assigned Flows
 a. Elevation = Use table below
 b. Type = Outflow
 c. Flow Specification = Volumetric Flow Rate
 d. Flow Rate = Use table below

Assigned 
Flow Name Elevation 

(meters)
Flow Rate 

(m3/hr)
Special 

Conditions

107 Browns 3 2.5 None

108 Peters 6 2.5 None

109 Chambers 10 2.5 None

110 Fords 4.5 2.5 None

111 Kellys 6 2.5 None

199 North Hydrant 1.5 20 Flow Off

207 Norths 6 2.5 None

208 Stewarts -4.5 2.5 None

209 Coles 9 2.5 None

210 Allens 3 2.5 None

211 Burns 1.5 2.5 None

299 South 
Hydrant 0 20 Flow Off

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

The flows will be varied based on the different scenarios examined. To do this, we need to create child 
scenarios. We will use the Scenario Manager to create the designs we need to evaluate.
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 Step 5. Manage the Scenarios

 1. In the Scenario Manager, create a child of this scenario by right-clicking on the Base Scenario and 
selecting Create Child. Name this child scenario 3 inch Pipe. This will be the parent scenario for all 

the runs with 3 inch main pipes. Alternatively, you can select the Create Child icon  on the 
Scenario Manager on the Quick Access Panel to create this child scenario.

 2. Select the 3 inch Pipe scenario and create another child, this one named Fire Flow. set the flow 
rate at each house to 0.5 m3/hr instead of 2.5 m3/hr. This will be the flow rate demand that needs 
to be met at the houses when either hydrant is open. 

 3. Next, create two children of this scenario named North Hydrant Fire and South Hydrant Fire. Load 
the North Hydrant Fire scenario from the Scenario Manager. Open the properties window of the 
North Hydrant and on the Optional tab, toggle the flow on by changing the special condition to 
None. 

 4. Now load the South Hydrant Fire scenario  turn on the South Hydrant.
 5. You now have all the scenarios that need to be evaluated for each pipe size but we still have two 

more pipe sizes that we need to investigate. 
 6. Right-click the 3 inch Pipe scenario and select Clone With Children.
 7. Name this scenario 3.5 inch Pipe. 
 8. Repeat this process to create another set of scenarios named 4 inch Pipe. The Scenario Manager 

on the Quick Access Panel should look like Figure 2.
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Figure 2: Scenario Manager for Water Supply to Housing Project

After creating the scenarios for the 3.5 inch pipe and 4 inch pipe, we need to open these scenarios and 
change the pipe sizes. This is accomplished most quickly with the Global Pipe Edit window. 

 1. Load the 3.5 inch Pipe scenario.
 2. Select Global Edit then Global Pipe Edit from the toolbar or Edit menu.
 3. Click the radio button for Pipe Template at the top, if not already selected, and click Select Pipe 

Data.
 4. Change the Size to 3-1/2 inch, click OK.
 5. In the Parameters to Change (Select in List) area, check the box next to Nominal Size 3-1/2 inch.
 6. Since we only want to apply this to certain pipes, select Special above the Pipe List.
 7. Change the Selection Type to Pipe Input Properties.
 8. For Pipe Property, select Pipe Inner Diameter.
 9. For Range, enter From 2.9 to 3.1 inches.

 10. Click Select Pipes and note that 15 of 25 pipes were selected, these are all the pipes that are cur-
rently 3 inches. Click OK.

 11. Click Apply Selections. A message should appear to inform you that changes were successively 
applied.

 12. Click OK.
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Repeat this process for the 4 inch Pipe scenario but changing the pipe size to 4 inch.

 Step 6. Specify Output

Before running the model, load the Base Scenario to set the Output Control. Open the Output Control win-
dow by selecting Output Control from the toolbar or Tools menu. This window allows the user to specify 
the output from the Fathom simulation. The window starts with a default set of outputs. Often the default 
output is sufficient. You may also specify a title for the model. Click on the General tab and add a title of 
Housing Project Example. On the Display Parameters tab, select the Junctions button and change the 
static and stagnation pressure units to barG. Click OK to save and close the Output Control

Now load the 3 inch Pipe scenario.

 Step 7. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 8. Examine the Output

The output from this model is shown in Figure 3. For the 3 inch Pipe scenario, with no hydrants open, the 
flow to each house is 2.5 m3/hr and the static pressure must be at least 4 barG (400 kPa(g)). The pres-
sure at each house is above 4 barG (400 kPa(g)), so the system with 3 inch mains would be sufficient.

Figure 3: Output window for 3 inch mains with no fire

On the Scenario Manager, load the North Hydrant Fire scenario under the 3 inch Pipe scenario. Run the 
model, and look at the output. This output is shown in Figure 4. Although the hydrant receives 20 m3/hr, 
the supply pressure is less than the required 6.2 barG (620 kPa(g)).



Housing Project

- 93 -

 
Figure 4: Output window for 3 inch mains with north hydrant fire

Because we know that 3 inch is sufficient for No Fire conditions, we only need to test the Fire conditions 
for each pipe size. The results of this testing are displayed in Table 1. After testing all the fire conditions, 
4 inch pipe is the only size that will deliver 6.2 barG (620 kPa(g)) to the North Hydrant during fire con-
ditions. Therefore, the housing development mains must be 4 inch pipe.

Table 1: Static pressure in barG at the open hydrant for each combination of pipe size and active hydrant

Fire Flow 
Location 3 inch 3.5 inch 4 inch

North Hydrant 
Fire 5.034 5.878 6.258

South 
Hydrant Fire 5.166 6.018 6.401
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Beginner - Cost Calculation 

Summary

This example demonstrates how to set up cost calculations in AFT Fathom. 

Determine the cost of the heat exchanger system over a 10-year period including material, installation, 
and energy costs.

Topics Covered

 l Estimating simple costs
 l Connecting cost libraries
 l Using Cost Settings
 l Using the Cost Report

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Beginner - Cost Calculation.fth
 l Controlled Heat Exchanger Temperature.dat - engineering library
 l Controlled Heat Exchanger Temperature - Junction Costs.cst - cost library for Controlled 

Heat Exchanger Temperature.dat
 l Controlled Heat Exchanger Temperature - Pipe Costs.cst - cost library for Steel - ANSI

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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If you have already worked the Controlled Heat Exchanger Temperature example for either the GSC or 
XTS modules, you can open the file you built for those examples, create a new scenario for this 
example, and then skip to Step 4.

Important: The XTS and GSC modules and cost calculations can be performed in the same run to 
simulate control functions over time, but we are not going to do this here. Before proceeding, 
make sure to disable GSC by selecting the radio button for Ignore under GSC in the Modules 
panel in Analysis Setup. Also, make sure to disable XTS by selecting Steady Only in the XTS 
section.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C
 d. This calculates the default fluid properties to use in the model to initialize the heat transfer 

calculations.
 3. Open the Heat Transfer/Variable Fluidspanel:

 a. Heat Transfer = Heat Transfer With Energy Balance (Single Fluid)

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 1: Workspace for Controlled Heat Exchanger Temperature example

Pipe Properties

 1. All Pipes
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 8 inch
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Length = 

Pipe Length (meters)

1 & 3-8 6

2 1.5

9 60

10 30

Junction Properties

 1. J1 & J9 Reservoirs
 a. Liquid Surface Elevation = 6 meters
 b. Liquid Temperature = 90 deg. C
 c. Update Density with Temperature = Checked
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 d. Liquid Surface Pressure = 0.3 barG (30 kPa (g))
 e. Pipe Depth = 0 meters

 2. J2 Pump 
 a. Inlet Elevation = 0 meters
 b. Pump Model = Centrifugal (Rotodynamic)
 c. Analysis Type = Pump Curve
 d. Enter Curve Data = 

Volumetric Head

m3/hr meters

0 20

115 18

230 12

 e. Curve Fit Order = 2
 3. J3 Three Way Valve                     

 a. Elevation = 0 meters
 b. Combined Flow = P2
 c. Split Flow Pipe #1 = P3
 d. Split Flow Pipe #2 = P9
 e. Loss Model = Cv
 f. Open Percentage Data = 

Open Pct. Cv Pipe #1 Cv Pipe #2

0 0 100

100 100 0

 g. Actual Percent Open = 75%
 4. J4, J7, & J8 Branch Junctions 

 a. Elevation = 0 meters
 5. J5 & J6 Heat Exchangers 

 a. Inlet Elevation = 0 meters
 b. Loss Model tab

 i. Loss Model = K Factor
 ii. K = 1400

 c. Thermal Data tab
 i. Thermal Model = Counter-Flow
 ii. Heat Transfer Area = 148 m2
 iii. Overall Heat Transfer Coefficient = 280 W/m2-K
 iv. Flow Rate = 90 kg/sec
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 v. Specific Heat = 4.2 kJ/kg-K
 vi. Inlet Temperature = 4.5 deg. C

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Define the Cost Settings group

To perform cost calculations they will first need to be enabled. Do this by opening Analysis Setup, nav-
igating to the Cost Settings panel , then selecting Calculate in the Cost Calculation section. If it is only 
desired to estimate energy costs, the Pump Energy Only option could be selected instead to simplify the 
input.

The Cost Settings panel is where the types of costs to be included in the cost calculations are specified. 
The Cost Settings panel is shown in Figure 2.

The Cost Definitions section allows you to specify the type of costs to be determined. You may select 
from engineering parameter costs, such as pipe weight, or actual monetary costs, including material and 
installation costs. For this example, select Monetary Costs, if not already selected. Include Material, 
Installation, and Operation/Energy costs by selecting them from the list of available monetary costs, as 
shown in Figure 2.

Energy cost data can be specified through an energy cost library, or by directly entering an energy cost 
on the Cost Settings panel. Using an energy cost library allows you to specify multiple energy costs, such 
as energy costs at both peak and off-peak rates. For this example, select Use This Energy Cost Inform-
ation and enter a Cost of 0.12 U.S. Dollars Per kW-hr, as shown in Figure 2.

The system lifetime to be applied for the cost calculations is specified in the Cost Time Period section. 
You can also specify interest and inflation rates to be applied to the cost calculations as well. For this 
example, enter a system life of 10 years, as shown in Figure 2, then close the Cost Settings panel by 
clicking the OK button.
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Figure 2: General cost calculation information is defined in the Cost Settings panel

 Step 5. Engineering and Cost Libraries

The actual material and installation costs that would be used with cost calculations are contained in cost 
libraries. The cost libraries needed for this example already exist, and just need to be accessed.

The Library Manager (opened from the Library menu) shows all of the available and connected libraries. 
Libraries can either be engineering libraries or cost libraries. Cost libraries are always associated with an 
engineering library, and are thus displayed subordinate to an engineering library in the library lists.

Here we will summarize some key aspects of libraries:

 l Cost information for a pipe is accessed from a cost library. Cost library items are based on cor-
responding items in an engineering library. (The engineering library also includes engineering 
information such as pipe diameters, hydraulic loss factors, etc.) 

 l To access a cost for a particular pipe or junction in a model, that pipe or junction must be based on 
items in an engineering library  that is connected to the model file.

 l There can be multiple cost libraries associated with and connected to an engineering library (such 
as regionally varying costs, or multiple foreign currencies). This makes it easier to manage costs 
of items.

Open the Library menu and select Library Manager. Click Add Existing Library, select the Controlled 
Heat Exchanger Temperature.dat engineering library from the AFT Fathom 13 Examples folder, and 
click Open. The engineering library titled Controlled Heat Exchanger Temperature should now appear 
in the list of available libraries.

Now add the cost libraries by clicking Add Existing Cost Library, and browsing to the Controlled Heat 
Exchanger Temperature - Junction Costs.cst and the Controlled Heat Exchanger Temperature - 
Pipe Costs.cst cost library files.

These libraries should connect automatically. If not, connect the newly added engineering and cost lib-
raries by checking the box next to the name in the list of available libraries.
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The Library Manager should appear as shown in Figure 3. The Library Manager window displays all of 
the available and connected libraries. 

Figure 3: Library Manager with engineering and cost libraries added and connected

The engineering libraries associated with these two cost libraries are the Steel - ANSI pipe material lib-
rary, and an external library called Controlled Heat Exchanger Temperature. For the cost data in the 
two cost libraries to be accessed by pipes and junctions in the model, the pipes and junctions must use 
these two engineering libraries.

The pipes for this example are already using data from the Steel - ANSI pipe material library, so no modi-
fications need to be made for the pipes. All of the junctions except the reservoir junctions must be mod-
ified to use the junction data contained in the engineering libraries. Do this by opening the properties 
window for each junction, and selecting the junction name displayed in the Library list, as shown in Figure 
4 for the Three-Way Valve Junction.
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Figure 4: The junctions to be included in the cost analysis must be associated with an engineering library

 Step 6. Including objects in the Cost Report

The final step before performing a cost analysis is to specify which pipes and junctions you want to be 
included in the final cost report. This is done by opening the properties window, navigating to the Cost 
tab, and choosing Include in Cost Report for each pipe and junction to be included, as shown for 
Pipe 1 in Figure 5.

The Global Edit feature may be used to update this information for all of the pipes and junctions.
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Figure 5: The Cost tab on the pipe and junction Properties windows is used to include the objects in the Cost 
Report

 Step 7. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 8. Examine the Cost Report

The Cost Report is displayed in the General Results section of the Output Window. View the Cost report 
by selecting the Cost Report Tab. The content of the Cost Report can be controlled from the Output Con-
trol window. Figure 6 shows the Cost Report for this example with the Material, Installation, Energy, and 
Total costs displayed.

The Cost Report shows the total system cost, as well as the individual totals for the material, installation, 
and energy costs. In addition, the Cost Report displays the detailed cost for each pipe, junction, and fit-
ting that was included in the report. The items are grouped together by type, and a subtotal for each cat-
egory is listed.
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Figure 6: The Cost Report in the General Output section shows the results of the cost analysis

Cost Analysis Summary

The cost analysis for this example shows the total system cost over 10 years for the heat exchanger sys-
tem is $99,001. Of that cost, $34,558 was for Material costs, $13,866 was for Installation costs, and 
$50,577 was energy cost over the life of the system.
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Non-Newtonian Phosphates Pumping 

Summary

This example demonstrates how to perform Non-Settling Slurry calculations in AFT Fathom to size a 
pump as part of a system design process.

Topics Covered

 l Entering rheological data
 l Using homogeneous scale-up features
 l Obtaining Power Law and Bingham Plastic constants

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Non-Newtonian Phosphates Pumping.fth
 l Metric - Non-Newtonian Phosphates Pumping Scale-up Data.txt
 l Metric - Non-Newtonian Phosphates Pumping Rheology Data.txt

Problem Statement

The piping for a non-settling slurry system which moves phosphate is being designed. The system will 
pump 1,080 m3/hr of phosphate through a horizontal pipe 700 meters long.

Use non-settling slurry calculations to size the pump for 1,080 m3/hr and alternate potential flows of 720 
and 1,440 m3/hr.

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Fluid panel

 a. Fluid Library = User Specified Fluid
 b. Name = Phosphate Slime
 c. Density = 1130 kg/m3
 d. Dynamic Viscosity = 1 centipoise (note that the viscosity entered here will not be used once 

the non-Newtonian parameters are entered).
 3. Viscosity Model panel

 a. Viscosity Model = Homogeneous Scale-up
 b. Entered Scaled Data: The data provided by Wilson, et al, 2006 for 203 mm (8 inch) pipe is 

as follows:
 i. Material = Steel - ANSI
 ii. Size = 8 inch
 iii. Type = STD (schedule 40)
 iv. Raw Data table = 

Table 1: Pressure drop data on phosphate slime from Wilson, et al, 2006 page 76 (203 mm/8 inch pipe)

Parameters Velocity Jm
Flow Regime

Units meters/sec m/m

1 0.53 0.089 Laminar

2 1.52 0.100 Laminar

3 2.00 0.102 Laminar

4 2.59 0.105 Laminar

5 3.24 0.108 Laminar

6 3.81 0.110 Laminar

7 4.43 0.113 Laminar

8 5.12 0.119 Turbulent

9 5.64 0.130 Turbulent

 1. In the table choose Velocity in meters/sec and Jm in m/m and use the Edit Table button to import 
the data from the Metric - Non-Newtonian Phosphates Pumping Scale-up Data.txt file. Altern-
atively, enter the data shown in Table 1 above, with the Flow Regime set to Laminar for the first 7 
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entries, and Turbulent for rows 8 and 9.
 2. Click Create Graph at the bottom.
 3. To see how the data will scale to 305 mm, choose the Cross-Plot Scale-Up Curves option, with 

Plot a Curve for Specific Pipe Size selected, specify the following parameters: Steel - ANSI, 12 
inch, and STD

 4. Click Update Graph at the bottom (see Figure 2)
 5. To see how Power Law and Bingham Plastic model would work for this data choose them in the 

Cross-Plot Correlation for Test Pipe Diameter area.
 6. Select OK

Figure 1: Non-Settling Slurry Scale-up test data entry
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Figure 2: Graph of Non-Settling Slurry scale-up data

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 3: Layout of pipe system for Non-Newtonian Phosphates Pumping Example

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 12 inch 
 d. Type = STD
 e. Length = 

Pipe Length

1 1 cm

2 700 meters

Junction Properties

 1. J1 & J3 Assigned Pressure
 a. Elevation = 0 meters
 b. Pressure = 0 barG (0 kPa(g))
 c. Pressure Specification = Stagnation

 2. J2 Pump
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 a. Pump Model tab
 i. Name = 1080 m3/hr
 ii. Inlet Elevation = 0 meters
 iii. Pump Model = Centrifugal (Rotodynamic)
 iv. Analysis Type = Sizing
 v. Parameter = Volumetric Flow Rate
 vi. Fixed Flow Rate = 1080 m3/hr
 vii. Nominal Efficiency = 75 Percent

 b. Optional tab
 i. Additional Efficiency Data

Motor Power Motor Eff. (%)

75 95

 ii. Power Units = kW

 Step 4. Create Two Alternate Cases

The example in Wilson et al, 2006, also requires evaluation of alternate flow rates. To create the altern-
ate cases do the following:

 1. Go to the Edit menu and click Select All
 2. From the Edit menu again, select Duplicate Special
 3. Increment All Pipe and Junction Numbers By = 10
 4. Click OK
 5. Move the duplicate below the first and click Paste
 6. Repeat steps 2-5 on the pipes and junctions that were duplicated
 7. For Pump J12, enter the following:

 a. Name = 720 m3/hr
 b. Fixed Flow Rate = 720 m3/hr

 8. For the J22, enter the following:
 a. Name = 1440 m3/hr
 b. Fixed Flow Rate = 1440 m3/hr

To show the names of the pumps and their head rise, a new Workspace Layer will be created.

 1. Select all pumps on the Workspace using a selection box (dragged from left to right) or holding 
CTRL while clicking each pump.

 2. In the Quick Access Panel, open the Workspace Layers tab.
 3. Create a new layer by selecting New Layer and then select the option From Workspace Selec-

tions in the drop-down menu. This creates a layer in which the selected objects and their labels 
are set to be visible.

 4. Name the layer Pump Labels.
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 5. Edit the layer by selecting it and clicking the gear icon to bring up the Layer Settings window or by 
double clicking on the layer name.

 6. Navigate to the Junction Parameters panel and expand the Commonly Used Junction Parameters 
list.

 7. Double-click Junction Name to add it to the list on the right-hand side. This will add the Junction 
Name to the pump labels.

 8. In the same panel, add Head Rise (m) to the label from the Pump Summary Parameters group.
 9. Close the Layer Settings window.

Note: The Head Rise parameter will be grayed out in the right hand column since there is not yet out-
put. After the model runs, this row will be white and each pump's head rise will be shown on the 
Workspace.

The workspace should resemble Figure 4.

Figure 4: Layout of pipe system for Non-Newtonian Phosphates Pumping Example with all three cases

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 
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 Step 6. Examine the Output

The Output window contains all the data that was specified in the Output Control window. 

Figure 5 shows the Output window and includes the Pump Summary tab. 

Figure 5: The Output window with default output data

The Output Control window can be used to customize the output and to add output parameters.

 1. Open Output Control from the toolbar or Tools menu
 2. In the Pipes section choose Head Gradient and add it to shown output. Then change its units to 

m/m. Head gradient is the same thing as Jm. See Figure 6.
 3. Next choose Pressure Gradient Stag. Total and add it.  Then change its units to bar/m.
 4. Select the Pumps button that runs along the top of Output Control.
 5. Choose Pressure Rise Stagnation and add it. Then change its units to m H2O std.. This is the 

head rise in terms of water head. See Figure 7.
 6. Click OK. The Output now appears as in Figure 8.

Table 3 summarizes the results from all three cases which agree well with those published by Wilson et 
al, 2006.
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Figure 6: The Output Control window Pipes report 
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Figure 7: The Output Control window Pumps report 

Figure 8: The Output showing head gradient, pressure gradient and pump water head rise
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Also of interest is the system curve. Navigate to the Graph Results window by clicking the Graph Results 
tab on the toolbar, or by pressing Control+G. On the Graph Control tab in the Quick Access Panel, select 
the Pump vs. System Curve tab if not already selected. CRV for Pump 2 should be selected, see Figure 
9. Click Generate.

The system curve is shown in Figure 10.

Figure 9: Data selection for graphing system curve
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Figure 10: System curve in Graph Results window

 Step 7. Compare Homogeneous Scale-Up to Power Law and Bingham Plastic 
Viscosity Models

Based on the fluid and flow regime and industry preference, a non-Newtonian model such as Power Law 
or Bingham Plastic may be preferred. How do those models compare to the Scale-up approach for the 
current example?

To perform the comparison, create two child scenarios. This can be done by opening the Scenario Man-
ager on the Quick Access Panel. Create two child scenarios and call them Power Law and Bingham 
Plastic.

Here the Power Law scenario will be reviewed. The Bingham Plastic scenario will be very similar and 
hence is not shown. Results for all three scenarios will be compared later in this example.

 1. Load the Power Law scenario
 2. Open Analysis Setup
 3. Open the Viscosity Model panel in the Fluid Properties group
 4. Click the Enter Scaled Data button
 5. Click the Graph tab
 6. Select the Cross-Plot Correlation for Test Pipe Diameter option
 7. Make sure the Power Law option is selected
 8. If not, select it and click Update Graph

Figure 11 shows that the Power Law correlation matches the data well. The Bingham Plastic correlation 
diverges from test data at higher flow rates.
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Figure 11: Non-Settling Slurry Scale-up data and Power Law (top) and Bingham Plastic (bottom) correlations
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 1. Click Cancel 
 2. Select Power Law from the drop down list of Viscosity Models
 3. Select Calculate from Rheological Data
 4. Click Calculate Constants 
 5. Make sure the Raw Data Type selection is Tube Flow Rheometer Data (8V/D)
 6. Enter the shear rate and shear stress data from Table 2, below. This data is equivalent to the data 

from Table 1, entered previously. Alternatively, use the Metric - Non-Newtonian Phosphates 
Pumping Rheological Data.txt file to import the shear rate and shear stress data into Fathom.

 7. Make sure the Shear Stress units are set to Pascals
 8. Click Generate Curve Fit Now
 9. Click OK

The data should be K = 28.28 kg/sec-m and n = 0.1364. See Figure 12. For the Bingham Plastic scenario 
the constants should be Plastic Viscosity= 0.03673 kg/sec-m and Yield Stress= 0.0004903 bar (0.04903 
kPa).

Table 2: Pressure drop data on phosphate slime from Wilson, et al, 2006 page 76 (203 mm/8 inch pipe) con-
verted into shear rate (8V/D) and shear stress (Tau)

Run
V Jm Shear Rate Shear Stress

meters/sec m/m 1/seconds Pascals

1 0.53 0.089 20.89 50.1

2 1.52 0.100 59.90 56.3

3 2.00 0.102 78.82 57.4

4 2.59 0.105 102.1 59.1

5 3.24 0.108 127.7 60.8

6 3.81 0.110 150.2 61.9

7 4.43 0.113 174.6 63.6

8 5.12 0.119 201.8 66.9

9 5.64 0.130 222.3 73.1
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Figure 12: Power Law data curve fit

Each scenario can be loaded and run. Results are summarized in Table 3. It is clear that  the Bingham 
Plastic model over predicts the required pump head and power at higher flow rates but is comparable at 
the lowest flow rate of 720 m3/hr. This is consistent with the lower part of Figure 11 where the Bingham 
Plastic correlation offers a poor match to the raw data as the flow rate increases.
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Table 3: Comparison of results between Homogeneous Scale-up, Power Law, and Bingham Plastic models

Q m3/hr 720 m3/hr 1080 m3/hr 1440 m3/hr

  Scale-
Up

Power 
Law

Bing-
ham 

Plastic

Scale-
Up

Power 
Law

Bing-
ham 

Plastic

Scale-
Up

Power 
Law

Bing-
ham 

Plastic

V meters/s-
ec 2.741 2.741 2.741 4.112 4.112 4.112 5.482 5.482 5.482

Jm m/m 0.0673-
5

0.0683-
0 0.06970 0.0702-

8
0.0721-

9 0.08067 0.0807-
2

0.0821-
6 0.10510

dP/dx bar/m 7.463-
E-03

7.569-
E-03

0.0077-
24

7.788-
E-03

7.999-
E-03

0.0089-
39

8.945-
E-03

9.105-
E-03

0.0116-
47

dP bar 5.224 5.298 5.407 5.452 5.600 6.257 6.261 6.374 8.153

dH 
Wate-

r
meters 53.27 54.03 55.14 55.59 57.10 63.81 63.85 64.99 83.14

dH 
Fluid meters 47.14 47.81 48.79 49.19 50.53 56.47 56.50 57.52 73.57

Pow-
er kW 146.5 148.6 151.7 229.4 235.6 263.3 351.3 357.6 457.4

Analysis Summary

A non-settling phosphate slurry pipeline was modeled and the pump sized for a range of flow rates. AFT 
Fathom non-settling slurry calculations allow evaluation of the non-Newtonian viscous behavior of the 
slurry.
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NFPA Firewater System 

Summary

This problem walks through building a hydraulic model of a fire water sprinkler system using Fathom's 
NFPA features. This example is based off of figure B.2 (a) and associated calculations from NFPA 15 
standard 8.5.3.1.

In this example, a firewater spray nozzle system is hydraulically modeled. The system consists of 28 
spray nozzles and is supplied by a fixed pressure source. As the design engineer, it is your responsibility 
to ensure that all spray nozzles receive at least 152 L/min, as well as the minimum supply pressure 
required to achieve these flows. To ensure that the proposed design is adequate, you will model the sys-
tem and use the hydraulically most remote nozzle to ensure that all spray nozzles are satisfied.

Topics Covered

 l Modeling a fire water spray system
 l Making groups
 l Using NFPA features
 l Generating an NFPA report
 l Using Excel Change Data

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - NFPA Firewater System - Initial.fth
 l Metric - NFPA Firewater System - Final.fth
 l Metric - NFPA AFT Transfer Spreadsheet.xlsx

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the Model

Open the Metric - NFPA Firewater System - Initial.fth model file listed above, which is located in the 
Examples folder in the AFT Fathom application folder. Save the file to a different folder.

The model should appear as shown in Figure 1.

Figure 1: Initial model for NFPA Firewater System example
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 Step 3. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C

 Step 4. Define the Miscellaneous group

While still in the analysis setup, expand the Miscellaneous drop down and open the NFPA panel. Check 
the box next to Enable NFPA. This will enable various features throughout the software such as NFPA 
internal fittings & losses for pipes, equivalent length loss model for junctions, NFPA report, etc. Keep the 
Initial Values the same. A group for the NFPA report will be selected later.

 Step 5. Define the Pipe and Junction Properties

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click the "Ok" button to save changes to the analysis setup and return to the workspace. At 
this point a user would need to draw their own network using the tools in the toolbox, but to save some 
time the piping layout for this model has already been created.

 

With the system in place, we now need to enter the properties of the objects. Because this model is large, 
all input has been added to a specially-configured Excel Change data spreadsheet that is included in the 
Examples folder and will be used to change the input to match the values in this example. Before import-
ing this spreadsheet, it is necessary to define values in each pipe and junction because the Excel 
Change data spreadsheet is only capable of changing input data, not entering new data. 

To quickly enter input data before using the Excel Change data spreadsheet, we will use the Global Pipe 
and Junction Editing features. If you are going to use Excel Change data to change the input you already 
have in your model, the values that you initially input in the model act simply as place holders and the 
value itself is not important. It is crucial, though, that you ensure that the units for each value that will be 
changed are specified correctly, because the Excel Change data spreadsheet will not change these units 
(it will only change the value itself).

Pipe Properties

To globally edit the pipes, select Global Pipe Edit from the Edit menu. Click All to select all pipes. Next, 
click Select Pipe Data and enter the following inputs in the pipe properties window.

ImportingFromExcel.html
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 1. Pipe Material = Steel - ANSI
 2. Pipe Geometry = Cylindrical Pipe
 3. Size = 1 inch
 4. Type = STD (schedule 40)
 5. Friction Model = User Specified
 6. Data Set = Hazen-Williams Factor
 7. Value = 120
 8. Length = 3 meters

In the Parameters to Change section, click All to apply all changes to the selected pipes, then click Apply 
Selections at the bottom. Then click OK.

Next, fittings a losses will need to be added to various pipes throughout the system. On the fittings & 
losses tab of the pipe properties window  move the slider from "Use K Factor" to "Use Equivalent 
Lengths" then specify the Fittings for each pipe according to the table below.

Note: Pipes that have Fittings & Losses entered in them will now have a red & displayed next to them. 
The symbol and display settings can be customized in User Options.

Table 1: Fittings and Losses for pipe input in NFPA model

Pipes Fitting Type Quantity

4, 6, 8, 10, 12, 14, 31, 33, 35, 
37, 39 Elbow, 90 deg. standard 1

2, 9, 13, 34, 38 Elbow, 90 deg. standard 2

7, 11, 19, 20, 22, 24, 25, 27, 29, 
32, 36, 40, 41, 42, 43, 44, 45, 

47, 49, 50, 52

Tee or Cross, (flow turned 90 
deg.) 1

15, 16, 17, 18, 40, 41, 42, 43 Elbow, 90 deg. standard and Tee 
or Cross, (flow turned 90 deg.) 1 Tee and 1 Elbow

Junction Properties

To globally edit the junctions, select Global Junction Edit from the Edit menu. Next, click the appropriate 
junction based on what you are inputting. For example, Spray Discharge. Click All to select all junctions 
in the list. Then, click Select Spray Discharge Data and enter the following inputs in the pipe properties 
window. Repeat this process for all junction types in the model using the inputs below.

 1. All Spray Discharges
 a. Elevation = 3 meters
 b. Loss Model = K (Fire Sprinkler)
 c. Exit Properties = Pressure
 d. Exit Pressure = 0 barG
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 e. K (Fire Sprinkler) = 3 liters/min per square root of bar
 f. Number of Sprinklers = 1

 2. All Branches
 a. Elevation = 3 meters

 3. J1 Assigned Pressure
 a. Elevation = 0.15 meters
 b. Pressure = 4.41 barG
 c. Pressure Specification = Static

 4. J2 Valve
 1. Inlet Elevation = 0.76 meters
 2. Outlet Elevation = 1.22 meters
 3. Valve Data Source = Equivalent Length (Metric)
 4. Equivalent Length = User Defined
 5. Equivalent Length (User) = 3.96 meters

Import Excel Change Data

After you have input for all pipes and junctions, import the Excel Change data spreadsheet. To do this, 
import the spreadsheet in the Examples Help file entitled Metric - NFPA AFT Transfer Spread-
sheet.xlsx  by clicking on File > Import Excel Change Data, and then browsing to this spreadsheet. After 
all changes were made, a window will appear that lets you know that all changes were made.

 Step 6. Create the NFPA Group

In order to generate an NFPA report, AFT Fathom needs to know the path for which you wish to gen-
erate the report. Generally, this report is developed for the hydraulically most remote path. For this model 
the hydraulically most remote path is either the path to J11 or J15. For Fathom to generate a path it will 
first need a group containing all pipes and junctions along the desired flow path.

To create a group, select all pipes and junctions that are along the flow path. For this example you will 
need to select pipes P1, P2, P3, P4, P5, P6, P7, P8, P9, and P10, and junctions J1, J2, J3, J4, J5, J6, J7, 
J8, J9, J10, and J11 (see this path selected in Figure 2). Note, to select multiple objects, hold the shift key 
while selecting each with this mouse. Alternatively, you can select these pipes and junctions directly from 
the Group Manager. Once these pipes and junctions are selected, open the Group Manager by going to 
Edit > Groups > Manager. Click on Create Group and name the group NFPA Path. Make sure this path 
is selected under Existing Groups, then under both the Pipes in Group and Junctions in Group columns, 
select Workspace. Press OK to confirm this group.
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Figure 2: NFPA Group selected on the Workspace

The group we just selected contains the hydraulically most remote path, but this information was simply 
provided for the sake of convenience in this example and is not frequently known without modeling the 
system. If you have the GSC module, you can use it to determine the most hydraulically remote path. 
See the Example problem NFPA Firewater System - GSC if you are interested in seeing how to use the 
GSC module for this. Otherwise, if the hydraulically most remote path is not known, you will need to dig 
through Fathoms output to determine which spray nozzle is receiving the least flow.
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 Step 7. Specify the NFPA Path

Once you know the hydraulically most remote path, you will generate an NFPA report for this path. To 
specify which path in AFT Fathom you want to generate the NFPA report for, open Analysis Setup and 
go to the NFPA panel. Select the group in the Select a Group for the NFPA Report list.

 Step 8. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

You will notice there are numerous cautions about the pipe lengths being shorter than the elevation 
change. This model used pipe lengths and elevations based off a NFPA example. In the NFPA 
example, the length of the spray discharges raised the outlet height of the junction. Fathom treats junc-
tions as single points in space, so to keep the inputs identical the pipe length had to be a little bit short. 

 Step 9. Examine the Output

The Output window contains the NFPA Report, as well as the standard AFT Fathom output parameters. 
To view the NFPA Report, click on the NFPA Report tab in the General section of the Output window. 
You can expand this section by dragging the border down. The NFPA Report can be printed from File > 
Print NFPA Report, or you can select all cells by clicking the top-left corner and copy-paste into Excel for 
modifications. The NFPA Report for this model is shown in Figure 3a and Figure 3b.
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Figure 3a: NFPA Report Page 1

Figure 3b: NFPA Report Page 2

Conclusion

AFT Fathom allows you to display the hydraulic calculations for an NFPA report. In this example, you 
have built a model of a firewater system and generated an NFPA hydraulic report. In this report we can 
see that the minimum pressure for this system is  4.41 barG in order to see  152 L/min at the most 
hydraulically remote nozzle.
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To those familiar with the NFPA Example this was based off, you may notice a slight difference in the min-
imum pressures calculated by Fathom. This is because Fathom uses a more detailed model to account 
for various behavior in the system. You can read more about these differences on the NFPA Panel topic.

NFPA-Panel.html
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Crude Oil Pipeline 

Summary

The objective of this example is to model a pipeline system to investigate the effects of a viscous fluid. 
We will answer a number of questions about the pipeline system such as: 

 1. How does viscosity affect pump performance?
 2. What is the flow rate? 
 3. What is the maximum pressure in the pipe? 
 4. Is the flow laminar or turbulent?
 5. How high can the hill be until a vacuum (i.e., less than atmospheric pressure) is created?
 6. How does the hill height affect flow rate?
 7. How much can the pump speed be slowed down and still not pull a vacuum?

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Crude Oil Pipeline.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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 a. Fluid Library = User Specified Fluid
 b. Name = Petroleum Product
 c. Density = 0.8 S.G. water
 d. Dynamic Viscosity = 500 centipoise

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

 
Figure 1: Model for Pipeline Problem

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 24 inch 
 d. Type = STD (schedule 20)
 e. Friction Model Data Set = Standard
 f. Lengths =



Crude Oil Pipeline

- 131 -

Pipe Length

1 30 meters

2 40 km

3 80 km

Junction Properties

Enter the properties of the junctions in the workspace as follows: 

 1. J1 Reservoir 
 a. Liquid Surface Elevation = 230 meters
 b. Liquid Surface Pressure = 0 barG (0 kPa(g))
 c. Pipe Depth = 3 meters

 2. J2 Pump 
 a. Inlet Elevation = 220 meters
 b. Pump Model = Centrifugal (Rotodynamic)
 c. Analysis Type = Pump Curve
 d. Enter Curve Data =

Volumetric Head

barrels/day meters

0 610

100,000 550

200,000 425

 e. Curve Fit Order = 2

 Note: If barrels/day is not an available unit, select User Options from the Tools menu, click on Pre-
ferred Units, and select the radio button for All Units.

 4. J3 Branch
 a. Elevation = 381 meters

 5. J4 Reservoir 
 a. Liquid Surface Elevation = 3 meters
 b. Liquid Surface Pressure = 0 barG
 c. Pipe Depth = 3 meters

In the Pump Properties window on the Optional tab, Fathom includes an option to Use Viscosity 
Correction.  We will turn this option on later to determine how much this option affects the answers. 
Leave the option off for now. 
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ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 5. Examine the Output

Open the Output Control window by selecting Output Control from the toolbar or Tools menu. On the Dis-
play Parameters tab, select the Pumps button to display the list of output parameters that are specific to 
pumps. Then add the three correction parameters to pump efficiency CE, pump head rise CH, and pump 
flow CQ.  These are the pump viscosity correction/pump de-rating factors that will de-rate the pump 
according to the Hydraulic Institute method, ANSI/HI Standard 9.6.7-2010. Change the Volumetric Flow 
Rate units to barrels/day.

Now select the Pipes button to display the pipe output parameters, then change the units for Volumetric 
Flow Rate to barrels/day. Also, add Reynolds Number to the list of output variables. Click OK to save the 
changes and close Output Control.

The Output window contains all the data that was specified in the output control window. The output from 
this model is shown in Figure 2. Note that the flow rate in all the pipes is 152,565 barrels/day.

 
Figure 2: Output Window for Pipeline example

Return to the workspace and open the pump properties window. Navigate to the Optional tab and check 
the box for Use Viscosity Correction. Input the following:
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 1. Head Correction (ANSI/HI 9.6.7-2015) = Assume Calculated Flow Is At BEP
 2. Rated Speed (rpm) = 3600

Click OK and run the model again. The output from this run is shown below. Now notice that the flow rate 
is 144,781 barrels/day.  Click the Pump Summary tab in the General Output section to see the values for 
CE, CH, and CQ. The output from this model is shown in Figure 3.

 
Figure 3: Output Window for Pipeline example with viscosity correction

Question 1. How does viscosity affect pump performance?

The flow rate, pump head, and overall power all decreased when the viscosity corrections were used.

Question 2. What is the flow rate? 

Before the viscosity correction was added the flow rate was 152,565 barrels/day. After the viscosity cor-
rection was added the flow rate became 144,781 barrels/day. Therefore, the viscosity correction factor 
reduced the flow rate by approximately 5.1%.

Question 3. What is the maximum pressure in the pipe? 

The maximum pressure can be found in the pipe summary in the P Static Max column. It occurs in Pipe 2 
and it occurs at the inlet of the pipe (outlet of the pump). The pressure is 37.503  bar (3,750.3 kPa) or 
36.4902 barG (3,649.02 kPa (g)). 

Question 4. Is the flow laminar or turbulent?
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In the pipe summary window we can see that the Reynolds number is 918.2. Therefore the flow is lam-
inar. The general cut-off for laminar flow is Reynolds number greater than 2,300.

Question 5. How high can the hill be until a vacuum is created?

To answer this question we have to change the elevation of branch J3 and re-run the model. If the hill 
height is raised to 457.8 meters, the minimum pressure in pipe 2 and 3 and at junction J3 is 1.014 bar 
(101.4 kPa), or nearly atmospheric pressure. If the hill is higher than 457.8 meters, a vacuum would be 
created. This output can be seen in Figure 4.

 
Figure 4: Output Window for Pipeline example with 457.8 meter hill

Question 6. How does the hill height affect flow rate?

Compare Figure 3 and Figure 4 and you will see that the flow rate is exactly the same. Because the pipe 
length is the same and the net elevation change is the same, the flow rate will be the same.

Question 7. How much can the pump speed be slowed down and still not pull a 
vacuum?

The pump can be slowed down to 86.6% before the minimum pressure in pipes 2 and 3 goes below atmo-
spheric (1.013 bar) (101.3 kPa). The output of this run is shown in Figure 5.
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Figure 5: Output Window for Pipeline example with pump operating at 86.6% speed
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Hot Water System 

Summary

The objective of this example is to select the best pump configuration for a hot water system. The design 
goals of the system are:

 l Minimum 0.42 bar (42 kPa) drop across flow control valves
 l Maximum 3 meters/sec velocity in all pipes
 l No NPSH violations
 l All pumps must operate between 70% and 100% of BEP
 l The selected pump must also work in a special operating mode with one pump off
 l The best pump will meet all the requirements and use the least power.

Topics Covered

 l Using Junction Libraries to enter data
 l Using multiple pump configurations
 l Using NPSH and Efficiency data for pumps
 l Turning off parts of a model to simulate different operating conditions

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Hot Water System.fth
 l Hot Water System.dat - engineering library

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 65 deg. C

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

 
Figure 1: Model Layout for Hot Water System
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Note: A safety factor of 10% will be added to all pipe and junction friction losses. This is added by typ-
ing in 1.1 in the Pipe Friction field for Design Factors found on the Optional tab in the Pipe Prop-
erties window. The Design Factor of 1.1 will be added to the Junction Friction Losses on the 
Optional tab in the Junction Properties windows for every junction except for the three pumps.

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = Use table below
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Lengths = Use table below

Pipe Size Length (meters)

12, 13 4 inch 10

6, 8 ,10, 18, 
20, 22, 24 4 inch 15

5, 7, 9, 17, 21 4 inch 30

19, 23 4 inch 50

11, 14 6 inch 10

3, 15 6 inch 15

1, 4, 16 6 inch 30

2 6 inch 90

 2. Optional tab
 a. Design Factors

 i. Pipe Friction = 1.1

Junction Properties

 1. J1 Reservoir
 a. Name = Topping Tank
 b. Liquid Surface Elevation = 3 meters
 c. Liquid Surface Pressure = 0 barG (0 kPa (g))
 d. Pipe Depth = 3 meters

 2. All Tees
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 a. Elevation = 0 meters
 b. Loss Model = Simple

 3. All Bends
 a. Inlet Elevation = 0 meters
 b. Type = Standard Elbow (knee, threaded)
 c. Angle = 90 Degrees

 4. J14 & J17 Control Valves
 a. J14 Name = FCV A
 b. J17 Name = FCV B
 c. Inlet Elevation = 0 meters
 d. Valve Type = Flow Control (FCV)
 e. Control Setpoint = Volumetric
 f. Flow Setpoint = 50 m3/hr

 5. All Pumps & Heat Exchangers
 a. J4 Name = Pump A
 b. J7 Name = Pump B
 c. J10 Name = Pump C
 d. J15 Name = Heat Exchanger A
 e. J18 Name = Heat Exchanger B
 f. Inlet Elevation = 0 meters

To show the names of the pumps, control valves, heat exchangers, and reservoirs, a new Workspace 
Layer will be created.

 1. Create a new layer by selecting New Layer and then Blank Layer from the Workspace Layers tab 
of the Quick Access Panel.

 2. Name the layer Junction Labels.
 3. Edit the layer by selecting it and clicking the gear icon to bring up the Layer Settings window.
 4. Open the Show/Hide Labels panel and uncheck Force Shown Labels to Match Shown Objects.
 5. Toggle the visibility icon next to the pumps, heat exchangers, control valves, and reservoir to on. 

This will cause their labels to be shown.
 6. Navigate to the Junction Parameters panel and expand the Commonly Used Junction Parameters 

list.
 7. Double-click Junction Name to add it to the list on the right-hand side. This will add the Junction 

Name to the label of the junctions that were defined in the Show/Hide Labels panel.
 8. Close the Layer Settings window.

To enter the pump and heat exchanger data, we will use a pre-defined library: 

 1. Open the Library menu and select the Library Manager. 
 2. At the bottom, click Add Existing Library. Navigate to the AFT Fathom 13 Examples folder and 

select the file titled Hot Water System.dat and Open. The library Hot Water System will be added 
to the list of available libraries.
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Note: Typically when a Library is first added to the list in Library Manager, it will automatically be con-
nected and will appear with a checkmark next to it. Step 3 below is only needed if the library is 
not automatically connected.

 3. If not already, check the box next to the library name Hot Water System, this will connect the lib-
rary to the model.

 4. Close Library Manager
 5. Now open the Pump Properties window for Pump A, and in the Library Jct field at the top of the 

properties window, select Metric - Hot Water Pump with Multiple Configs from the drop down 
menu. 

 6. In the Pump Curve area, make sure RPM = 1800 RPM and Impeller = 6 inches. 
 7. Repeat this process for Pump B and Pump C.
 8. Open the Heat Exchanger Properties Window for Heat Exchanger A, and select Metric - Hot 

Water Heat Exchanger in the library drop down box. This library includes the pressure loss data 
for the heat exchangers.

 9. Repeat these steps for Heat Exchanger B. 

Finally, use Global Junction Edit to add the 10% safety factor.

 1. Select Global Edit then Global Junction Edit from either the toolbar or Edit menu.
 2. Select Common Data
 3. Click Select Common Junction Data
 4. In the Design Factor area, set Junction Friction Loss = 1.1
 5. Click OK
 6. Click All to select all junctions in the list
 7. Check the box in the Parameters to Change (Select in List) area next to Design Factor 1.1
 8. Click Apply Selections. A message should appear to inform you that changes were successively 

applied.
 9. Click OK.

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 5. Examine the Output

After running the model, select the Pump Summary tab and review these results. The pump summary 
data is shown in Figure 2. 
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Figure 2: Pump Summary for First Configuration

Now we must review these results to determine if the requirements are met. The pumps operate at 91% 
to 96% of BEP and there are no NPSH violations. Although the pump meets the requirements, we can 
see from the valve summary in Figure 3 that the flow control valves do not maintain a minimum of 0.7 bar 
(70 kPa) pressure drop. The velocity in all the pipes is less than 3 meters/sec. The pipe summary is 
shown in Figure 4. 

Figure 3: Valve Summary for First Configuration

Figure 4: Pipe Output for First Configuration

After examining this pump configuration, this process needs to be repeated for each configuration, in 
order to find which pump best meets the specified requirements. A tool that can be used for this kind of 
evaluation is the Scenario Manager. Open the Scenario Manager on the Quick Access Panel and create 
five scenarios, one for each pump configuration. Below each scenario, create a child scenario for each 
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configuration named Pump A Off. The Scenario Manager on the Quick Access Panel should look like Fig-
ure 5. Alternatively, you can access the Scenario Manager from the Tools menu.

Figure 5: Scenario Manager on the Quick Access Panel for Hot Water System

Now, work your way through each scenario and change the pump configuration to the pump con-
figuration for each scenario. For the scenarios where Pump A is off, use the Special Condition Pump Off 
No Flow. Run each scenario, note the sum of the three pump's power usage, and determine if the pump 
meets all the requirements. It would help to create a table of the requirements and configurations as 
shown in Table 1. 

Table 1: Summary Table for Hot Water System

Pump 1800 x 6 1800 x 7 1800 x 8 3600 x 4 3600 x 5

Normal Mode      

BEP OK? Yes Yes No No No

NPSH OK? Yes Yes Yes Yes Yes

FCV dP OK? No Yes Yes Yes Yes

Pipe Velocity 
OK? Yes Yes Yes Yes Yes
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Pump 1800 x 6 1800 x 7 1800 x 8 3600 x 4 3600 x 5

Power Used 
(kW) 3.958 5.643 7.770 7.770 13.504

Special Mode 
(Pump A Off)      

NSPH OK? Yes Yes Yes Yes Yes

FCV dP OK? No Yes Yes Yes Yes

Pipe Velocity 
OK? Yes Yes Yes Yes Yes

From Table 1, it can be seen that the only configurations that meet all the requirements are the 1800 
RPM x 7-inch impeller. One thing to note is that the 1800 RPM x 8-inch and 3600 RPM x 4-inch con-
figurations are actually the same pump configuration due to the affinity laws.  The power usage of both 
configurations help show that they are the same pump.

Note: The 1800 RPM x 6-inch configuration with Pump A turned off is a case where the flow control 
valves will have to add pressure in order to maintain their set point. A flow control valve adding 
pressure is physically unrealistic, however, it is useful for troubleshooting purposes because it 
shows how close a control valve is to being able to maintain set point. The fact that the FCVs 
fail with this particular scenario is an example of how a certain pump configuration and oper-
ating condition may not be able to provide the system pressure and meet the requirements.
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Plant Cooling Cost Calculation 

Summary

This example demonstrates the fundamental concepts of doing a cost analysis with AFT Fathom.  The 
example illustrates how to calculate initial and life cycle costs for a given system design.

After designing a plant cooling system, it is necessary to calculate the system cost over a 10-year period 
to determine the feasibility of the design.  The system model consists of four circulating water pumps, 
schedule 20 steel - ANSI pipes and fittings, and two sets of cooling tower cells.

To determine the cost of the cooling system for a 10-year period, include material, installation, and 
energy costs for the pumps, pipes, and fittings.  The cooling towers costs will be determined apart from 
the system cost (cooling tower cost calculations are not included in this example).

Topics Covered

 l Creating cost libraries
 l Entering pipe, junction and fitting cost data into libraries
 l Connecting cost libraries
 l Using Cost Settings
 l Using the Cost Report

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

In addition, it is assumed that the user has worked through the Beginner - Cost Calculation example and 
is familiar with the basics of doing cost calculations.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Plant Cooling Cost Calculation - Initial.fth
 l Metric - Plant Cooling Cost Calculation - Final.fth
 l Plant Cooling.dat - existing engineering library
 l Plant Cooling - Pump Costs.cst - completed cost library for Plant Cooling.dat

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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 l Plant Cooling - Elbow Costs.cst - completed cost library for AFT INTERNAL LIBRARY
 l Plant Cooling - Pipe Costs Metric.cst - completed cost library for Steel - ANSI

Note: The cost libraries above will be recreated as part of this example, but they are also included as 
reference material.

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the model

Open the Metric - Plant Cooling Cost Calculation - Initial.fth model file listed above, which is located 
in the Examples folder in the AFT Fathom application folder. Save the file to a different folder.

The model should appear as shown in Figure 1.

Figure 1: The Plant Cooling Cost Calculation model

 Step 3. Define the Cost Settings group

By default, the cost calculations are turned off. To turn on the cost calculations, open Analysis Setup, nav-
igate to the Cost Settings panel, and select Calculate in the Cost Calculation section. The Cost Settings 



Plant Cooling Cost Calculation

- 146 -

panel is shown in Figure 2.

The Cost Definitions section allows you to specify the type of costs to be determined.

In the Cost Definitions area, select Material, Installation, and Operation/Energy costs by checking the 
box next to the name in the list.

In the Energy Cost section, select Use This Energy Cost Information, and enter a Cost of 0.12 U.S. Dol-
lars Per kW-hr.

In the Cost Time Period section, enter a System Life of 10 years.

The Cost Settings panel should look like Figure 2. Close the Analysis Setup window by clicking OK.

Figure 2: The cost calculations are selected on the Cost Settings window

 Step 4. Create the Cost Libraries

Refer to the AFT Fathom Help Content for detailed information regarding creating and using cost lib-
raries.

The energy cost for the pumps was specified in the Cost Settings as a fixed cost rate. Now, the material 
and installation cost for the pumps, pipes, and fittings must be included. This will be done by creating 
three new cost libraries. 

The first cost library will be for the pipe material and installation costs and it will be associated with the 
engineering library that contains the pipe material data, which is the Steel - ANSI pipe material library.  

The second cost library will be for the additional pipe fittings and losses costs for the elbow losses that 
are lumped into the pipes. The second cost library will be associated with the AFT INTERNAL LIBRARY. 
This is because the AFT Internal Library contains the loss information for the additional fittings and 
losses tab in the Pipe Properties window.

The third cost library will be for the pump material and installation costs, and it will be associated with the 
engineering library that contains the pump information (i.e., the Plant Cooling.dat  engineering library).
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Create a cost library for the pipe material and installation costs

Create a new cost library for the pipe costs by opening the Library menu and selecting Cost Library. 
Create a new cost library by clicking New at the bottom. When you click New, you are prompted to 
choose the engineering library with which the cost library will be associated. 

The piping material data used in the model comes from the default Steel - ANSI Pipe Material Library, so 
the pipe cost library will be connected to this library, as well. Select Steel - ANSI from the library list 
shown in the Select Library window, then click Select.

Important: Make this choice carefully, because once you have made the association you cannot 
change it.

Once the library is created, you must enter a meaningful description and select the cost units. Enter the 
following data on the General tab:

 1. Cost Type = Monetary
 2. Monetary Unit = U.S. Dollars
 3. Description = Plant Cooling - Pipe Costs Metric
 4. Notes = This library is for the Plant Cooling Cost Calculation example file

Save the cost library to a file by clicking Save. Specify a file name such as, Plant Cooling - Pipe Costs 
Metric.cst, and click Save. After saving, if prompted, choose to add the new library to the list of available 
and connected libraries by clicking Yes.

The information on the General tab should appear as shown in Figure 3. The selected library file inform-
ation, cost type and monetary units, a description of the cost library, and any descriptive notes you have 
added will be displayed.

Be sure to keep the Edit Cost Library window open for the next step. For this cost library, you will enter 
pipe material and installation costs on the Pipe Material tab.

Note: The library filenames may be different than those shown in Figure 3.
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Figure 3: The Edit Cost Library window is used to enter cost library data

Enter the pipe material costs

After the pipe cost library has been created, select the Pipe Materials tab. This is where you will enter the 
material and installation costs for the piping. 

The Pipe Materials tab shows all the pipes in the engineering library (AFT Steel - ANSI Pipe Material 
Library). Costs can be entered at several levels. You can enter costs at the material level, the nominal 
size level, and finally at the type (i.e., schedule) level. Costs entered at the material level apply to all nom-
inal sizes and types in that material type. Costs entered at the nominal size level apply to all schedules 
within that nominal size. Costs entered at the type (schedule) level apply only to that type. For this 
example, all of the pipe material costs will be entered at the type (schedule) level for specific 
sizes.

To enter a new cost, start by switching the Sort selection to Material, Type or Schedule, Nominal Size. 
Navigate to Steel - ANSI, STD, 8 inch. Next click New Cost to create a new cost item in the table. The 
new cost item will appear as a new column.

Each pipe size in this example has two non-recurring (NR) costs associated with it. The costs to be 
entered are the material and installation costs. You will need to make a second column and chang Cost 
Type to Installation (NR). Figure 4 shows the costs entered for 8-inch STD Steel - ANSI. 

Enter the non-recurring pipe costs for the pipe in this example, as shown below.

All pipes are STD Steel - ANSI:
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Nominal Size 
(inches)

Material Cost 
(dollars/meter)

Installation Cost 
(dollars/meter)

8 34.50 78.75

14 74.00 169.00

18 90.00 229.75

20 116.25 280.50

24 131.25 316.75

28 190.35 361.00

30 197.00 423.25

Figure 4: Non-recurring pipe costs, such as material and installation costs, are entered on the Pipe Materials 
tab

After the material and installation costs are entered for each STD type for the sizes listed above, click 
Save to save the information in the cost library file, and then click Close to close the Edit Cost Library win-
dow.

Create a cost library for the elbow  fittings  with cost scale tables

Several pipes in the model have 90 degree elbows specified in the Fittings and Losses tab in the respect-
ive Pipe Properties windows. The cost of these 90 degree elbow fittings can be included in the cost 
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calculation. The costs for these items will be accounted for in scale tables. Scale tables can be used to 
vary a cost with a parameter such as diameter (i.e., size). Once created, this scale table can be applied to 
fittings and losses items.

Create a cost library for the elbow fittings and losses costs by opening the Library menu and selecting 
Cost Library. Create a new cost library by clicking New. You are prompted to choose the engineering lib-
rary with which the cost library will be associated.

ØThe cost library for the elbow fittings and losses will be associated with the AFT INTERNAL 
LIBRARY, as this is the engineering library in which the pipe fittings and losses data is kept for the 
default elbow pipe fittings and losses.  Select AFT INTERNAL LIBRARY and click Select.  

On the General tab, specify the following information:

 1. Cost Type = Monetary
 2. Monetary Unit = U.S. Dollars
 3. Description = Plant Cooling - Elbow  Costs
 4. Notes = This library is for the elbows included as additional Fittings and Losses for the pipes

Click Save and save this cost library with a file name such as Plant Cooling - Elbow  Costs.cst

The first table to create is the scale table for the 90-deg. elbow installation costs. Select the Tables tab, 
and click New Table.

Enter the following data for the scale table on the New Scale Table window:

 1. Name = 90 Elbows Installation
 2. Table Type = Diameter
 3. Table Format = Cost

After entering the data, click OK.

Now enter the cost data in the table using the values in the table below, as shown in Figure 5. Note that 
the diameter units are in inches because the Steel - ANSI pipe material library uses inches. However, if 
you prefer to use a different unit for diameter, such as centimeters, AFT Fathom will make the appro-
priate conversions. For this example, use inches.

Diameter (inches) Installation Cost (US dollars)

7.981 185.50

12.25 298.00

17.376 446.00

23.25 595.00

29.00 744.00

33.00 843.00

You do not need to enter data in the scale tables for every diameter in the model. If a diameter falls 
between two data points in the table, AFT Fathom will use the points on either side to linearly interpolate 
for a value. If the cost function is non-linear, you may need to add additional data points to achieve a 
more accurate cost value.
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Create another scale table for the material costs using the following data:

 1. Name = 90 Elbows Material
 2. Table Type = Diameter
 3. Table Format = Cost

Diameter (inches) Material Cost (US dollars)

7.981 68.00

12.25 151.50

17.376 262.50

23.25 373.50

29.00 484.50

33.00 558.50

After the scale tables have been created, and the cost data entered, the Tables tab should appear as 
shown in Figure 5.

Figure 5: The Tables tab on the Edit Cost Library window is used to create cost scale tables

Click Save after the two cost tables are created and keep the Edit Cost Library window open for the next 
step.
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Add the costs for pipe fittings

With the cost scale tables for the fittings defined, the costs for the pipe fittings can be added. Select the 
Pipe Fittings & Losses tab. A list of all of the available fittings and losses is displayed in the Pipe Fittings 
& Losses list.

The fittings in the model are Elbow/Bend, Smoothed Flanged, r/D=1, 90 deg. (C). Navigate through the 
list until you find the proper selection for these fittings.

Add the material cost by clicking New Cost, and entering the following data:

 1. Description = Elbow Material Costs
 2. Cost Type = Material (NR)
 3. Material = Steel - ANSI
 4. Material Size = All Sizes
 5. Material Type = All Types
 6. Use Size Table = Table of Costs
 7. Multiplier = 1
 8. Size Scaling Table = 90 Elbows Material

Now add the installation cost by clicking New Cost again and entering the following data:

 1. Description = Elbow Installation Costs
 2. Cost Type = Installation (NR)
 3. Material = Steel - ANSI
 4. Material Size = All Sizes
 5. Material Type = All Types
 6. Use Size Table = Table of Costs
 7. Multiplier = 1
 8. Size Scaling Table = 90 Elbows Installation

The actual cost values used for the fittings are the values that were entered in the scale tables on the 
Tables tab. The scale table to use for each cost is specified when the cost is defined. After the cost data 
is entered, the Pipe Fittings & Losses tab should appear as shown in Figure 6.
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Figure 6: The Pipe Fittings & Losses tab in the Edit Cost Library window is used to specify costs for pipe fit-
tings and losses items

Click Save and close the Edit Cost Library window, as now, the cost library for the elbow fittings and 
losses is now completed.

Create a cost library for the pumps

To enter cost for a pump, or any other junction type, the junction must first be added to the an engin-
eering library in the Library Manager. Cost data is then entered in a cost library associated with that engin-
eering library. The pumps used in this example have already been added to an engineering library, but 
no costs have been created for it yet. Create a new cost library associated with the Plant Cooling engin-
eering library by opening the Library menu and selecting Cost Library.  

Click New, then select the Plant Cooling  library and click Select. Specify the following general inform-
ation on the General tab:

 1. Cost Type = Monetary
 2. Monetary Unit = U.S. Dollars
 3. Description = Plant Cooling - Pump Costs
 4. Notes = This library is for the pumps in the Plant Cooling engineering library

Save the cost library to a file by clicking Save and giving the file a name such as Plant Cooling - Pump 
Costs.cst. When prompted, choose to add the new library to the list of available and connected libraries. 
Keep the Edit Cost Library window open for the next step.



Plant Cooling Cost Calculation

- 154 -

Enter the pump costs

After the pump cost library has been created, select the Junctions tab. This is where you will enter the 
material and installation costs for the pumps.

All of the junctions that are available in the selected engineering library will be listed. Select the Metric - 
Plant Cooling Pump from the list of pumps.

Add the material cost by clicking New Cost, and entering the following data:

 1. Description = Pump Material Cost
 2. Cost Type = Material (NR)
 3. Use Size Table = (None)
 4. Cost (U.S. Dollars) = 28500
 5. Cost Per = Item

Add the installation cost by clicking New Cost again and entering the following data:

 1. Description = Pump Installation Cost
 2. Cost Type = Installation (NR)
 3. Use Size Table = (None)
 4. Cost (U.S. Dollars) = 12500
 5. Cost Per = Item

Figure 7 shows the pump costs entered in the cost library.

Click Save and then click Close.

Figure 7: The Junctions tab on the Edit Cost Library window is used to specify costs for junctions
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Connecting the cost libraries

The Plant Cooling engineering and cost libraries should have been added to the list of available libraries 
and been connected to the example model. If they were not, you can use the Library Manager to connect 
the cost libraries now (see Figure 9). The Plant Cooling - Pump Costs is connected subordinate to the 
Plant Cooling. The Plant Cooling - Pipe Costs Metric is connected subordinate to the Steel - ANSI 
pipe material library. Lastly, the Plant Cooling - Elbow Costs is connected subordinate to the AFT 
INTERNAL LIBRARY. Refer to the AFT Fathom Help Content for information on how to connect libraries 
using the Library Manager.

Make sure that the pumps are utilizing the engineering library junction data, otherwise the costs 
will not be calculated.

Figure 8: Pump using the engineering library data
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Figure 9: Library Manager with connected engineering and cost libraries

 Step 5. Including objects in the Cost Report

The final step before performing a cost analysis is to specify which pipes and junctions you want to be 
included in the final cost report. This is done by opening the properties window, navigating to the Cost 
tab, and choosing Include in Cost Report for each pipe and junction to be included, as shown for Pipe 
100 in Figure 10.

Include the four circulating water pumps and all of the pipes in the cost report. The Global Edit feature 
may be used to update this information for all of the pumps and pipes.
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Figure 10: The Cost tab on the Pipe and Junction Properties windows is used to include the objects in the 
Cost Report

 Step 6. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 7. Examine the Cost Report

The Cost Report is displayed in the General Results section of the Output window. View the Cost report 
by selecting the Cost Report tab. The content of the Cost Report can be modified from the Output Control 
window. Figure 11 shows the Cost Report for this example with the Material, Installation, Oper-
ation/Energy, and Total costs displayed.

The Cost Report shows the total system cost, as well as the individual totals for the material, installation, 
and energy costs. In addition, the Cost Report displays the detailed cost for each pipe, junction, and fit-
ting that was included in the report. The items are grouped together by type, and a subtotal for each cat-
egory is listed.
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Figure 11: The Cost Report in the General Output section shows the results of the cost analysis

Analysis Summary

The cost analysis for this example shows the following costs for the plant cooling system design:

Total of All Model Costs $4,589,100

Total Material Cost $413,515

Total Installation Cost $687,646

Total Operation/Energy Cost $3,487,938

Total Cost of Pipe $904,734

Total Cost of Pumps $3,651,938

Total Cost of Fittings $32,426

Minimizing Cost with AFT Fathom Automated Network Sizing Module™

The AFT Fathom Automated Network Sizing Module (ANS) is a tool built on AFT Fathom technology. 
With the ANS module you can automatically size all pipes or ducts in your system to minimize monetary 
cost, weight, volume, or surface area. In addition, you can concurrently size the pumps and pipes to 
obtain the absolute lowest cost system that satisfies your design requirements. Finally, by accounting for 
non-recurring and recurring costs, you can size pipe and duct systems to minimize life cycle costs over 
some specified duration.

ANSAutomatedNetworkSizing.html
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By using the AFT Fathom Automated Network Sizing Module (ANS) on this example, not only could the 
system cost be determined, the cost could also be minimized by varying selected pipe and junction sizes 
in the system.
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Non-Newtonian Mill Discharge Slurry 

Summary

This example demonstrates how one can take small-scale raw rheological data for a mill slurry at a min-
erals plant and use it on a full-scale pipe calculation.

Topics Covered

 l Reviewing and entering rheological data
 l Using homogeneous scale-up features
 l Obtaining and using Power Law and Bingham Plastic constants

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

In addition the user should have worked through Non-Newtonian Phosphates Pumping example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Non-Newtonian Mill Discharge Slurry.fth
 l Non-Newtonian Mill Discharge Slurry Data.xlsx

Problem Statement

The piping for a non-settling slurry for a mill discharge at a minerals plant is being designed. The system 
will supply 200 m3/hr of slurry through a 12-inch (305 mm) horizontal pipe 100 meters long.

Rheological data using the actual fluid in a 1/4 inch (1 cm) pipe has been obtained. Perform non-settling 
slurry calculations to evaluate how well the Bingham Plastic and Power Law models follow the raw data. 
Then determine the pressure drop in the full-scale pipe using Bingham Plastic, Power Law and Homo-
geneous Scale-up models.

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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 Step 1. Review Raw Data in Excel

The data taken for 1/4 inch STD schedule (0.9246 cm ID), 0.75 meter pipe is as follows:

Density = 1400 kg/m3

Table 1: Pressure drop data on mill slurry (1/4 inch pipe - 0.9246 cm ID, 0.75 meter long)

Run Q (m3/hr) dP (Pa)

1 0.003 25,000

2 0.015 36,000

3 0.025 44,000

4 0.050 53,000

5 0.100 60,000

The Bingham Plastic and Power Law models typically process data in terms of shear rate and shear 
stress. The above data needs to be changed into a form for input into AFT Fathom.

Open the provided Excel spreadsheet Non-Newtonian Mill Discharge Slurry Data.xlsx. Click the 
Excel tab for Metric units. Here one can see the raw data and calculated shear rate and shear stress. See 
Figure 1 for a view of the data. The shear rate and shear stress data is in the yellow columns. 

 
Figure 1: Mill slurry raw and calculated data from Excel file

 Step 2. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.
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 Step 3. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel:

 a. Fluid Library = User Specified Fluid
 b. Name = Mill Discharge Slurry
 c. Density = 1400 kg/m3
 d. Dynamic Viscosity = 1 Pa-sec (note that the viscosity entered here will not be used once 

the non-Newtonian parameters are entered)
 3. Open the Viscosity Model panel

 a. Viscosity Model = Bingham Plastic
 b. Select Calculate from Rheological Data
 c. Click Calculate Constants
 d. Raw Data Type = Tube Flow Rheometer Data (8V/D)
 e. Raw Data = (make sure to change the units for Shear Stress to Pascals)

Parameter Shear Rate Shear Stress

Units 1/seconds Pascals

1 10.7 77.0

2 53.7 110.9

3 89.5 135.6

4 179.0 163.3

5 358.0 184.9

 f. Curve Fit Order = 1
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Figure 2: Bingham Plastic data entry
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Figure 3: Bingham Plastic curve fit and constants calculation

 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 4: Layout of pipe system for Mill Discharge Slurry example

Pipe Properties

 1. Pipe Material = Steel - ANSI
 2. Pipe Geometry = Cylindrical Pipe
 3. Size = 1/4 inch
 4. Type = STD (schedule 40)
 5. Length = 0.75 meters

Junction Properties

 1. J1 Assigned Pressure
 a. Elevation = 0 meters
 b. Pressure = 10 bar (1000 kPa)
 c. Pressure Specification = Stagnation

 2. J2 Assigned Flow
 a. Elevation = 0 meters
 b. Type = Outflow
 c. Flow Specification = Volumetric Flow Rate
 d. Flow Rate = 0.003 m3/hr

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
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have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 6. Examine the Output

Figure 5 shows the Output window. It can be seen that the pressure drop is 0.3408 bar (34,082 Pascals) 
for 0.003 m3/hr, compared to the raw data value of 0.2500 bar (25,000 Pascals).

Figure 5: The Output window with default output data

 Step 7. Create Scenarios

From the Base Scenario, make a child scenario named Bingham Plastic.

 Step 8. Run Other Bingham Plastic Scenarios

Load the Bingham Plastic scenario and use the Duplicate Special feature to create five identical runs. 
Enter flow rates of 0.015, 0.025, 0.050 and 0.100 m3/hr at the Assigned Flow junctions. Run the model 
and note the pressure drop for each pipe.

 Step 9. Create and Run Power Law Scenarios

In the Scenario Manager, right click the Bingham Plastic scenario and select Clone Without Children. 
Name this scenario Power Law.

 1. Load the Power Law Scenario
 2. Open Analysis Setup
 3. Open the Viscosity Model panel
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 a. Viscosity Model = Power Law
 b. Select Calculate from Rheological Data
 c. Click Calculate Constants
 d. Raw Data Type = Tube Flow Rheometer Data (8V/D)
 e. Raw Data = should still be loaded from before
 f. Curve Fit Order = 1

 g. Click Generate Curve Fit Now
 h. Click OK

 4. Click OK

Run the model again.

Figure 7 shows the output for each of the ten cases. Figure 8 plots the test data against the results of 
Bingham Plastic and Power Law. From Figure 8 it is clear the Power Law model fits the mill discharge 
slurry data better than Bingham Plastic.

Figure 6: Power Law curve fit from Viscosity Model panel
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Figure 7: Summary of AFT Fathom output and test data

Figure 8: Graph comparing AFT Fathom output and test data

 Step 10. Evaluate Full Scale Data

 1. Make another child scenario called Full Scale - 12 inch
 2. Change pipe P1 to 100 meters length and 12 inch diameter
 3. Change junction J2 to a flow rate of 200 m3/hr
 4. Make three child scenarios below Full Scale - 12 inch: one for each, Bingham Plastic, Power 

Law, and Homogeneous Scale-up
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 5. Load the Bingham Plastic scenario, open Analysis Setup, and perform a curve fit for Bingham 
Plastic

 6. Run the Bingham Plastic scenario and note the pressure drop
 7. Repeat the above for the Power Law  scenario
 8. For the Homogeneous Scale-up scenario, use the test data from the Excel spreadsheet. Make 

sure to enter the data as Volumetric in m3/hr and Jm in m/m. All 5 data points are laminar flow, as 
shown in Figure 9.

Figure 9: Homogeneous Scale-up window with test data input

Figure 10 shows a comparison of pressure drop results using multi-scenario output for the three children. 
It can be seen that there is closer agreement between Power Law and Homogeneous Scale-up. The 
Bingham Plastic results are not as close which was true earlier in this example comparing to actual test 
data (Figure 8). Therefore the Bingham Plastic pressure drop should be excluded and the design pres-
sure drop should be based on Power Law and Homogeneous Scale-up.
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Figure 10: Full scale pressure drop comparison of Bingham Plastic, Power Law, and Homogeneous Scale-up

Analysis Summary

A non-settling mill discharge slurry for a minerals plant was modeled using non-settling slurry cal-
culations in AFT Fathom. Runs for small scale and full-scale calculation were made and pressure drop 
was determined for these cases.
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Flow Induced Vibration Calculations (Metric Only)

Summary

Repeated vibration on a piping system can result in vibration induced fatigue and failure. Pipe failure due 
to vibration creates safety concerns for personnel and environmental contamination, as well as costly 
downtime and repairs. Despite these concerns, vibration sources and resulting fatigue are often not 
addressed by design standards. Instead, designers and operators often react to vibration issues rather 
than prevent and avoid these issues proactively.

In response to vibration concerns, the Energy Institute developed the Guidelines for the Avoidance of 
Vibration Induced Fatigue Failure in Process Pipework. These guidelines provide sources of vibration for 
engineers to consider, many of which can be identified or modeled in an AFT application as found in the 
Table 1 below.

Table 1: Vibration sources and applicable AFT Application  

Vibration Sources AFT Applic-
ation

Surge
Sudden 

changes to flow/-
pressure

AFT Impulse / 
AFT xStream

Cavitation Vapor formation 
and collapse

AFT Fathom / 
AFT Impulse

Reciprocating 
Equipment

Identify res-
onant fre-

quencies to 
avoid during 

operation

AFT Impulse 
PFA Module / 
AFT xStream 
PFA Module

FIV
Turbulence 

from flow dis-
continuities

AFT Fathom / 
AFT Arrow

AIV High frequency 
acoustic energy AFT Arrow

FIP
Excitation at 

dead end 
branches

AFT Arrow

These guidelines provide a structured approach to identify, assess, and correct vibration concerns 
through qualitative and quantitative methods. AFT has developed a Flow Induced Vibration Calculations 
spreadsheet which, in conjunction with model output and user input, can perform key parts of the recom-
mended quantitative assessment of different vibration sources. These calculations used with the Energy 
Institute guidelines will help engineers identify vibration concerns in their systems.

https://www.energyinst.org/
References.html
References.html
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In this example, learn how to use AFT Fathom  to help calculate the Likelihood of Failure (LOF) for Flow 
Induced Vibration (FIV) in accordance with Energy Institute Guidelines to avoid vibration induced 
fatigue failure.

Topics Covered

 l The cause and concerns of Flow Induced Vibration (FIV):
 l Occurs in both compressible and incompressible flow
 l Excitation caused by turbulence from discontinuities or boundary layer separation
 l Generally concentrated at low frequencies (<100 Hz)
 l Can lead to visible vibrations of piping and supports

 l Required calculation parameters for FIV
 l Excel Export Manager
 l Use of AFT vibration analysis spreadsheet

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Flow Induced Vibration Calculations.fth

 l Flow Induced Vibration Calculations.xlsx

Problem Statement

Turbulence is common in most practical piping systems. In this example, we will examine turbulence in 
straight pipes, caused by the boundary layer at the pipe wall, with its intensity depending on the flow 
regime, characterized by the Reynolds number. However, in typical scenarios, major flow disturbances 
like process equipment, partially closed valves, sharp bends, tees, and reducers are the primary sources 
of turbulence.

Reference: Pages 48-53, Section T2.2, Flowchart T2-1

Purpose: Looking at the part of the mainline with most turbulence and the greatest distance between 
supports to determine the LOF

Input Values/Sources/Descriptions:

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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Note: Table 2 shows the specific values used in this model, but the steps in this Example can be used 
to calculate the LOF for vibration concerns in any model.

Table 2: Input Values/Sources/Descriptions

Object Inputs Example 
Value Source Description

P4 (Pipe) L,span 7 m User Input

Max span 
length 

between sup-
ports

P4 (Pipe) T 9.525 mm User Input Thickness of 
pipe wall

P4 (Pipe) fn (adv. only) 1 Hz User Input
Structural nat-

ural fre-
quencies

P4 (Pipe) D,int 438.15 mm AFT Export Internal pipe 
diameter

P4 (Pipe) ρ 998.9342 
kg/m3 AFT Export Fluid density 

(static)

P4 (Pipe) v 4.0503 m/s AFT Export Fluid velocity

Note: L,span of 7 m assumes that supports are at the elbows and the pressure boundaries for the 
example model.

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the Model

Open the Metric - Flow Induced Vibration Calculations.fth model file.

The workspace should look like Figure 1 below.
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Figure 1: Layout of FIV Analysis Model on the Workspace

 Step 3. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 4. Excel Export Manager

 1. From the Workspace, click the Excel Export Manager button on the toolbar, then click Open.

Figure 2: Opening Excel Export Manager from the Workspace

 2. The Excel Export Manager window appears.

ExportingToExcel.html
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Figure 3: Excel Export Manager window

Note that three rows have been added to the Excel Export Manager with the following information. P# 
(Pipe) is the same pipe for all rows.

Table 3: Excel Export Manager parameters for FIV calculations

Object Parameter Units Excel 
Sheet

Excel Start-
ing Cell Header Units

P# (Pipe) Diameter 
Hydraulic mm FIV Calcs 

Liquid C13

P# (Pipe) Density of 
Fluid Average kg/m3 FIV Calcs 

Liquid C14

P# (Pipe) Velocity meters/sec FIV Calcs 
Liquid C15

 3. At the bottom, for Excel Export Location, click the radio button for Previously Saved Workbook.
 4. The Flow Induced Vibration Calculation Excel spreadsheet should be preselected. If not, click the 

Select Workbook button, navigate to the Flow Induced Vibration Calculation.xlsx file then 
click Open. The top of the Excel Export Manager window should look like Figure 4 and the bottom 
should look like Figure 5.



Flow Induced Vibration Calculations

- 176 -

Figure 4: Excel Export Manager window with incompressible fluids

Figure 5: Bottom of the Excel Export Manager window

 5. Once all inputs are confirmed to match the above window, click Export Now at the bottom left.

Figure 6: Bottom of the Excel Export Manager window

 Step 5. Vibration Analysis Spreadsheet

AFT Fathom will export the parameters to the spreadsheet which has the prebuilt calculations.

To complete the vibration analysis, use the following instructions:
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Figure 7: Flow Induced Vibration Calculations Excel document following export

 1. Navigate to the FIV Calcs Liquid sheet in the Excel workbook.

 2. With the values from AFT Fathom, note the user specified values for the remaining inputs:
 a. L,span in m
 b. T in mm
 c. fn (advanced only)

 l For the highest accuracy, the natural frequency should be measured for the system.
 l If the natural frequency is not known the typical fundamental natural frequency for 

the system based on the support type is given in Table T2-1 on page 50 of the EI 
Guidelines and is shown in the spreadsheet in the “Determining Support Type” table 
in cells F28-F31.

 3. The LOF is calculated and shown in cell C19 in the output section.
 4. Use the EI Guidelines to determine appropriate actions based on displayed LOF.

Conclusion

An LOF of 0.377 indicates a moderate risk that the pipe may fail, but does not necessarily require a full 
redesign of the main line. When failure is not imminent (LOF < 0.5), the following is recommended by the 
EI Guidelines:

 l Small bore connections on the main line should be assessed.
 l A visual survey should be undertaken to check for poor construction and/or potential vibration 

transmission from other sources.
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Module Walk-Through Examples 
The examples in the Fathom Module Help System are designed to get new users trained to use the 
Fathom modules correctly in the shortest amount of time. 

If this is your first time using Fathom, please start with the Walk-Through Examples to learn how to create 
and run Fathom models. Start with the Three Reservoir Model, because it provides the most complete, 
basic description on how to set up and run a Fathom model. After this example, it is recommended that 
you work through the remaining Walk-Through examples. 

If you are just learning to work with the Fathom modules, start with the Beginner model for each module, 
then choose an example from the tables on the Module pages that most closely matches your applic-
ation. The examples are arranged in order of increasing complexity.

Fathom GSC Examples

Fathom XTS Examples

Fathom SSL Examples

Fathom ANS Examples

Fathom Combined Module Examples
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Goal Seek and Control (GSC) Examples
The examples below utilize the Goal Seek and Control module.

Fathom GSC Examples

Example Complexity Fluid Pipes Pumps Description

Beginner - Heat 
Transfer in a Pipe Beginner Water 

(liquid) 1 0

Learn the basics of the GSC 
module. See how to use 
Analysis Setup to activate 
and enable the GSC module 
and to use the Goal Seek 
and Control group to define 
variables and goals. Learn 
where to find the GSC Vari-
ables and GSC Goals tabs 
in the Output window.

Pump Sizing and 
Selection with 
Flow Control 

Valves

Beginner Water 
(liquid) 9 1

Learn how to use the GSC 
module to size a pump in a 
system with a pump and 
flow control valves in series. 

Cooling System Beginner Water 
(liquid) 20 2

Learn how to link GSC vari-
ables together to apply mul-
tiple variables and goals in a 
single simulation.

Model Calibration 
with Pipe Vari-

ables
Beginner Water 

(liquid) 6 0

Learn how to use the GSC 
module to vary pipe friction 
to calibrate a model to 
match a measured volu-
metric flow rate.

Spray Discharge 
System Intermediate Water 

(liquid) 11 0

Learn how to create groups 
and use the Group Max/Min 
and Group Sum goals using 
the GSC module.

Controlled Heat 
Exchanger Tem-

perature
Intermediate Water 

(liquid) 10 1

Learn how to use the GSC 
module with heat transfer to 
vary the open percentage of 
a three-way valve to achieve 
a desired temperature.

NFPA Firewater 
System Intermediate Water 

(liquid) 71 0
Learn how to use the GSC 
module to determine the 
most hydraulically remote 
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Example Complexity Fluid Pipes Pumps Description

nozzle for NFPA Reports.

Beginner - Heat Transfer in a Pipe - GSC 

Summary

The objective of this example is to demonstrate how goals and variables are used in the GSC module to 
achieve an objective. 

For this example, we will use the GSC module to determine the flow rate required such that the fluid at 
the outlet of a 30-meter section of pipe, with heat transfer, reaches a temperature of 50 deg. C.

Note: This example can only be run if you have a license for the GSC module.

Topics Covered

 l Defining the Goal Seek and Control group
 l Understanding Goal Seek and Control Output

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Beginner - Heat Transfer in a Pipe.fth
 l Metric - Beginner - Heat Transfer in a Pipe - GSC.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 2. Open the model

Open the Metric - Heat Transfer in a Pipe.fth example file listed above, which is located in the 
Examples folder in the AFT Fathom application folder. Save the file to a different folder. The workspace 
should look like Figure 1 below:

Figure 1: Workspace for GSC Heat Transfer example

 Step 3. Define the Modules group

The GSC module is controlled through the Goal Seek and Control group in Analysis Setup.  Open Ana-
lysis Setup and navigate to the Modules panel. Check the box next to Activate GSC. The Use option 
should automatically be selected, making GSC enabled for use. Alternatively, GSC can be enabled from 
the Analysis menu by going to the Goal Seek & Control option and selecting Use, as shown in Figure 2.
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Figure 2: GSC can be enabled and disabled from the Analysis menu

 Step 4. Define the Goal Seek and Control Group

The Goal Seek and Control group is made up of three items: Variables, Goals, and Numerical Controls. 
The default settings in Numerical Controls will suffice for most applications and no input is necessary in 
this panel for this example. The variables and goals are defined in their respective panels.  The Variables 
panel is shown in Figure 3 below:

Figure 3: Variables panel

Variables Panel

In the GSC module, variables are the parameters that the solver will modify in order to achieve the spe-
cified goals. There should be one variable defined for each goal. 
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Open the Variables panel in the Goal Seek and Control group in Analysis Setup. The Variables panel 
allows you to create and modify the system variables. The object type and junction type are selected, 
then the name and number of the object to which the variable applies, and the object parameter that is to 
be varied are specified all on the Variables panel. 

To create a new variable, follow these steps:

 1. Click New Variable
 2. Apply = Checked
 3. Object Type = Junction 
 4. Junction Type = Assigned Flow
 5. Junction Number and Name = J2 (Assigned Flow)
 6. Variable Parameter = Flow 
 7. Link To = (None)
 8. Lower Bound (Optional) = 0

The Apply column allows users to specify which of the variables that have been defined will be used. This 
allows the flexibility of creating multiple variable cases, while only applying selected variables for any 
given run.

The Link To column allows users to apply the same variable to multiple objects. This allows users to force 
parameters for several objects to be varied identically.

Upper and Lower Bounds provide logical extremes during the goal search. For this case, leave both the 
lower bound and the upper bound values blank.

After entering the data, the Variables panel should appear as shown in Figure 4:

Figure 4: The Variables panel is used to specify the variables

Goals Panel
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Goals are the parameter values set by the user that Fathom adjusts the variables to achieve. There 
should be one goal defined for each variable. 

Open the Goals panel in the Goal Seek and Control group. The Goals panel allows you to create and 
modify the system goals. The goal type, object type, and the goal parameter are selected. A criterion for 
determining if the goal has been met is then specified, along with a value and units for the goal para-
meter. You can select the object to which the goal applies, and, if applicable, the location on the object at 
which the goal applies (i.e. the inlet or outlet of a pipe object).

Do the following:

 1. Click New Goal
 2. Apply = Checked
 3. Goal Type = Point 
 4. Object Type = Pipe
 5. Goal Parameter = Temperature
 6. Criteria =  =
 7. Goal Value = 50
 8. Goal Units = deg. C
 9. Object ID = P1 (Pipe)

 10. Object Location = Outlet

After entering the data, the Goals panel should appear as shown in Figure 5:

Figure 5: The Goals panel is used to specify the goals

As variables and goals are added to a model, Fathom will display symbols beside the pipes and junctions 
that have variables or goals applied to them. The default is a V for variables, and a G for goals. The goal 
symbol is not displayed next to objects that are part of a group goal. This is illustrated in Figure 6:
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Figure 6: Workspace with Goal and Variable symbols displayed 

 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 6. Examine the Output

Figure 7 shows the Output window with the General, Pipes, and Junctions sections displayed.

Figure 7: The Output window contains all the data that was specified in the output control window
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The results of the GSC analysis are shown in the General Output section in the GSC Variables and 
GSC Goals tabs. The GSC Variables tab shows the final value for the variable parameter, as shown in 
Figure 8. The GSC Goals tab shows the final value achieved for the goal, as shown in Figure 9.

Figure 8: GSC Variable Results are displayed in the General section of the Output Window

Figure 9: GSC Goal Results are displayed in the General section of the Output Window

The GSC module analysis determined that a mass flow rate of 1.408 kg/sec (5.143 m3/hr) results in a 
pipe outlet temperature of 50 deg. C. In order to achieve the desired temperature, the assigned flow rate 
was varied from the initial value of 4.5 kg/s, to the final value of 1.409 kg/sec. In addition to the GSC mod-
ule tabs in the General Output section, the resulting pipe flow and temperature results can be seen in the 
Pipes section of the Output Window.
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Pump Sizing and Selection with Flow Control Valves - GSC 

Summary

The piping for a heat exchanger system is being designed. The system will pump supply water from a 
tank pressurized to 0.7 barG (70 kPa(g)) with a liquid surface elevation of 1.5 meters to a receiving tank 
with a pressure of 2 barG (200 kPa(g)) and a liquid surface elevation of 3 meters. The heat exchangers 
operate in parallel. The flow through the heat exchangers is controlled to 25 m3/hr by two flow control 
valves. There is a design requirement that the control valves have a minimum pressure drop of 0.35 bar 
(35 kPa).

Use the GSC module to size the pump.

Note: This example can only be run if you have a license for the GSC module.

Topics Covered

 l Defining the Goal Seek and Control group
 l Using Pump head rise as a GSC Variable
 l Using Group Max/Min Goals

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition the user should have worked through the Beginner: Heat Transfer in a Pipe - GSC example 
and the Spray Discharge System - GSC example, which demonstrates how to use Group Max/Min 
goals.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Pump Sizing and Selection with Flow Control Valves.fth
 l Metric - Pump Sizing and Selection with Flow Control Valves - GSC.fth

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the model

Open the Metric - Pump Sizing and Selection with Flow Control Valves.fth example file and save it 
as a new file. Right click on the Base Scenario and select Create Child. Name the child scenario Goal 
Seek Control.

Set the J2 Pump Sizing Parameter to Head Rise, with a Fixed Head Rise of 6 meters. In this example, the 
head rise will become the GSC variable.

The workspace should look like Figure 1 below:

Figure 1: Workspace for GSC Pump Selection with Flow Control Valves example
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 Step 3. Create a Group

Create a group named Flow Control Valves by opening the Edit menu, hover over Groups, and select 
Create. Add both Control Valve junctions J4 and J7 to the group.

 Step 4. Define the Modules Group

Open Analysis Setup, and navigate to the Modules panel. Check the box next to Activate GSC. The Use 
option should automatically be selected, making GSC enabled for use.

 Step 5. Define the Goal Seek and Control Group

Specify the variables and goals for the model.

Variables Panel

Select the Variables panel in the Goal Seek and Control group. For this example, click New Variable and 
enter the following variable data:

 1. Apply = Checked
 2. Object Type = Junction 
 3. Junction Type = Pump
 4. Junction Number and Name = J2 (Pump)
 5. Variable Parameter = Head Rise 
 6. Link To = (None)

After entering the data, the Variables panel should appear as shown in Figure 2:

Figure 2: The Variables panel is used to specify the variables
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Goals Panel

Select the Goals panel in the Goal Seek and Control group. 

Create a new goal for the pressure drop across the flow control valves as defined below (if the option for 
a group goal is not visible, you may have forgotten to create a group as discussed above). Click New 
Goal and enter the following:

 1. Apply = Selected
 2. Goal Type = Group
 3. Object Type = Group Max/Min
 4. Goal Parameter = Pressure Loss
 5. Criteria = >= 
 6. Goal Value = 0.35
 7. Goal Units = bar
 8. Object ID = Flow Control Valves
 9. Object Location = NA

After entering the data, the Goals panel should appear as shown in Figure 3:

Figure 3: The Goals panel is used to specify the goals

 Step 6. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 
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 Step 7. Examine the Output

The results of the GSC module analysis are shown in the General Output section. The GSC Variables 
tab shows the final value for the variable parameter, as shown in Figure 4. The pump head rise required 
for this system to supply a minimum of 0.35 bar (35 kPa) pressure drop at each of the Flow Control Valve 
junctions is 55.35 meters. The GSC Goals tab shows the final value achieved for the goal, as shown in 
Figure 5. This shows the goal of a minimum 0.35 bar (35 kPa) pressure drop was obtained for both 
valves.

Note that the results for this example are same as the results for the original Pump Selection with Flow 
Control Valves example.

Figure 4: GSC Variable Results are displayed in the General section of the Output Window

Figure 5: GSC Goal Results are displayed in the General section of the Output Window
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Cooling System - GSC 

Summary

The objective of this example is to use the GSC module to vary the required pump speed and control 
pressure such that a minimum flow of 35 m3/hr is maintained through the Heat Exchanger, and the con-
trol valve open percentage remains above 30%.

Note: This example can only be run if you have a license for the GSC module.

Topics Covered

 l Applying multiple variables and goals.
 l Using linked variables

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition the user should have worked through the Beginner - Heat Transfer in a Pipe - GSC example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Cooling System.fth
 l Metric - Cooling System - GSC.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 2. Open the Model

Open the Metric - Cooling System.fth example file and save it as a new file.

Load the Pump A scenario and turn off Pump J5 by opening the properties window, navigating to the 
Optional tab, and selecting the Pump Off No Flow special condition.

Open the properties window for Control Valves J11. On the Control Valve Model tab, under Loss When 
Fully Open, select Cv and then select From Open % Table (on Optional Tab) for the Loss Source. 

Go to the Optional tab and add the following data to Open Percentage Data table:

Open Pct. Cv

0 0

100 150

Click OK. Make these same changes to Control Valves J12 and J13. The workspace should look like Fig-
ure 1 below:

Figure 1: Workspace for GSC Cooling System example

 Step 3. Define the Modules Group

Open Analysis Setup, and navigate to the Modules panel. Check the box next to Activate GSC. The Use 
option should automatically be selected, making GSC enabled for use.
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 Step 4. Define the Goal Seek and Control Group

Specify the variables and goals for the model.

Variables Panel

Open the Variables panel in the Goal Seek and Control group in Analysis Setup. For this example, we will 
be adding four variables: one pump variable and three control valve variables which will be linked. Enter 
the variable inputs shown  in Figure 2:

Figure 2:  The Variables panel is used to specify the variables

Goals Panel

There should be one goal defined for each variable. In this case we essentially have two variables, since 
all of the control valve variables are linked, causing them to act as a single variable.

Open the Goals panel in the Goal Seek and Control group in Analysis Setup. Create two new goals as 
defined below in Figure 3:
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Figure 3: GSC Manager Goals tab is used to specify the goals

After entering the data, the Goals panel should appear as shown in Figure 3. Note that by setting the 
most hydraulically remote heat exchanger and control valve equal to the minimum requirements, we are 
ensuring that the other heat exchangers and control valves will exceed the minimum values.

 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 6. Examine the Output

The results of the GSC module analysis are shown in the General Output section. The GSC Variables 
tab shows the final values for the variable parameters, as shown in Figure 4. The pump speed was 
determined to be 84.26%, and the control setpoint for the valves was determined to be 3.094 barG 
(309.4 kPa(g)). The GSC Goals tab shows the final values achieved for the goals, as shown in Figure 5.

Viewing the Valve Summary tab will show that control valves J11 and J12 have open percents above the 
minimum of 30%. The Heat Exchanger Summary tab will similarly show that heat exchangers J14 and 
J15 have volumetric flow rates above the required minimum of 35 m3/hr.
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Figure 4: GSC Variable Results are displayed in the General section of the Output Window

Figure 5: GSC Goal Results are displayed in the General section of the Output Window
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Model Calibration with Pipe Variables - GSC 

Summary

A supply reservoir feeds a water treatment pond through gravity flow and the pipeline has been in exist-
ence for about 15 years.  The original pipeline delivered about 457 m3/hr and recently, the operators 
working at the treatment pond have reported that the flow has dropped by about 20%.  Their lead engin-
eer has determined that the cause of the flow reduction is most likely due to pipe corrosion.  

The objective of this example is to demonstrate how to use the GSC module to determine the amount of 
additional frictional resistance in the pipeline due to years of corrosion.  This could factor into the decision 
on whether or not to replace the pipeline and when.

For this example, the GSC module will be used to approximate the absolute roughness due to corrosion 
in the pipeline which has reduced the flow rate from 457 m3/hr to 366 m3/hr. 

Note: This example can only be run if you have a license for the GSC module.

Topics Covered

 l Defining the Goal Seek and Control group
 l Setting Variables and Goals 
 l Understanding Goal Seek and Control Output 

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition the user should have worked through the Beginner - Heat Transfer in a Pipe - GSC example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Model Calibration with Pipe Variables - GSC.fth

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C

 Step 3. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

Figure 1: Workspace for GSC Model Calibration Using Pipe Variables Example
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Enter the following pipe and junction properties.

Pipe Properties

 1. All Pipes
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 8 inch
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Length = 

Pipe Length (meters)

1 & 5 1610

2, 3, & 4 805

6 610

Junction Properties

 1. J1 Reservoir
 a. Name = Supply Reservoir
 b. Liquid Surface Elevation = 370 meters
 c. Liquid Surface pressure = 0 barG (0 kPa(g))
 d. Pipe Elevation = 305 meters

 2. J2 Branch
 a. Elevation = 150 meters

 3. J3 Branch
 a. Elevation = 180 meters

 4. J4 Branch
 a. Elevation = 30 meters

 5. J5 Branch
 a. Elevation = 90 meters

 6. J6 Branch
 a. Elevation = 15 meters

 7. J7 Reservoir
 a. Name = Treatment Pond
 b. Liquid Surface Elevation = 3 meters
 c. Liquid Surface Pressure = 0 barG (0 kPa(g))
 d. Pipe Depth = 0 meters

To show the names of the  reservoirs a new Workspace Layer will be created.
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 1. Create a new layer by selecting New Layer and then Blank Layer from the Workspace Layers tab 
of the Quick Access Panel.

 2. Name the layer Reservoir Labels.
 3. Edit the layer by selecting it and clicking the gear icon to bring up the Layer Settings window.
 4. Open the Show/Hide Labels panel and uncheck Force Shown Labels to Match Shown Objects.
 5. Toggle the visibility icon next to the reservoirs to on. This will cause their labels to be shown.
 6. Navigate to the Junction Parameters panel and expand the Commonly Used Junction Parameters 

list.
 7. Double-click Junction Name to add it to the list on the right-hand side. This will add the Junction 

Name to the label of the junctions that were defined in the Show/Hide Labels panel.
 8. Close the Layer Settings window.

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 4. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 5. Examine the Output

After running the model based upon the original pipeline operation with brand new clean steel pipe, we 
find that the flow rate is 456.7 m3/hr, as shown in Figure 2.

Figure 2: Original pipeline results based upon clean pipe

 Step 6. Create  a child scenario named Flow Reduction from Corrosion

In the child scenario, we are going to use the GSC module to determine how much additional frictional 
resistance due to corrosion is in the pipeline. In this new scenario, we know that the flow rate has been 
reduced to 366 m3/hr in the physical system by corrosion and therefore the GSC goal in this case is 
going to be the volumetric flow rate.
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The GSC module is a very useful tool that allows one to calibrate their models so that the predicted res-
ults can match measured data.  There are four different GSC pipe variables that can be used to assist 
with this calibration including the specified pipe Friction  (e.g. absolute roughness), pipe Design Factor, 
pipe ID (scaling), and Insulation Thickness.

In order to use GSC to determine the amount of additional frictional resistance due to corrosion, an input 
parameter must be varied.  In this case, we are going to vary each pipe's absolute roughness in order to 
achieve the desired goal flow rate of 366 m3/hr.

 Step 7. Define the Modules Group

Open Analysis Setup, and navigate to the Modules panel. Check the box next to Activate GSC. The Use 
option should automatically be selected, making GSC enabled for use.

 Step 8. Define the Goal Seek and Control Group

Specify the variables and goals for the model.

Variables Panel

Select the Variables panel within the Goal Seek and Control group. The Variables panel allows users to 
create and modify the system variables.

In this scenario, we are going to vary the current pipe friction model (i.e. absolute roughness) for each 
pipe in the system.  Since there are six individual pipes, there will be six individual pipe variables.  If all six 
variables were to be able to vary independently of each other and there is only one goal associated, then 
this could lead to a less unique solution (as there could be several different combinations of pipe rough-
ness values that would lead to the desired result).  Therefore, we are going to assume that the entire 
pipeline has the same level of additional frictional resistance due to corrosion.  In order to accomplish 
this, all pipe variables can be linked together.  Since only one goal is present, we will only need one effect-
ive variable and so all of the pipe variables will be linked to the first variable.

Since there are six pipes, we will set pipes P2 - P6 to be linked to pipe P1.

For pipe P1, set the following variable data:

 1. Apply = Selected
 2. Object Type = Pipe 
 3. Junction Type = NA
 4. Object Number and Name = P1 (Pipe)
 5. Variable Parameter = Friction 
 6. Link To = (None)

Now, add new variables for pipes P2 - P6.  The only differences between the variables for these pipes 
and the variable for pipe P1 will be the Object Number and Name and instead of selecting (None) under 
the Link To column, select P1 (Pipe).  This will link pipes P2 - P6 to pipe P1 which will force all six pipe 
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variables to be varied identically, requiring only one goal to be specified.  Figure 3 below shows all the 
linked pipe variables.

Figure 3: Six linked pipe variables (working effectively as a single variable) to vary the pipe friction model 
(i.e. absolute roughness)

Goals Panel

Goals are the parameter values set by the user that the solver tries to achieve by adjusting the variables. 
There should be one goal defined for each unlinked (and thus independent) variable. Since variables 2 - 
6 are all linked to variable 1, only one goal will be required.

Select the Goals panel in the Goal Seek and Control group. 

Create a new goal and set up the following goal information:

 1. Apply = Selected
 2. Goal Type = Point
 3. Object Type = Pipe
 4. Goal Parameter = Volumetric Flow Rate
 5. Criteria = =
 6. Goal Value = 366
 7. Goal Units = m3/hr
 8. Object ID = P6 (Pipe)
 9. Object Location = NA

After entering the data, the Goals panel should appear as shown in Figure 4.

On the Numerical Control panel, the Search Method can be modified for Goals between two options, 
Beta Method and Least Squares. The Beta Method is useful in situations where there are multiple vari-
ables and multiple goals. For this model, make sure that the Least Squares method is selected.
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Figure 4: GSC Manager Goals tab is used to specify the goals

 Step 9. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 10. Examine the Output

The results of the GSC module analysis are shown in the General section of the Output window. The 
GSC Variables tab shows the final value for the variable parameter, as shown in Figure 5. The resulting 
absolute roughness value that would decrease the flow rate to 366 m3/hr would be about 0.03966 cm. 
The additional frictional resistance in the pipeline due to corrosion is about nine times larger than the 
absolute roughness for clean steel pipe. The GSC Goals tab shows the final value achieved for the goal, 
as shown in Figure 6.

Figure 5: GSC Variable Results are displayed in the General section of the Output Window
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Figure 6: GSC Goal Results are displayed in the General section of the Output Window
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Spray Discharge System - GSC 

Summary

The objective of this example is to demonstrate how the Group Max/Min and Group Sum goal types can 
be used in the GSC module to achieve a goal for a group of objects. 

For this example, we will use the GSC module to solve for the supply pressure required to:

Supply a minimum of 30 m3/hr to each spray discharge junction using a Group Max/Min goal.

Supply a total flow rate of 230 m3/hr through the system using a Group Sum goal. 

Note: This example can only be run if you have a license for the GSC module.

Topics Covered

 l Creating Groups
 l Using Group Max/Min and Group Sum Goals

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition the user should have worked through the Beginner - Heat Transfer in a Pipe - GSC example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Spray Discharge System.fth
 l Metric - Spray Discharge System - GSC.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 2. Open the Model

Open the Metric - Spray Discharge System.fth example file and save it as a new file. We will not need 
the existing child scenarios for this example: right click on the Base Scenario in the Scenario Manager 
and select Delete All Children. The workspace should look like Figure 1 below:

Figure 1: Workspace for GSC Spray Discharge system example

 Step 3. Create a Group

In order to use the Group Max/Min and Group Sum goal types, the junctions included in the goal must be 
added to a group. To create a group, go to the Edit menu and select the Groups -> Create option. Give 
the new group the name Spray Discharges, and click OK. The Group Manager will be displayed. Select 
all of the Spray Discharge junctions from the junction list, as shown in Figure 2. After choosing the Spray 
Discharge junctions, click OK on the Group Manager form. 

Note: If the Spray Discharge junctions were selected in the Workspace before Create Group was 
selected from the Edit menu, then they would be automatically selected for us in the Group Man-
ager window.



Spray Discharge System - GSC

- 207 -

Figure 2: Groups are Created Using the Group Manager

 Step 4. Define the Modules Group

Open Analysis Setup, and navigate to the Modules panel. Check the box next to Activate GSC. The Use 
option should automatically be selected, making GSC enabled for use.

 Step 5. Define the Goal Seek and Control Group

Specify the variables and goals for the model.

Variables Panel

Open the Variables panel in the Goal Seek and Control group. For this example select New Variable, 
then choose following variable data:

 1. Apply = Selected
 2. Object Type = Junction 
 3. Junction Type = Assigned Pressure
 4. Junction Number and Name = J9 (Assigned Pressure)
 5. Variable Parameter = Pressure 
 6. Link To = (None)
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After entering the data, the Variable panel should appear as shown in Figure 3:

Figure 3: The Variables panel is used to specify the variables

Goals Panel

Open the Goals panel next. For this example, we are going to define two goals. We will apply one goal at 
a time for the sake of comparing the impact that each goal has on the results.

The first goal type is a Group Max/Min goal. This type of goal allows a single goal to be applied to a group 
of objects. Fathom applies a Group Max/Min goal by ensuring the final goal value is either greater than or 
equal to (Min) or less then or equal to (Max) the specified value. For this example, a Group Max/Min goal 
will be applied to ensure the minimum flow rate out of all of the spray discharge junctions is at least 30 
m3/hr.

The second goal type is a Group Sum goal. This type of goal is used to set the sum of the goal parameter 
for all the members in the group to a specified value. For this example, the Group Sum goal will be 
applied to ensure the sum of the flow rates through the spray discharges equals 230 m3/hr.

Create two new goals defined as follows:

Group Max/Min:

 1. Apply = Checked
 2. Goal Type = Group
 3. Object Type = Group Max/Min
 4. Goal Parameter = Volumetric Flow Rate Out
 5. Criteria = >= 
 6. Goal Value = 30
 7. Goal Units = m3/hr
 8. Object ID = Spray Discharges
 9. Object Location = NA



Spray Discharge System - GSC

- 209 -

Group Sum:

 1. Apply = Not Checked
 2. Goal Type = Group 
 3. Object Type = Group Sum
 4. Goal Parameter = Volumetric Flow Rate 
 5. Criteria = = 
 6. Goal Value = 230
 7. Goal Units = m3/hr
 8. Object ID = Spray Discharges
 9. Object Location = NA

After entering the data, the Goals panel should appear as shown in Figure 4 in Step 7.

 Step 6. Create Scenarios

Using the Scenario Manager on the Quick Access Panel, create two child scenarios, one named Group 
Max Min and another named Group Sum.

 Step 7. Select Group Max/Min Goal

Load the Group Max Min scenario. 

Open the Goals panel in the Goal Seek and Control group in Analysis Setup. Make sure the Group 
Max/Min goal is applied, indicated by the check mark in the Apply column for that goal. Make certain 
Group Sum goal is NOT applied by unchecking the check box in the Apply column. The GSC goals 
should appear as shown in Figure 4:

Figure 4: Group Max Min Goal Applied in the Goals panel
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 Step 8. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 9. Examine the Output

The GSC Variables tab shows the final value for the variable parameter, as shown in Figure 5. The sup-
ply pressure required to supply a minimum of 30 m3/hr at each of the Spray Discharge junctions is 18.85 
barG (1,885 kPa(g)). The GSC Goals tab shows the value achieved for the goal, as shown in Figure 6. 
The flow rates determined for the Spray discharge junctions are shown in Figure 7. The spray discharge 
flow rates shown in Figure 7 illustrate how the Group Max/Min resulted in a the flow rate through each of 
the spray discharges meeting or exceeding the specified minimum flow rate of 30 m3/hr. The total sys-
tem flow is 262.05 m3/hr.

Figure 5: GSC Variable Results are displayed in the General section of the Output Window

Figure 6: GSC Goal Results are displayed in the General section of the Output Window
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Figure 7: Flow Rates Calculated for the Spray Discharge junctions for Group Max/Min goal

 Step 10. Select Group Sum Goal

Load the Group Sum scenario. 

Open the Goals panel in the Goal Seek and Control group from Analysis Setup. Apply the Group Sum 
goal by clicking the check box next to the Group Sum goal in the Apply column. Make certain Group 
Max/Min goal is NOT applied by unchecking the check box in the Apply column. The GSC goals should 
appear as shown in Figure 8:

Figure 8: Group Sum Goals are applied in the GSC Manager

 Step 11. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 
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 Step 12. Examine Output

The GSC Variables tab shows the final value for the variable parameter, as shown in Figure 9. The sup-
ply pressure required to supply a total system flow of 230 m3/hr is 14.60 barG (1,460 kPa(g)). The GSC 
Goals tab shows the final value achieved for the goal, as shown in Figure 10. The goal of 230 m3/hr for 
the system flow in this example was achieved. The flow rates determined for the Spray Discharge junc-
tions are shown in Figure 11. Note that overall, the flows through the spray discharges in the Group Sum 
scenario are less than the flows determined for the Group Max/Min scenario. This is because in the 
Group Max/Min scenario, the restriction was placed on the flow rate at each of the spray discharges, res-
ulting in a system flow of 262.05 m3/hr, while the restriction in the Group Sum scenario was on the total 
system flow equaling 230 m3/hr. 

Figure 9: GSC Variable Results are displayed in the General section of the Output Window

Figure 10: GSC Goal Results are displayed in the General section of the Output Window

Figure 11: Flow Rates Calculated for the Spray Discharge junctions for Group Sum Goal
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Controlled Heat Exchanger Temperature - GSC 

Summary

The objective of this example is to use the GSC module to vary a Three Way Valve percent open to 
divert heat exchanger flow to maintain a downstream temperature of 50 deg. C for a specified upstream 
supply temperature. 

Note: This example can only be run if you have a license for the GSC module.

Topics Covered

 l Using GSC to control flow splits

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition the user should have worked through the Beginner - Heat Transfer in a Pipe - GSC example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Controlled Heat Exchanger Temperature.fth
 l Metric - Controlled Heat Exchanger Temperature - GSC.fth
 l Controlled Heat Exchanger Temperature.dat

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 2. Open the Model

Open the Metric - Controlled Heat Exchanger Temperature.fth example file and save it as a new file. 
The workspace should look like Figure 1 below:

Figure 1: Workspace for GSC Controlled Heat Exchanger Temperature example

 Step 3. Define the Modules Group

Open Analysis Setup, and navigate to the Modules panel. Check the box next to Activate GSC. The Use 
option should automatically be selected, making GSC enabled for use.

 Step 4. Define the Goal Seek and Control Group

Specify the variables and goals for the model.

Variables Panel

Open the Variables panel in the Goal Seek and Control group. For this example, we will be adding a vari-
able for the Three Way Valve % Open. Click New Variable and enter the following data:

 1. Apply = Selected
 2. Object Type = Junction 
 3. Junction Type = Three Way Valve
 4. Junction Number and Name = J3 (Three Way Valve)
 5. Variable Parameter = Open Percentage 
 6. Link To = (None)
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 7. Lower Bound = 0
 8. Upper Bound = 100

 
Figure 2: GSC Manager Variables tab is used to specify the variables

Goals Panel

Open the Goals panel in the Goal Seek and Control group in Analysis Setup. Click New Goal for the 
downstream temperature and define it with the data below:

 1. Apply = Selected
 2. Goal Type = Point
 3. Object Type = Branch
 4. Goal Parameter = Temperature
 5. Criteria = =
 6. Goal Value = 50
 7. Goal Units = deg. C
 8. Object ID = J8 (Branch)
 9. Object Location = Outlet

After entering the data, the Goals panel should appear as shown in Figure 3:
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Figure 3:  The Goals panel is used to specify the goals

 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 6. Examine the Output

The results of the GSC module analysis are shown in the General Output section. The GSC Variables 
tab shows the final value for the variable parameter, as shown in Figure 4. The open percentage required 
for the Three Way Valve to achieve a temperature of 50 deg. C at Branch J8 is 79.24%. The GSC Goals 
tab shows the final value achieved for the goal, as shown in Figure 5. This shows the goal of 50 deg. C 
was achieved for the downstream temperature.

Figure 4: GSC Variable Results are displayed in the General section of the Output Window
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Figure 5: GSC Goal Results are displayed in the General section of the Output Window
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NFPA Firewater System - GSC 

Summary

The goal of this example is to determine how to use the GSC module to determine the hydraulically most 
remote path to generate an NFPA report.

Note: This example can only be run if you have a license for the GSC module.

Topics Covered

 l Defining the Goal Seek and Control group
 l Setting Variables and Goals
 l Understanding Goal Seek and Control Output

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition the user should have worked through the Beginner - Heat Transfer in a Pipe - GSC example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - NFPA Firewater System.fth 
 l Metric - NFPA Firewater System - GSC.fth 

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 2. Open the Model

Open the Metric - NFPA Firewater System - Final.fth  file  and save under a different name.  

The workspace should look like Figure 1 below:

Figure 1: Workspace window for NFPA Firewater System - GSC Example

 Step 3. Create the Spray Nozzles group

In this example, we will use the GSC module to determine the hydraulically most remote path. 

To do this, you first need to create a group of all spray nozzles. Make this group by going to the Edit menu 
and selecting groups, and then clicking on Create. Name the group Spray Nozzles and under the 
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Junctions in Group section, click on Special, specify Selection Type as Junction Type, and choose Spray 
Discharge as the Junction Type. Click on Select Junctions and then press OK to confirm the selected 
junctions, then press OK to exit the Group Manager. 28 junctions should be selected.

 Step 4. Define the Modules Group

Open Analysis Setup, and navigate to the Modules panel. Check the box next to Activate GSC. The Use 
option should automatically be selected, making GSC enabled for use.

 Step 5. Define the Goal Seek and Control Group

Specify the variables and goals for the model.

Variables Panel

Next, ensure that GSC is both activated and enabled in the Modules panel of Analysis Setup. Then open 
the Variables panel. Click on New Variable and specify the Assigned Pressure J1 as the variable. This 
pressure boundary will be varied in order to achieve the goal, which in this case is a goal of at least 152 
L/min through each sprinkler. See Figure 2 to see this variable specified.

Figure 2: Assigned Pressure Variable on Goal Seek and Control Manager window

Goals Panel

Open the Goals panel and select New Goal. Specify the goal as shown in Figure 3.
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Figure 3: Minimum Flow Rate Group Goal on Goal Seek and Control Manager window

 Step 6. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

You will notice there are numerous cautions about the pipe lengths being shorter than the elevation 
change. This model used pipe lengths and elevations based off a NFPA example. In the NFPA 
example, the length of the spray discharges raised the outlet height of the junction. Fathom treats junc-
tions as single points in space, so to keep the inputs identical the pipe length had to be a little bit short. 

 Step 7. Examine the Output

The GSC module displays the value of the variable required in order to achieve the specified goal, as 
well as the object that was used for the group goal (in this case, this object is the spray discharge that 
receives the minimum amount of flow and, therefore, is the spray nozzle that contains the hydraulically 
most remote path). You can see that the pressure needed at J1 in order to ensure that all spray nozzles 
receive 152 L/min of flow is 4.406 barG, and that the hydraulically most remote spray nozzle is J15 (see 
Figure 4 and Figure 5).

Figure 4: Calculated value for the GSC Variable in the Output
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Figure 5: Calculated value for the GSC Goal when the GSC Variable is applied in the Output
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Extended Time Simulation (XTS) Examples
The examples below utilize the Extended Time Simulation module.

Fathom XTS Examples

Example Complexity Fluid Pipes Pumps Description

Beginner - Filling a 
Tank Beginner Water 28 1

Learn the basics of the XTS 
module such as defining a 
transient junction and spe-
cifying the Transient Control 
group in Analysis Setup. See 
how to generate a Quick 
Graph from the Output win-
dow to see how a tank fills up 
over time.

Reservoir Balance Beginner Water 2 0

Learn how to use the XTS 
module to see the effects of 
a system with multiple finite 
open tanks.

Valve Closing Beginner Water 3 1

Learn how to use the XTS 
module to define an initiating 
transient event, such as a 
valve closing when a reser-
voir liquid height reaches a 
specified value.

Controlled Heat 
Exchanger Tem-

perature
Beginner Water 10 1

Learn how to use the XTS 
module to model a system 
with a pump that shuts off 
once the liquid level of a tank 
reaches a specified value.

Housing Project Intermediate Water 28 1

Learn how to use the XTS 
module to specify a Dual 
Event Cyclic transient ini-
tiation, such as a pump turn-
ing on or off depending on a 
reservoir liquid height.

Variable Demand Intermediate Water 19 2

Learn how to use the XTS 
module to define a Single 
Event Initiation of Transient 
for multiple junctions within a 
system. 
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Beginner - Filling a Tank - XTS 

Summary

The objective of this example is to introduce the user to the Extended Time Simulation (XTS) module by 
modeling the filling of a tank. A liquid transfer system will be modeled. The pump will run for a specified 
time, and the change in fluid height in the delivery tank will be examined using the transient output data.

Note: This example can only be run if you have a license for the XTS module.

Topics Covered

 l Specifying Transient Control
 l Understanding Transient Output

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Beginner - Filling a Tank - XTS.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate XTS and select Transient to enable the XTS module for use. A 

https://www.aft.com/products/fathom/video-tutorial-series
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new group will appear in Analysis Setup titled Transient Control. Click OK to save the changes and exit 
Analysis Setup. Open the Analysis menu to see the new option called Time Simulation. From here you 
can quickly toggle between Steady Only mode (normal AFT Fathom) and Transient (XTS mode).

 Step 3. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C

 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

Figure 1: Workspace for XTS Filling a Tank example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties. The required information is highlighted in blue. 



Extended Time Simulation (XTS) Examples

- 226 -

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 4 inch 
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Lengths = 

Pipe Length (meters)

1 5

2 295

Junction Properties

 1. J1 Reservoir
 a. Name = Lower Reservoir
 b. Tank Model = Infinite Reservoir
 c. Liquid Surface Elevation = 3 meters
 d. Liquid Surface Pressure = 0 barG (0 kPa (g))
 e. Pipe Elevation = 0 meters

 2. J2 Pump 
 a. Inlet Elevation = 0 meters
 b. Pump Model = Centrifugal (Rotodynamic)
 c. Analysis Type = Pump Curve
 d. Enter Curve Data = 

Volumetric Head

m3/hr meters

0 90

115 115

230 75

 e. Curve Fit Order = 2

 3. J3 Reservoir
 a. Name = Upper Reservoir
 b. Tank Model = Finite Open Tank
 c. Known Parameters Initially = Both Parameters (Liquid Surface Level & Surface Pressure)
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 d. Cross-Sectional Area = Constant, 14 meters2
 e. Liquid Level Specification = Height from Bottom
 f. Liquid Height = 0 meters

 g. Liquid Surface Pressure = 0 barG (0 kPa (g))
 h. Tank Height = 9 meters
 i. Pipe Elevation = 60 meters
 j. Tank Bottom Elevation = 60 meters

To show the names of the  reservoirs a new Workspace Layer will be created.

 1. Create a new layer by selecting New Layer and then Blank Layer from the Workspace Layers tab 
of the Quick Access Panel.

 2. Name the layer Reservoir Labels.
 3. Edit the layer by selecting it and clicking the gear icon to bring up the Layer Settings window.
 4. Open the Show/Hide Labels panel and uncheck Force Shown Labels to Match Shown Objects.
 5. Toggle the visibility icon next to the reservoirs to on. This will cause their labels to be shown.
 6. Navigate to the Junction Parameters panel and expand the Commonly Used Junction Parameters 

list.
 7. Double-click Junction Name to add it to the list on the right-hand side. This will add the Junction 

Name to the label of the junctions that were defined in the Show/Hide Labels panel.
 8. Close the Layer Settings window.

 Step 5. Define the Transient Control Group

XTS module transient simulations are controlled through the Transient Control group in Analysis Setup. 
Access the Transient Control group by opening the Simulation Duration panel. When Fathom is set to 
perform a transient analysis, Transient Control becomes one of the items required to run the model.

The Simulation Duration panel in the Transient Control group is used to specify transient start and stop 
times, as well as the time step controls and solution parameters for finite tank liquid level calculations. 
Start times, stop times, and time steps can be specified in any units from seconds to years. From the Sim-
ulation Duration panel, users can specify the number of output points that are saved to the transient out-
put file. This allows XTS to do transient calculations with a small time step while limiting the size of the 
transient data output file. Enter the following inputs in the Simulation Duration panel, as shown in Figure 
2.

 1. Start Time = 0 minutes
 2. Stop Time = 30
 3. Time Step = 1 minutes



Extended Time Simulation (XTS) Examples

- 228 -

Figure 2: The Transient Control panel is used to control transient simulations

In addition to Transient Control, it is possible in define transient events for individual junctions. This 
allows the user to define events such as pump trips or start-ups, or valve closures. For this example, we 
will not specify any junction transients. The transient data for this example will be related to the fluid being 
pumped into the tank over the transient time period we have defined in Transient Control.

 Step 6. Specify the Time Simulation Formatting

Open the Output Control window and select the Format & Action tab. Set the Time Simulation Formatting 
units to minutes and click OK to save and close the window.

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

After all of the pipes and junctions have been defined, and all of the transient data and transient control 
items have been specified, the transient simulation may be executed.

 Step 7. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

When using the XTS module, the Solution Progress window displays the progress through the transient 
analysis. This information is displayed below the solution tolerance data, as shown in Figure 3:
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Figure 3: Solution Progress Window shows the convergence progress, as well as the transient solution pro-
gress when running transient cases 

 Step 8. Examine the Output

AFT Fathom displays transient output for all Pipes and Junctions in the Output Window, as shown in Fig-
ure 4.
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Figure 4: Transient output is displayed in the Output Window

Each of the summary tables in the General Output section has a companion transient summary tab 
which displays the summary data at each time step in the transient run. Each junction included in the 
summary is included in the transient summary. The transient summary data for each junction may be 
expanded or collapsed by clicking the + or – sign in beside the junction data list. The entire list may be 
expanded or collapsed by clicking the button in the top left-hand corner of the transient summary window. 
Figure 5 shows the Reservoir Transient summary tab, with all of the data sets collapsed. Figure 6 shows 
the Reservoir Transient summary tab, with the data for the J3 Reservoir expanded.

Figure 5: Transient Summaries are displayed in the General Output section
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Figure 6: Transient Summary data can be expanded to show the junction data for every Time Step

The Quick Graph feature can be used to quickly plot transient data for quick examination. To use the 
Quick Graph feature, place the mouse cursor over the column of data you wish to examine. Then, right 
click with the mouse, and select Quick Graph from the list. Figure 7 illustrates how to do this for J3 Reser-
voir Liquid Height vs. Time. Figure 8 shows the resulting graph. The graph illustrates how the liquid level 
in the Reservoir rises with time, as would be expected. The Graph Results window may also be used to 
create a full range of graphs related to the XTS module transient output.
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Figure 7: Use Quick Graph to easily plot J3 Reservoir liquid height 

Figure 8: Quick Graph Plot of J3 Reservoir liquid height

Similar to the summary transient data, the transient tabs in the Pipe and Junctions sections of the Output 
Window are used to display the transient data for each pipe and junction at every time step, as shown in 
Figure 9. This transient data can be expanded or collapsed in the same manner as in the General Output 
transient summaries.
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Figure 9: Output Window showing the Pipe and Junction Transient tabs

Figure 10 shows the output data for the pipes and junctions, found on the Pipes and All Junctions tabs, at 
the initial time step, Time = 0 minutes. The output for all of the pipes and junctions can be displayed at 
any time step by using the slider bar located at the bottom of the Output window. Figure 11 shows the 
pipe and junction data at Time = 5 minutes.

Figure 10: Pipe and Junction transient data at Time = 0 minutes
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Figure 11: Pipe and Junction transient data at Time = 5 minutes

 Step 9. Create a New Scenario

Create a new scenario called Variable Speed Pump.

Open the Pump Properties window for J2. On the Variable Speed tab, set the pump to Controlled Pump 
(Variable Speed) and select Volumetric Flow Rate with a Control Setpoint of 100 m3/hr.

Rerun the model.

 Step 10. Examine the Output

Figure 12 shows a Quick Graph plot of the Pump Speed vs. Time for the controlled flow pump. Note how 
the pump speed increases over time to maintain the controlled flow. This is because the hydrostatic pres-
sure downstream of the pump is increasing because the tank is slowly filling over time.
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Figure 12: Quick Graph plot of Controlled Pump Speed vs. Time
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Reservoir Balance - XTS 

Summary

The objective of this example is to demonstrate how the interaction of different hydrostatic pressures 
between can be analyzed using the XTS module. This example will use three finite reservoirs connected 
in series, with different initial liquid elevations.

Note: This example can only be run if you have a license for the XTS module.

Topics Covered

 l Using Finite Reservoirs Junctions

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition, it is assumed that the user has worked through the Beginner - Filling a Tank - XTS example, 
and is familiar with the basics of XTS transient analysis.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Reservoir Balance - XTS.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 2. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate XTS and select Transient to enable the XTS module for use. A 
new group will appear in Analysis Setup titled Transient Control. Click OK to save the changes and exit 
Analysis Setup. Open the Analysis menu to see the new option called Time Simulation. From here you 
can quickly toggle between Steady Only mode (normal AFT Fathom) and Transient (XTS mode).

 Step 3. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C

 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 1: Workspace for XTS Reservoir Balance example

Pipe Properties

Enter the following for both pipes P1 and P2.

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 4 inch 
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Length = 75 meters

Junction Properties

Figure 2 shows the Reservoir Properties window for junction J1. In the Fathom XTS module, reservoir 
junctions can have finite dimensions. The reservoirs can also be open, or closed. If the tank is closed, the 
user must specify the gas thermodynamics inside the closed tank. Users may also specify different initial 
known parameters for the reservoir. If only the Liquid Surface level is known, Fathom will calculate the 
Surface Pressure. Alternatively, if only the Surface Pressure is known, Fathom will calculate the Liquid 
Height. When using a reservoir as a finite tank, users must also specify the tank height, the initial liquid 
height in the tank, as well as the tank cross sectional area.



Reservoir Balance - XTS

- 239 -

 
Figure 2: Reservoir Properties Window in Fathom XTS

Next, define the reservoir junctions.

 1. J1 Reservoir
 a. Tank Model = Finite Open Tank
 b. Known Parameters Initially = Both Parameters (i.e. Liquid Surface Level & Surface Pres-

sure)
 c. Cross-Sectional Area = Constant, 14 meters2
 d. Liquid Level Specification = Height from Bottom
 e. Liquid Height = 12 meters
 f. Liquid Surface Pressure = 0 barG (kPa (g))

 g. Tank Height = 15 meters
 h. Pipe Elevation = 0 meters
 i. Tank Bottom Elevation = 0 meters

 2. J2 Reservoir
 a. Tank Model = Finite Open Tank
 b. Known Parameters Initially = Both Parameters (i.e. Liquid Surface Level & Surface Pres-

sure)
 c. Cross-Sectional Area = Constant, 14 meters2
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 d. Liquid Level Specification = Height from Bottom
 e. Liquid Height = 0 meters
 f. Liquid Surface Pressure = 0 barG (kPa (g))

 g. Tank Height = 15 meters
 h. Pipe Elevation = 0 meters
 i. Tank Bottom Elevation = 0 meters

 3. J3 Reservoir
 a. Tank Model = Finite Open Tank
 b. Known Parameters Initially = Both Parameters (i.e. Liquid Surface Level & Surface Pres-

sure)
 c. Cross-Sectional Area = Constant, 14 meters2
 d. Liquid Level Specification = Height from Bottom
 e. Liquid Height = 3 meters
 f. Liquid Surface Pressure = 0 barG (kPa (g))

 g. Tank Height = 15 meters
 h. Pipe Elevation = 0 meters
 i. Tank Bottom Elevation = 0 meters

 Step 5. Define the Transient Control Group

Open Analysis Setup again and navigate to the Simulation Duration panel, part of the Transient Control 
group. 

For this example, with a Start Time of 0 minutes, set the Stop Time to 120 minutes with a time step of 1 
minute. The output will be saved to the output file for every time step. 

 Step 6. Specify the Time Simulation Formatting

Open the Output Control window and select the Format & Action tab. Set the Time Simulation Formatting 
units to minutes and click OK to save and close the window.

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 7. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 
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 Step 8. Examine the Output

For this model, the output will be easiest to view as a graph, so select the Graph Results tab. Use the 
Graph Results window to plot the liquid height in each of the three reservoirs on the same plot. Figure 3 
shows the Graph Control tab of the Quick Access Panel for simultaneously plotting the transient liquid 
height in all three reservoirs. After selecting the Transient graphing tab, select Reservoir from the Pipes 
or Junctions drop-down menu.

Figure 4 show the resulting graph. Note that, as one would expect because the tanks are the same sizes 
and at the same elevations, the liquid heights between the tanks eventually reach the same equilibrium 
value.
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Figure 3: The transient liquid height in all three reservoirs can be selected in the Select Graph Data window
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Figure 4: Reservoir liquid heights can be plotted using the Graph Results window
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Valve Closing - XTS 

Summary

The objective of this example is to demonstrate how to set up an event based transient in the XTS mod-
ule for a valve junction. A valve is set to close when the liquid height in discharge tank reaches a spe-
cified level. 

Note: This example can only be run if you have a license for the XTS module.

Topics Covered

 l Defining Junction Transients
 l Understanding Transient Output

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition, it is assumed that the user has worked through the Beginner - Filling a Tank - XTS example, 
and is familiar with the basics of XTS transient analysis.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Valve Closing - XTS.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 2. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate XTS and select Transient to enable the XTS module for use. A 
new group will appear in Analysis Setup titled Transient Control. Click OK to save the changes and exit 
Analysis Setup. Open the Analysis menu to see the new option called Time Simulation. From here you 
can quickly toggle between Steady Only mode (normal AFT Fathom) and Transient (XTS mode).

 Step 3. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C

 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 1: Workspace for XTS Valve Closing example

The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties. The required information is highlighted in blue. 

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 4 inch 
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Lengths = 

Pipe Length (meters)

1 6

2 300

3 6

Junction Properties
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 1. J1 Reservoir
 a. Name = Lower Reservoir
 b. Tank Model = Infinite Reservoir
 c. Liquid Surface Elevation = 3 meters
 d. Liquid Surface pressure = 0 barG (0 kPa (g))
 e. Pipe Depth = 3 meters

 2. J2 Pump 
 a. Inlet Elevation = 0 meters
 b. Pump Model = Centrifugal (Rotodynamic)
 c. Analysis Type = Pump Curve
 d. Enter Curve Data = 

Volumetric Head

m3/hr meters

0 90

115 115

230 75

 e. Curve Fit Order = 2
 1. J3 Valve 

 a. Inlet Elevation = 60 meters
 b. Valve Data Source = User Specified
 c. Loss Model = Cv
 d. Loss Source = Fixed Cv
 e. Cv = 100

 3. J4 Reservoir
 a. Name = Upper Reservoir
 b. Tank Model = Finite Open Tank
 c. Known Parameters Initially = Both Parameters
 d. Cross-Sectional Area = Constant, 14 meters2
 e. Liquid Height Specification = Height from Bottom
 f. Liquid Height = 0 meters

 g. Liquid Surface Pressure = 0 barG (0 kPa (g))
 h. Tank Height = 9 meters
 i. Pipe Elevation = 60 meters
 j. Tank Bottom Elevation = 60 meters

 Step 5. Define the Transient Control Group

Open Analysis Setup again and navigate to the Simulation Duration panel, part of the Transient Control 
group. 
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For this example, with a Start Time of 0 minutes, set the Stop Time to 60 minutes with a time step of 1 
minute. The output will be saved to the output file for every time step. 

 Step 6. Specify the Time Simulation Formatting

Open the Output Control window and select the Format & Action tab. Set the Time Simulation Formatting 
units to minutes and click OK to save and close the window.

 Step 7. Enter the Valve Transient Data

For this example, we will set an event-based transient on the valve junction such that when the liquid elev-
ation in the reservoir reaches a height of 5 meters, the valve will close over a period of 30 seconds. Junc-
tion transient events are defined on the Transient Data tabs in the Junction Properties windows. Open 
the J3 Valve Properties window, and select the Transient tab.

Transients for junctions can be defined as either time based or event based transients. A time based tran-
sient starts at a specified absolute time. Event based transients are initiated when a defined criteria, such 
as when a pressure in a particular pipe is reached or exceeded. There are three types of event transients 
for junctions. Single event transients are events that occur only once in a simulation. Dual cyclic events 
are two transient events that repeat one after the other as many times as the event triggers occur during 
a simulation (such as a valve closing then reopening). Dual sequential transient events are two transients 
events which occur one after the other, without repeating.

For this example, we will define a single transient event. The event will occur when the liquid height in the 
upper reservoir reaches 5 meters. When the liquid height reaches 5 meters, the valve will close over a 
period of 30 seconds.

Figure 2 shows the Transient Data tab for the Valve Properties window. The transient event is defined in 
the Initiation of Transient area. This is where the event that will trigger the transient event is defined. The 
profile of what occurs when the transient is initiated is defined in the Transient Data area. For this 
example, the transient data consists of the valve closing profile. The valve Cv profile is specified over the 
time period that the valve is to close. In this example, the Cv profile is linear over the 30-second closing 
time.  Enter the transient data as shown below and in Figure 2, then select OK.

 1. Transient tab
 a. Transient Special Condition = None
 b. Initiation of Transient = Single Event
 c. Event Type = Reservoir Liquid Height
 d. Condition = Greater Than
 e. Value = 5 meters
 f. Junction = 4 (Upper Reservoir)

 g. Transient Data = Absolute Values
 h. Data Points = 

Time (seconds) Cv

0 100



Valve Closing - XTS

- 249 -

Time (seconds) Cv

30 0

3600 0

 
Figure 2: Valve closing Event Transient definitions are made on the Transient tab in the Valve Properties win-

dow

Fathom will display a T next to the junction label on the workspace when a transient has been defined for 
a junction.

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 8. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 
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 Step 9. Examine the Output

When junction event transients occur, these events are recorded and displayed in the general output sec-
tion of the Output Window. Open the Output Control and navigate to Format & Action. Change the Time 
Simulation Formatting to minutes. The events are displayed on two different tabs. The first tab sorts the 
events by junction number, and the second tab sorts the events by time, in the order in which they occur. 
The tabs are shown in Figure 3:

Figure 3: Event Transient Tabs in are shown in the General Output section of the Output Window

A Quick Graph plot of the liquid height in the reservoir, shown in Figure 4, shows that the final liquid 
height in the Upper Reservoir is about 5.2 meters. This is because the valve closes over a 30-second 
period. The valve starts to close when the liquid reaches 5 meters. During the 30-second period that the 
valve is closing, liquid continues to flow into the tank. Thus, there is some overshoot which results in 
approximately 20 additional centimeters of fluid being added to the tank. This can also be seen by look-
ing at the liquid height at the final time step shown on the Reservoir Transient tab.
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Figure 4: A Quick Graph plot can be used to plot reservoir liquid height showing overshoot due to valve clos-
ure time
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Controlled Heat Exchanger Temperature - XTS 

Summary

Use the Extended Time Simulation module to determine the length of time required to fill the discharge 
reservoir, and to turn off the pump when the tank is full.

The discharge reservoir is a finite size tank, 6 meters high, with a cross sectional area of 7.5 meters2. 
The pump is to shut off when the tank is filled. How long does it take to fill the tank? What happens after 
the pump is turned off?

Note: This example can only be run if you have a license for the XTS module.

Topics Covered

 l Defining Transient Control
 l Defining system transients

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition, it is assumed that the user has worked through the Beginner - Filling a Tank - XTS example, 
and is familiar with the basics of XTS transient analysis.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Controlled Heat Exchanger Temperature.fth
 l Metric - Controlled Heat Exchanger Temperature - XTS.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 2. Open the Model

Open the Metric - Controlled Heat Exchanger Temperature.fth example file and save it as a new file. 
The workspace should look like Figure 1 below.

Important: The XTS and GSC modules and cost calculations can be used in the same run to sim-
ulate control functions over time, but we are not going to do this here.

Figure 1: Workspace for XTS Controlled Heat Exchanger Temperature example

 Step 3. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate XTS and select Transient to enable the XTS module for use. A 
new group will appear in Analysis Setup titled Transient Control. Click OK to save the changes and exit 
Analysis Setup. Open the Analysis menu to see the new option called Time Simulation. From here you 
can quickly toggle between Steady Only mode (normal AFT Fathom) and Transient (XTS mode).

Note: The XTS module does not perform heat transfer calculations. You will be prompted to disable 
heat transfer calculations in order to proceed with modeling a transient. Click Yes.

 Step 4. Define Pipes and Junctions group

Most of the input is already entered. The only exception is for Reservoir J9. Enter the following  junction 
properties.
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 1. J3 Three Way Valve
 a. Library Jct = (None)
 b. Actual Percent Open = 79 %

 i. This value comes from the Actual Percent Open value calculated from the GSC 
example

 2. J9 Reservoir
 a. Name = Discharge Reservoir
 b. Tank Model = Finite Open Tank
 c. Known Parameters Initially = Liquid Surface Level & Surface Pressure
 d. Cross-Sectional Area = Constant, 7.5 meters2
 e. Liquid Level Specification = Height from Bottom
 f. Liquid Height = 0 meters

 g. Liquid Surface Pressure = 0.3 barG (30 kPa (g))
 h. Tank Height = 6 meters
 i. Pipe Elevation = 6 meters
 j. Tank Bottom Elevation = 6 meters

 Step 5. Setup the Transient Data

For this example, we will set an event-based transient on the pump so the pump will turn off when the 
liquid level in the discharge tank reaches 6 meters.

You will define a single transient event. The event will occur when the liquid height in the reservoir 
reaches 6 meters. When the liquid height reaches 6 meters, the pump speed will drop from 100% to 0% 
in 10 seconds.

Open the Pump Properties window, and enter the following information. Then the  Transient tab should 
appear as shown in Figure 2.

 1. Library Jct = (None)
 2. Transient tab

 a. Transient Type = Speed vs. Time
 b. Transient Special Condition = None
 c. Initiation of Transient = Single Event
 d. Event Type = Reservoir Liquid Height
 e. Condition = Greater Than or Equal To
 f. Value = 6 meters

 g. Junction = 9 (Discharge Reservoir)
 h. Transient Data = Absolute Values
 i. Data Points = 

Time (seconds) Speed (Percent)

0 100

10 0
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Figure 2: Junction transients are specified on the Transient tabs on the junction Properties windows

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 6. Define the Transient Control Group

Open Analysis Setup again and navigate to the Simulation Duration panel, part of the Transient Control 
group. 

For this example, with a Start Time of 0 minutes, set the Stop Time to 45 minutes with a time step of 1 
minute. The output will be saved to the output file for every time step. 

 Step 7. Specify the Time Simulation Formatting

Open the Output Control window and select the Format & Action tab. Set the Time Simulation Formatting 
units to minutes and click OK to save and close the window.
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 Step 8. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 9. Examine the Output

Open the Output Control and navigate to Format & Action. Change the Time Simulation Formatting selec-
tion to minutes and click OK. The transient reservoir data shows that the water in the discharge tank 
reached a height of 6 meters in 31 minutes. This is confirmed by the event message indicating the pump 
transient also initiated at this time (Figure 4).

The Quick Graph plot (Figure 3) shows the tank liquid height over time. To create this graph, go to the 
Reservoir Transient tab in the top section of the window, then right-click on any of the Liq. Height cells for 
the Discharge Reservoir, junction J9, and select the Quick Graph option. There is an increase in the tank 
liquid height until the time when the pump turns off. The graph then shows that there is actually back flow 
into the system, due to the hydrostatic pressure of the fluid in the tank. This explains why there is a Crit-
ical Warning, which states that the pump head cannot be predicted due to reverse flow through the 
pump. A check valve would need to be added to the system to prevent this situation in the case of pump 
shutdown.

Figure 3: The liquid level in a finite tank junction can change with time
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Figure 4: Event transients occurrences are recorded in the General section of the Output Window
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Housing Project - XTS 

Summary

This example uses the XTS module to simulate a supply pump used to replenish a water storage tank 
that is used to supply water to a housing development. There is a requirement that the height of the liquid 
in the water supply tank is not to drop below 3 meters. Use the flow conditions specified in the 4 inch 
Pipe scenario (not the fire flow scenarios) of the Housing Project walk-through example as the basis for 
this example.

Note: This example can only be run if you have a license for the XTS module.

Topics Covered

 l Using Dual Cyclic Junction Transients
 l Understanding Transient Output
 l Resolving Time Step issues

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition, it is assumed that the user has worked through the Beginner - Filling a Tank - XTS example, 
and is familiar with the basics of XTS transient analysis.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Housing Project.fth
 l Metric - Housing Project - XTS.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

https://www.aft.com/products/fathom/video-tutorial-series
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To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the model

Open the Metric - Housing Project.fth example file.  Right-click on the 4 inch Pipe scenario and select 
Save Scenario to File Without Children and save this scenario to a new model file.

The Workspace should look like Figure 1 below:

Figure 1: Workspace for XTS Water to Housing Project Example

For this example, we will be changing the West Lake junction (J1) from an infinite reservoir to a finite 
water supply tank. We will then add a new supply reservoir, as well as a supply pump and a check valve 
to the system. The new supply pump will replenish the supply tank as the water level in the tank is 
depleted.

 Step 3. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate XTS and select Transient to enable the XTS module for use. A 
new group will appear in Analysis Setup titled Transient Control. Click OK to save the changes and exit 
Analysis Setup. Open the Analysis menu to see the new option called Time Simulation. From here you 
can quickly toggle between Steady Only mode (normal AFT Fathom) and Transient (XTS mode).
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 Step 4. Modify the existing model

Figure 2: Workspace for XTS water to Housing Project example with supply pump system added

Modify the workspace to include the new supply reservoir, supply pump, check valve, and piping as 
shown in Figure 2. You may need to move the objects to the right on the Workspace to create room for 
the new pipes and junctions. Do this by selecting all pipes and junctions by either using CTRL+A or click-
and-drag and selection box encompassing all objects. Then click, hold, and drag the objects to the right. 
Now define the new objects.

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = PVC - ASTM
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 4 inch 
 d. Type = schedule 40
 e. Friction Model Data Set = Standard
 f. Lengths = 

Pipe Length (meters)

300 7.5

301 150

302 1.5
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Junction Properties

 1. J300 Reservoir
 a. Name = West Lake
 b. Tank Model = Infinite Reservoir
 c. Liquid Surface Elevation = 0 meters
 d. Liquid Surface Pressure = 0 barG (0 kPa (g))
 e. Pipe Depth = 0 meters

 2. J301 Pump
 a. Inlet Elevation = 0 meters
 b. Pump Model = Centrifugal (Rotodynamic)

 i. Analysis Type = Pump Curve
 ii. Enter Curve Data = 

Volumetric Head

m3/hr meters

0 300

45 350

90 240

 iii. Curve Fit Order = 2
 c. Optional tab

 i. Special Condition = Pump Off With Flow Through
 1. J302 Check Valve

 a. Inlet Elevation = 60 meters
 b. Loss Model = Cv
 c. Cv = 10
 d. Forward Velocity to Close Valve = 0 meters/sec
 e. Delta Pressure/Head to Reopen  = Pressure
 f. Delta Pressure = 0 bar (kPa)

 2. J1 Reservoir
 a. Name = Supply Tank
 b. Tank Model = Finite Open Tank
 c. Known Parameters Initially = Both Parameters (Liquid Surface Level & Surface Pressure)
 d. Cross-Sectional Area = Constant, 6.5 meters2
 e. Liquid Level Specification = Height from Bottom
 f. Liquid Height = 4.9 meters

 g. Liquid Surface Pressure = 0 barG (0 kPa (g))
 h. Tank Height = 5 meters
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 i. Pipe Depth = 5 meters
 j. Tank Bottom Elevation = 60 meters

 Step 5. Define the Transient Control Group

Open Analysis Setup again and navigate to the Simulation Duration panel, part of the Transient Control 
group. 

For this example, with a Start Time of 0 minutes, set the Stop Time to 120 minutes with a time step of 1 
minute. The output will be saved to the output file for every time step. 

 Step 6. Specify the Time Simulation Formatting

Open the Output Control window and select the Format & Action tab. Set the Time Simulation Formatting 
units to minutes and click OK to save and close the window.

 Step 7. Enter the Pump Transient Data

For this example, the pump will be set to turn on when the liquid level in the supply tank drops below 3 
meters, and turn off when the water level returns to 5 meters. To do this, we will use a Dual Event Cyclic 
event transient.

The Dual Event Cyclic event requires that two transients be defined. In this case, the first transient will be 
the pump turning on when the water level drops below 3 meters, and the second transient will be the 
pump turning off when the water level returns to 5 meters. The pump speed transients need to be 
included for both transient events as well. Enter the following in the pump properties window.

 1. Transient tab
 a. Transient Type = Speed vs. Time
 b. Transient Special Condition = None
 c. Initiation of Transient = Dual Event Cyclic
 d. First Event

 i. Event Type = Reservoir Liquid Height
 ii. Condition = Less Than or Equal To
 iii. Value = 3 meters
 iv. Junction = 1 (Supply Tank)

 e. First Transient = 

Time (seconds) Speed (Percent)

0 0

30 100
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 e. Second Event
 i. Event Type = Reservoir Liquid Height
 ii. Condition = Greater Than or Equal To
 iii. Value = 5 meters
 iv. Junction = 1 (Supply Tank)

 e. Second Transient = 

Time (seconds) Speed (Percent)

0 100

30 0

Figure 3: First Event and First Transient Data for Water to Housing Project XTS example 
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Figure 4: Second Event and Second Transient Data for Water to Housing Project XTS example

For this example, at the beginning of the simulation, the storage tank is full, so the pump will not be run-
ning initially. To account for this, the pump Special Condition on the Optional Tab must be set to Pump 
Off With Flow Through. In order to be consistent, the First Transient defined must be defined with an ini-
tial speed of 0, indicating a pump startup.

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 8. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 



Housing Project - XTS

- 265 -

 Step 9. Examine the Output

Figure 5 shows a Quick Graph plot of the liquid height in the J1 Supply Tank. The plot illustrates how the 
Dual Event Cyclic transient will repeat continuously as the event to trigger each transient is met, in turn. 
The plot shows the tank draining due to the flow to the housing project. When the liquid level reaches 3 
meters, the pump starts, causing the liquid level in the tank to rise again. When the level reaches 5 
meters, the transient to stop the pump is initiated. Because the liquid level reaches the top of the tank at 
this time, the Warnings tab will display a warning about the tank overflowing at 73 minutes. With the 
pump turned off, the tank drains until the level drops to 3 meters and the pump is started again. 

The plot shows the liquid level dropping below 3 meters. This is due, primarily with the time step res-
olution that was set in Transient Control. The time step was set to 1 minute, but the pump startup tran-
sient is 30 seconds. The size of the time step leads to overshoot in the calculations. Open the 
Simulation Duration panel, and set the time step to 10 seconds. Set the output to save to file every 6th 
time step (write output once every minute). The results from this case are shown in Figure 6. The results 
using the 10-second time step clearly show the effect of using the smaller time step.

The user should always carefully consider the time step being used in relation to the length of the tran-
sient events defined for their analysis.

Note: You may notice a warning message indicating that the static pressure is lower than vapor pres-
sure at the outlet of pipe 301. Since this example is for demonstration purposes only, this warn-
ing may be ignored. However, warnings should otherwise never be ignored.

Figure 5: Plot of Supply Tank liquid level showing Dual Event Cyclic transient
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Figure 6: Plot of Supply Tank liquid level with 10-second time step
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Variable Demand - XTS 

Summary

This example uses a pump transient to initiate auxiliary pump start up for a system with variable 
demands to ensure adequate pressure drop across a control valve. Additional loads will be added to the 
system every 30 seconds, until the control valve open percentage exceeds 50%. At that time, the aux-
iliary pump will start to handle the additional capacity.

Note: This example can only be run if you have a license for the XTS module.

Topics Covered

 l Defining Control Valve Event Transient
 l Understanding Transient Output
 l Using Transient Graphs

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition, it is assumed that the user has worked through the Beginner - Filling a Tank - XTS example, 
and is familiar with the basics of XTS transient analysis.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Variable Demand - XTS.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 2. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate XTS and select Transient to enable the XTS module for use. A 
new group will appear in Analysis Setup titled Transient Control. Click OK to save the changes and exit 
Analysis Setup. Open the Analysis menu to see the new option called Time Simulation. From here you 
can quickly toggle between Steady Only mode (normal AFT Fathom) and Transient (XTS mode).

 Step 3. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C

 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

Figure 1: Workspace for XTS Variable Demand example
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The system is in place but now we need to enter the properties of the objects. Double-click each pipe and 
junction and enter the following properties. The required information is highlighted in blue. 

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = PVC - ASTM
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 4 inch 
 d. Type = schedule 40
 e. Friction Model Data Set = Standard
 f. Lengths = 

Pipe Length (meters)

1-7 & 10-19 3

8 & 9 15

Junction Properties

 1. J1 Reservoir
 a. Tank Model = Finite Open Tank
 b. Known Parameters Initially = Both Parameters
 c. Cross-Sectional Area = Constant, 2 meters2
 d. Liquid Level Specification = Height from Bottom
 e. Liquid Height = 3 meters
 f. Liquid Surface Pressure = 0 barG (0 kPa (g))

 g. Tank Height = 3 meters
 h. Pipe Depth = 3 meters
 i. Tank Bottom Elevation = 0 meters

 2. J2, J7, & J9 Branches
 a. Elevation = 0 meters

 3. J3 & J5 Pumps
 a. Inlet Elevation = 0 meters
 b. Pump Model = Centrifugal (Rotodynamic)
 c. Analysis Type = Pump Curve
 d. Pump Curve Data = 

Volumetric Head

m3/hr meters

0 24
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Volumetric Head

m3/hr meters

28 27

57 15

 e. Curve Fit Order = 2
 4. J4 & J6 Valves

 a. Inlet Elevation = 0 meters
 b. Valve Data Source = User Specified
 c. Loss Model = Cv
 d. Loss Source = Fixed Cv
 e. Cv = 100

 5. J8 Control Valve
 a. Inlet Elevation = 0 meters
 b. Control Valve Model tab

 i. Valve Type = Pressure Reducing (PRV)
 ii. Always Control (Never Fail) = Unchecked
 iii. Control Setpoint = Pressure, Static
 iv. Setpoint = 3.1 bar (310 kPa)
 v. Loss When Fully Open = Cv
 vi. Loss Source = From Open % Table (on Optional Tab)

 c. Optional tab
 i. Open Percentage Data =

Open Pct. Cv

0 0

100 100

 6. J10, J12, J14, J16, & J18 Valves
 a. Inlet Elevation = 3 meters
 b. Valve Data Source = User Specified
 c. Loss Model = Cv
 d. Loss Source = Fixed Cv
 e. Cv = 10

 7. J11, J13, J15, J17, & J19 Assigned Pressures
 a. Elevation = 3 meters
 b. Pressure = 0 barG (0 kPa (g))
 c. Pressure Specification = Stagnation
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 Step 5. Define the Transient Control Group

Open Analysis Setup again and navigate to the Simulation Duration panel, part of the Transient Control 
group. 

For this example, with a Start Time of 0 minutes, set the Stop Time to 3 minutes with a time step of 5 
seconds. The output will be saved to the output file for every time step. 

 Step 6. Enter the Transient Data

Valve Transients

Initially, the only flow through the system will be through the J10 Valve. Valves J12, J14, J16, and J18 will 
start closed, and they will open 30 seconds apart, in sequence. Set the Special Condition for Valves J12, 
J14, J16, and J18 to Closed on the Valve Properties Optional tab. 

The valve opening transient for Valve J12 is shown in Figure 2. Valves J14, J16, and J18 should be set 
up with the same opening transient, and by adding 30 seconds to the Time Absolute event for each valve 
so that valve J14 opens at 60 seconds, valve J16 opens at 90 seconds, and valve J18 opens at 120 
seconds.

Note that a red XT will now be displayed next to the junction labels to show that these valves are closed, 
and have transients applied to them.
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Figure 2: Valve J12-J18 opening transient profiles are defined on the Transient tab on the Valve Properties 
window

Pump Transient

Pump J5 is not operating at the beginning of this simulation. On the Optional tab of the Pump Properties 
window set the Pump J5 Special Condition to Pump Off With Flow Through. The pump is set to start 
when the open percentage of Control Valve J8 exceeds 50%. The transient event definition and pump 
startup profile are shown in Figure 3.
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Figure 3: Pump J5 transient startup profile is defined on the Transient tab on the Pump Properties window

Isolation Valve J6 should be closed initially to prevent flow through the leg while Pump J5 is not oper-
ating. Do this by setting the Valve J6 Special Condition to Closed on the Optional tab. Valve J6 will open 
when Pump J5 starts. To do this, use the same transient event as defined for Pump J5. This is shown in 
Figure 4.
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Figure 4: Valve J6 opening transient profile is defined on the Transient tab on the Valve Properties window

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 7. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 8. Examine the Output

The occurrence of the transient events is recorded on two tabs in the General Output section. The first 
tab sorts the events by junction, and the second tab sorts the events chronologically. Figure 5 shows the 
chronological ordering of the transient events for this run. This output shows the downstream valves 
opening at 30-second intervals. It also shows that Pump J5 started 65 seconds into the run, and the isol-
ation valve J6 also opened at 65 seconds.
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Figure 5: A chronological list of Transient Events is shown in the General Output section of the Output Win-
dow

Plotting the speed of Pump J5 vs. time as a Quick Graph from the Output shows the pump starting up at 
65 seconds, and coming up to full speed over 5 seconds. This is shown in Figure 6.

Figure 6: Quick Graph can be used to plot the Pump J5 Speed vs. Time

Now go to the Graph Results window. A stacked graph can be made for the Control Valve J8 as shown in 
Figure 7 to see the affect of the opening valves on the flow rate at the control valve, as well as how the 
open percent at the control valve responds. It can be seen here that the control valve open percent 
reaches 50% at 65 seconds, which correlates with the beginning of the pump startup.
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To create these stacked graphs, go to the Transient tab in Graph Control. Change the Pipes or Junctions 
selection to Valves and check the box next the 8, Control Valve. At the bottom, click the Add button next 
to Select Parameter to add a second parameter to graph. Set the first parameter to Volumetric Flow Rate 
with m3/hr Units, and set the second parameter to Open Percentage with Percent Units. Now click Gen-
erate.

Figure 7: Stacked graph on the Graph results tab showing the Volumetric Flow Rate and Open Percentage 
over time at Control Valve J8
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Settling Slurry (SSL) Examples
The examples below utilize the Settling Slurry module.

Fathom SSL Examples

Example Complexity Fluid Pipes Pumps Description

Beginner - 
Pump Sizing for 
Sand Transfer 

System

Beginner Slurry 3 1

Learn the basics of the 
SSL module such as defin-
ing a Detailed slurry cal-
culation model in Analysis 
Setup, using the Slurry 
De-Rating feature in the 
Pump Properties window, 
adding Slurry parameters 
using the Output Control 
window, and generating 
Slurry System Curves in 
the Graph Results win-
dow.

Slurries with 
Variable Fluid 

Properties
Intermediate Water/Slurry 2-3 1

Learn how to use the SSL 
module with Variable Fluid 
Properties. See how to 
use the Volume Balance 
junction and the Simplified 
slurry calculation model.

Slurry System 
Feasibility 

Study
Advanced Slurry 1 0

Learn how to use the SSL 
module and the Scenario 
Manager to determine the 
feasibility of selected oper-
ating conditions. See how 
to use the Multi-Scenario 
output feature in the Out-
put window and how to per-
form a Batch run for a 
model with multiple scen-
arios.
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Beginner - Pump Sizing for Sand Transfer System - SSL 

Summary

This example shows how SSL can be used to size a slurry pump as part of a system design process. 
The piping for a slurry system that moves sand is being designed. The system will pump 25% sand by 
volume from an open supply vessel with a liquid surface elevation of 1.5 meters to an open receiving tank 
with a liquid surface elevation of 3 meters.

Use the SSL module to size the pump.

Note: This example can only be run if you have a license for the SSL module.

Topics Covered

 l Entering solids data
 l Reviewing calculated slurry output
 l Creating slurry system curves

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

 l Metric - Pump Sizing for Sand Transfer System - SSL.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 2. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate SSL and select Settling to enable the SSL module for use. The 
items in the Fluid Properties group will change to accommodate slurry definitions. Click OK to save the 
changes and exit Analysis Setup. Open the Analysis menu to see the new option called Slurry. From 
here you can quickly toggle between Disable mode (normal AFT Fathom) and Settling (SSL mode).

 Step 3. Define the Fluid Properties Group

Open Analysis Setup from the toolbar or from the Analysis menu and input the following on the respect-
ive panels.

 1. Carrier Fluid (Figure 1)
 a. Fluid Model = Basic (Water)
 b. Temperature = 21 deg. C

 2. Slurry Definition (Figure 2)
 a. Slurry Model = Settling Slurry - Wilson, Addie, Clift
 b. Slurry Calculation Method = Detailed
 c. Concentration Type = Volume Fraction
 d. Amount Solids Added = 25 Percent

 3. Solids Definition (Figure 3)
 a. Solids Specifications = User Specified Solids Added
 b. M (Stratification Ratio Exponent) = Calculated
 c. Terminal Velocity Parameter, Vt / Vts (Xi) = 1
 d. Density = 2.9 S.G. water
 e. d50 = 0.0381 cm
 f. d85 = 0.0762 cm
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Figure 1: Carrier Fluid panel in the Fluid Properties group in Analysis Setup with SSL activated

Figure 2: Slurry Definition panel in the Fluid Properties group in Analysis Setup with SSL activated
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Figure 3: Solids Definition panel in the Fluid Properties group in Analysis Setup with SSL activated

 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 4: Layout of pipe system for Pump Sizing for Sand Transfer System example

Enter the following pipe and junction properties.

Pipe Properties

 1. All Pipes
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 12 inch
 d. Type = STD
 e. Friction Model Data Set = Standard
 f. Length = 

Pipe Length (meters)

1 6

2 150

3 15

Junction Properties

 1. J1 Reservoir
 a. Name = Supply Tank
 b. Liquid Surface Elevation = 1.5 meters
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 c. Liquid Surface Pressure = 0.7 barG (70 kPa(g))
 d. Pipe Depth = 1.5 meters

 2. J2 Pump 
 a. Inlet Elevation = 0 meters
 b. Pump Model tab

 i. Pump Model = Centrifugal (Rotodynamic)
 ii. Analysis Type = Sizing
 iii. Parameter = Mass Flow Rate
 iv. Fixed Flow Rate = 1270 m-ton/hr Solids

 c. Slurry De-Rating tab
 i. De-Rating Method = ANSI/HI Standard 12.1-12.6-2016
 ii. Percent Fines = 0 %
 iii. Head De-Rating Data = Specify Impeller Size Directly
 iv. Impeller Size = 20 cm

 3. J3 Elbow 
 a. Inlet Elevation = 0 meters
 b. Type = Standard Elbow (knee, threaded)
 c. Angle = 90 Degrees

 4. J4 Reservoir
 a. Name = Receiving Tank
 b. Liquid Surface Elevation = 3 meters
 c. Liquid Surface Pressure = 2 barG (200 kPa(g))
 d. Pipe Depth = 3 meters

To show the names of the  reservoirs, a new Workspace Layer will be created.

 1. Create a new layer by selecting New Layer and then Blank Layer from the Workspace Layers tab 
of the Quick Access Panel.

 2. Name the layer Reservoir Labels.
 3. Edit the layer by selecting it and clicking the gear icon to bring up the Layer Settings window.
 4. Open the Show/Hide Labels panel and uncheck Force Shown Labels to Match Shown Objects.
 5. Toggle the visibility icon next to the reservoirs to on. This will cause their labels to be shown.
 6. Navigate to the Junction Parameters panel and expand the Commonly Used Junction Parameters 

list.
 7. Double-click Junction Name to add it to the list on the right-hand side. This will add the Junction 

Name to the label of the junctions that were defined in the Show/Hide Labels panel.
 8. Close the Layer Settings window.

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.
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 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 6. Examine the Output

Open the Output Control window by selecting Output Control from the Output toolbar or Tools menu.

On the Display Parameters tab, click the Pumps button, and add the De-rating Head Correction factor 
(CH) to the Pump Summary output.

The Output Control window can also be used to configure the slurry output data, as is shown in Figure 5. 
Click OK when you are finished.

Figure 5: The Output Control window can be used to configure the slurry output data

The Slurry tab in the pipes section shows the slurry results, as shown in Figure 6. Here one can see that 
the velocity is 6.674 meters/sec, which is safely above the 3.498 meters/sec max settling velocity. Other 
pressure drop and relevant slurry data can be viewed here.



Settling Slurry (SSL) Examples

- 285 -

Also shown in Figure 6 is the Pump Summary in the General Section. There, the required pump head is 
shown as 27.81 meters, and the de-rating head correction factor is 0.7887. Hence a pump should be 
selected that can generate 27.81/0.7887 = 35.26 meters of head based on water.

Figure 6: The Output window shows the Slurry results table in the center Pipes section and the pump de-rat-
ing in the Pump Summary in the upper General section

Also of interest is the system curve. Select the Graph Results window tab then in the Graph Control tab in 
the Quick Access Panel select the Slurry System Curve tab. See Figure 7.

By default the parameter to graph is Jm vs. Velocity. Select the units of Jm as m/m that will make it com-
pletely dimensionless as is typically done. Check the box for Water System Curve which cross-plots the 
water curve and then click Generate. The curves are shown in Figure 8.
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Figure 7: Data selection for graphing slurry system curve
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Figure 8: Slurry system curve and water curve in Graph Results window

Conclusion

The pump head requirements were determined, and a de-rating factor was calculated according to the 
ANSI/HI Standard 12.1-12.6-2016. The de-rating factor for pump head (CH) was used to manually cal-
culate pump head using water, such that the correct size pump could be selected when looking at man-
ufacturer data based on water curves. The velocity in each pipe was found to be higher than the max 
settling velocity (Vsm) of the sand and water slurry which ensured that no settling would occur. A slurry 
system curve was created to allow the user to see where the system was operating with respect to solids 
settling.
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Slurries with Variable Fluid Properties - SSL 

Summary

This example demonstrates the fundamental concepts of the Settling Slurry (SSL) add-on module by 
way of example. The example shows how SSL can be used to model the introduction of solids into a 
clear fluid stream.

Evaluate pump and system performance for a slurry system that will pump 30% sand by volume for three 
cases:

 1. Pumping clear water (no solids in system)
 2. Solids introduced into the system, and propagated through to the pump discharge
 3. Solids have propagated through the entire system

This example is essentially modeling four snapshots in time as the slurry is injected and pumped through 
the pipeline.  These four snapshots in time can be modeled through the usage of the Volume Balance 
junction.

Note: This example can only be run if you have a license for the SSL module.

Topics Covered

 l Entering solids data
 l Using Volume Balance junctions with variable fluid properties
 l Creating slurry system curves and evaluating pump performance

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition the user should have worked through Beginner - Pump Sizing for Sand Transfer System - 
SSL example.

Model File

This example uses the following file, which is installed in the Examples folder as part of the AFT Fathom 
installation:

VolumeBalancePropertiesWindow.html
VolumeBalancePropertiesWindow.html
https://www.aft.com/products/fathom/video-tutorial-series
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 l Metric - Slurries with Variable Fluid Properties - SSL.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate SSL and select Settling to enable the SSL module for use. The 
items in the Fluid Properties group will change to accommodate slurry definitions. Click OK to save the 
changes and exit Analysis Setup. Open the Analysis menu to see the new option called Slurry. From 
here you can quickly toggle between Disable mode (normal AFT Fathom) and Settling (SSL mode).

 Step 3. Define the Fluid Properties Group

Open Analysis Setup from the toolbar or from the Analysis menu and input the following on the respect-
ive panels.

 1. Carrier Fluid - Figure 1
 a. Fluid Model = Advanced
 b. Fluid Library = AFT Standard
 c. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 d. Temperature = 4 deg. C
 e. Select Variable Fluid Properties

 2. Solids Definition - Figure 2
 a. Slurry Calculation Method = Simplified
 b. Solids Specifications = User Specified Solids Added
 c. M (Stratification Ratio Exponent) = User Specified
 d. Value = 1.7
 e. Density = 2.65 S.G. water
 f. d50 = 0.041 cm

 3. Slurry Definition - Figure 3
 a. Slurry Calculation Method = Simplified (this selection will be the same as on the Solids 

Definition panel)
 b. Concentration Type = Volume Fraction
 c. Amount Solids Added = 30 Percent
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Figure 1: Carrier Fluid panel in the Fluid Properties group in Analysis Setup with SSL activated

Figure 2: Solids Definition panel in the Fluid Properties group in Analysis Setup with SSL activated
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Figure 3: Slurry Definition panel in the Fluid Properties group in Analysis Setup with SSL activated

 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 4: Layout of pipe system for Pump Sizing for Sand Transfer System example

Enter the following pipe and junction properties.

Pipe Properties

 1. All Pipes
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 6 inch
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Length = 

Pipe Length (meters)

1 15

2 305

Junction Properties
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 1. J1 & J3 Assigned Pressures
 a. Elevation = 0 meters
 b. Pressure = 10.34 barG (1034 kPa (g))
 c. Pressure Specification = Stagnation

 2. J2 Pump 
 a. Inlet Elevation = 0 meters
 b. Pump Model = Centrifugal (Rotodynamic)
 c. Analysis Type = Pump Curve
 d. Enter Curve Data = 

Volumetric Head Efficiency

m3/hr meters Percent

0 60 -

115 57 45

183 53 64

251 47 75

319 40 77

387 30 74

 e. Curve Fit Order = 2

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 5. Create the Scenarios             

For this example, there are four cases to be examined.  Create a scenario for each of the four cases, as 
shown in Figure 5:
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Figure 5: Use the Scenario Manager on the Quick Access Panel to create the four analysis cases

Clear Water Scenario

Load the Clear Water scenario by double-clicking the scenario name in the Scenario Manager.

This case requires that the pipes use clear water as their fluid. As pipes are drawn on the workspace, 
they automatically assume the same fluid type that is defined in the Analysis Setup window. As a result, 
at this point, all of the pipes are defined as using the sand slurry. Reset both pipes to use only water by 
opening the pipe properties window and inputting the following:

 1. Fluid Properties tab
 2. Fluid Properties button
 3. In the Analysis Setup window that appears, click the Solids Definition item, and select No Solids 

Added, as shown in Figure 6. This will treat the fluid as clear water.
 4. Click OK.
 5. Make sure to do this to both pipes.
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Figure 6: Fluids can be treated as clear fluid by selecting No Solids Added as the Solids Specification

Slurry to Pump Suction Scenario

Now load the Slurry to Pump Suction as the active scenario in the Workspace.

For the case where the fluid far upstream of the pump suction is slurry, and the fluid just upstream of the 
pump is clear water, a Volume Balance junction must be used to account for the difference in fluid dens-
ity. The Volume Balance junction balances the flow based on volume rather than mass, ensuring that the 
velocity across the interface is the same. This junction must be used any time there is a system interface 
with fluids of different densities. 

Add a Volume Balance junction just upstream of the pump suction by splitting the pipe as follows:

 1. While holding the Shift key drag and drop the Volume Balance junction over pipe P1.
 2. In the dialogue box set Pipe A as 14.99 meters, then select OK. The Workspace should now 

appear as shown in Figure 7. This will insert the fluid interface shortly before the pump suction.
 3. Open the Volume Balance properties window for junction J4 and check that the elevation is 0 

meters.

This case requires that the short pipe just upstream and the pipe downstream of the pump use clear 
water as their fluid. Set both pipes P2 and P3 to use only water as follows:

VolumeBalancePropertiesWindow.html
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 1. Fluid Properties tab
 2. Fluid Properties button
 3. In the Analysis Setup window that appears, click the Solids Definition item, and select No Solids 

Added, as shown in Figure 6. This will treat the fluid as clear water.
 4. Click OK.
 5. Make sure to do this to both pipes.

Figure 7: Layout of pipe system for partial slurry case with slurry at the pump suction showing the Volume 
Balance junction for the Slurries with Variable Fluid Properties example

Slurry to Pump Discharge Scenario

Load the Slurry to Pump Discharge scenario as the active scenario.

For the case where the fluid upstream and just downstream of the pump discharge is slurry, and the rest 
of the system downstream is clear water, a Volume Balance junction must be used again to account for 
the difference in fluid density. 

Add a Volume Balance junction just downstream of the pump discharge by splitting pipe 2.

 1. While holding the Shift key drag and drop the Volume Balance junction over pipe P2.
 2. In the dialogue box set Pipe A as 0.01 meters, then select OK. The Workspace should now 

appear as shown in Figure 8. This will insert the fluid interface shortly after the pump discharge.
 3. Open the Volume Balance properties window for junction J5 and check that the elevation is 0 

meters.

This case requires that the pipe P4 downstream of the pump use clear water as its fluid. Set pipe P4 to 
use only water as follows:
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 1. Fluid Properties tab
 2. Fluid Properties button
 3. In the Analysis Setup window that appears, click the Solids Definition item, and select No Solids 

Added, as shown in Figure 6. This will treat the fluid as clear water.
 4. Click OK.

Figure 8: Layout of pipe system for partial slurry case with slurry at the pump discharge showing the Volume 
Balance junction for the Slurries with Variable Fluid Properties example

All Slurry Scenario

For this case, all of the pipes contain the sand slurry. The system layout is the same as is shown in Figure 
4.

 Step 6. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

Note: All scenarios can be run automatically by Fathom by completing a Batch Run from the File 
menu.
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 Step 7. Examine the Output

Table 1 shows the variation of the system flows, velocities, and pump performance as the slurry pro-
gresses through the system.

Figure 9 shows the pump curve plotted along with both the water and slurry system curves. This graph 
was generated in the All Slurry scenario using the Slurry System Curve graph type.

As the slurry progresses from the system inlet to the pump suction, the system volumetric flow rate, 
pump head, and power are not significantly changed (compare Table 1 output for Clear Water to Slurry to 
Pump Suction). 

After the slurry arrives at the pump discharge (compare Table 1 output for Slurry to Pump Suction to 
Slurry to Pump Discharge), there is a notable increase in the system volumetric flow rate (318.8 to 362.5 
m3/hr). This is a result of the new density passing into the pump, which results in a different velocity in the 
pipe line (4.752 to 5.403 meters/sec), a different pressure loss (which varies as velocity squared, and the 
velocity is now higher), and hence a different head rise on the pump. This shifts the pump operation out 
on the curve to a higher flow rate and lower head (39.59 to 33.78 meters).

Eventually the slurry fills the entire pipe (compare Table 1 output for Slurry to Pump Discharge to All 
Slurry). Because of the increased overall head loss of the slurry compared to water, the system shifts 
back on the pump curve to a lower flow rate (362.5 to 339.6 m3/hr) and higher head rise (33.78 to 36.92 
meters). The system operating velocity also drops (5.403 to 5.061 meters/sec).

The power requirement on the pump increases from the Clear Water to All Slurry scenario as the system 
progresses from all water to all slurry.

Of significance here is the fact that, perhaps counter to intuition, the clear water and all slurry cases do 
not encompass the entire flow and system performance cases for the pump. The highest and lowest flow 
cases actually occur as the system is only partially full of slurry. Care should be taken to examine inter-
mediate slurry flow cases to determine system feasibility for situations where slurry is being introduced 
into the flow, as the maximum and minimum flow cases will not necessarily occur when the system is 
flowing all clear fluid, or all slurry.

It is difficult to quantify the intermediate cases through the use of pump vs. system curves. This is a result 
of the variation in density that occurs in the system, which confuses the meaning of Head which itself 
depends on constant density. Thorough analysis is needed in these cases. Figure 9 shows the clear 
water and all slurry system curves.

Finally, note that to keep the example clearer, the effect of pump de-rating was not addressed. In real sys-
tems when the slurry progresses from the Slurry to Pump Suction case to the Slurry to Pump Discharge 
case, there will be a further decrease in pump performance which will effectively lower the pump curve in 
Figure 9. This would serve to shift operation to even higher flow rates for the Slurry to Pump Discharge 
and All Slurry cases.

Table 1: System flow and pump performance for different scenarios. The velocity and volumetric flow results 
are for the inlet of the pipe at the pump discharge
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Parameter Vol. Flow 
Rate Velocity dP dH Overall 

Power

Units m3/hr meters/sec bar meters kW

Clear Water 320.4 4.774 3.868 39.40 44.17

Slurry to 
Pump Suction 318.8 4.752 3.887 39.59 44.17

Slurry to 
Pump Dis-

charge
362.5 5.403 4.953 33.78 65.55

All Slurry 339.6 5.061 5.413 36.92 65.94

Figure 9: Plotting the pump curve along with the water and slurry system curves illustrates how the pump 
performance will vary as the slurry progresses through the system
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Slurry System Feasibility Study - SSL (Metric Only)

Summary

Note: Because this example is presented in SI units in the reference from which it was taken, it is 
presented in the same units here for consistency when discussing the results.

This example demonstrates how the Settling Slurry (SSL) add-on module can be used to evaluate the 
feasibility of a slurry system operating point. The example is based on Case Study 13.1 found on page 
329 of Slurry Transport Using Centrifugal Pumps, 3rd Edition, by Wilson, Addie, Sellgren, and Clift. Here 
only the 0.65 m case is evaluated.

An operating condition from a previous case study was selected:

Condition A:

D = 0.65 meters

Vsm = 4.84 meters/sec

Cvd = 0.20

Vm = 6.30 meters/sec

It was noted in the previous study that increasing Cvd and decreasing Vm reduced the specific energy 
consumption, and a revised operating point was also selected:

Condition B:

D = 0.65 meters

Vsm = 4.84 meters/sec

Cvd = 0.221

Vm = 5.70 meters/sec

Using these two operating points, determine whether either operating point would be feasible for the sys-
tem.

Note: This example can only be run if you have a license for the SSL module.

Topics Covered

 l Entering solids data
 l Reviewing calculated slurry output
 l Evaluating stability of system operability

Required Knowledge
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This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition the user should have worked through Beginner - Pump Sizing for Sand Transfer System - 
SSL example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Slurry System Feasibility Study -  SSL.fth
 l Slurry System Feasibility Study - SSL.xlsx

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate SSL and select Settling to enable the SSL module for use. The 
items in the Fluid Properties group will change to accommodate slurry definitions. Click OK to save the 
changes and exit Analysis Setup. Open the Analysis menu to see the new option called Slurry. From 
here you can quickly toggle between Disable mode (normal AFT Fathom) and Settling (SSL mode).

 Step 3. Define the Fluid Properties Group

Open Analysis Setup from the toolbar or from the Analysis menu and input the following on the respect-
ive panels.

 1. Carrier Fluid - Figure 1
 a. Fluid Model = Basic (Water)
 b. Temperature = 4 deg. C

 2. Solids Definition - Figure 2
 a. Slurry Calculation Method = Detailed
 b. Solids Specifications = User Specified Solids Added

https://www.aft.com/products/fathom/video-tutorial-series
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 c. M (Stratification Ratio Exponent) = Calculated
 d. Terminal Velocity Parameter = Vt / Vts (Xi)
 e. Value = 0.56
 f. Density = 2.65 S.G. water

 g. d50 = 0.7 mm
 h. d85 = 1 mm

 3. Slurry Definition - Figure 3
 a. Slurry Calculation Method = Detailed (this selection will be the same as on the Solids Defin-

ition panel)
 b. Concentration Type = Volume Fraction
 c. Amount Solids Added = 20 Percent

Figure 1: Carrier Fluid panel in the Fluid Properties group in Analysis Setup with SSL activated
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Figure 2: Solids Definition panel in the Fluid Properties group in Analysis Setup with SSL activated
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Figure 3: Slurry Definition panel in the Fluid Properties group in Analysis Setup with SSL activated

 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.



Slurry System Feasibility Study - SSL

- 305 -

Figure 4: Layout of pipe system for Slurry System Feasibility Study example

Enter the following pipe and junction properties.

Pipe Properties

 1. All Pipes
 a. Pipe Material = (User Specified)
 b. Pipe Geometry = Cylindrical Pipe
 c. Inner Diameter = 0.65 meters
 d. Friction Model Data Set = User Specified
 e. Friction Factor = Explicit Friction Factor
 f. Value = 0.012

 g. Length = 100 meters

Junction Properties

 1. J1 Assigned Pressure
 a. Elevation = 0 meters
 b. Pressure = 10 bar
 c. Pressure Specification = Stagnation

 2. J2 Assigned Flow
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 a. Elevation = 0 meters
 b. Type = Outflow
 c. Flow Specification = Mass Flow Rate
 d. Flow Rate = 4000 m-ton/hr Solids  (metric tons equivalent to 4.0 x 10^6 kg/hr)

 i. (metric tons equivalent to 4.0 x 10^6 kg/hr)

ØTurn on Show Object Status from the View menu to verify if all data is entered. If so, the Pipes and 
Junctions group in Analysis Setup will have a check mark. If not, the uncompleted pipes or junctions will 
have their number shown in red. If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data.

 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 6. Examine the Output

The maximum settling velocity for Condition A calculated by Fathom is 4.833 meters/sec, as shown in 
Figure 5. The value for the maximum settling velocity for Condition B can be reproduced in a similar fash-
ion using Fathom.

Figure 5: Output for Condition A calculation showing maximum settling velocity

 Step 7. Evaluate System Operability

To determine the feasibility of the selected operating conditions, it is helpful to examine how the oper-
ating points relate to the system operability. One method of evaluating the system operability is to plot the 
system curves in terms of head of slurry (Jm vs. velocity). It is useful to plot the system curves as lines of 
constant concentration, as well as lines of constant slurry throughput. 
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The system curves for a given slurry throughput and concentration can be plotted directly by using the 
graphing capabilities of Fathom. However, to examine the system operability over a range of flows and 
concentrations, it may be more convenient to use a spreadsheet application, such as Microsoft Excel, to 
plot the system data all together. Fathom’s scenario manager and multi-scenario output features can be 
utilized to facilitate this process.

Evaluating the system in this manner may require a large number of scenarios to sufficiently capture the 
system operability. For your convenience, all of the necessary cases have been set up in the Fathom 
model file Metric - Slurry System Feasibility Study - SSL.fth. 

Steps 8 through 12 describe how the cases were set up in Fathom, and then copied into a spreadsheet 
for evaluation, should you wish to build the evaluation cases for yourself.  The final evaluation of the oper-
ating points is presented in Step 13.

 Step 8. Creating Scenarios to Evaluate System Operability

For this example, scenarios can be used to calculate Jm and velocity data for three different lines of con-
stant concentration, as well as for three different lines of constant throughput.

Setup the scenarios for constant concentrations as follows:

 1. From the Scenario Manager on the Quick Access Panel, create a scenario under the Base Scen-
ario called 0.65 meters pipe.

 2. Under the 0.65 meters pipe scenario, create a scenario called Cvd = 0.15. Load this scenario, and 
open the Analysis Setup window. Set the solids concentration to 15% in the Slurry Definition 
panel.

 3. Under the Cvd = 0.15 scenario, create scenarios for a range of mass flow rates from 1,000 m-ton 
per hr to 10,000 m-ton per hr in increments of 500 m-ton per hr, as shown in Figure 6. Load each 
of these scenarios and set the flow value in each Assigned Flow junction to the corresponding 
throughput value for each scenario.

 4. Right-click scenario Cvd = 0.15 and select Clone With Children. Name the new scenario Cvd = 
0.20. In this scenario, open Analysis Setup and change the solids concentration to 20%. Repeat 
this process, and create a set of scenarios for Cvd = 0.34. 

 5. There are now three groups of scenarios, each for a different solids concentration. Each of the 
three concentrations will have a set of scenarios for a range of different through puts, as shown in 
Figure 7.
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Figure 6: The Scenario Manager on the Quick Access Panel can be used to set up multiple throughput cases 
for a given solids concentration
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Figure 7: The Scenario Manager on the Quick Access Panel can be used to clone scenarios to easily create 
additional constant solids concentration cases

Setup the scenarios for constant throughput as follows:

 1. Under the 0.65 meters pipe scenario, create a scenario called Flow = 3500 m-ton per hr. Load this 
scenario, and set the flow value in the Assigned Flow junction 3500 m-ton/hr.

 2. Under the Flow = 3500 m-ton per hr scenario, create scenarios for a range of solids con-
centrations, as shown in Figure 8. Load each of these scenarios and set the solids concentration 
value in the Slurry Definition panel in Analysis Setup to the corresponding solids concentration 
value for each scenario.

 3. Right-click scenario Flow = 3500 m-ton per hr and select Clone With Children. Name the new 
scenario Flow = 4000 m-ton per hr. In this scenario,  set the flow value in the Assigned Flow junc-
tion 4000 m-ton/hr. Repeat this process, and create a set of scenarios for Flow = 4500 m-ton per 
hr.
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 4. There are now three additional sets of scenarios, each for a different throughput value. Each of 
the three flows will have a set of scenarios for a range of different solids concentrations, as shown 
in Figure 9.

Figure 8: The Scenario Manager on the Quick Access Panel can be used to set up multiple solid con-
centration cases for a given throughput
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Figure 9: The Scenario Manager on the Quick Access Panel can be used to clone scenarios to easily create 
additional constant throughput cases

 Step 9. Specify Output 

Make sure that the Base Scenario is active, the open Output Control by selecting Output Control from the 
toolbar or Tools menu.

Knowing that for this example, the output data will be exported to a spreadsheet application, use the out-
put control to set up the slurry output in a way that will make it simpler to plot the data in the spreadsheet.  
Open Output Control and on the Display Parameters tab, click the Slurry button. Then select the specific 
data to be displayed on the Slurry tab in the Output Window, as well as the order in which the data 
appears.  

Figure 10 illustrates how the slurry output data could be organized in the Output Window. Because we 
will be plotting Jm vs. velocity in the spreadsheet, velocity and Jm are displayed next to each other in the 
output. One might also wish to plot Im vs. velocity, so velocity can be displayed again adjacent to the out-
put data for Im.
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Figure 10: The Output Control window can be used to configure the slurry output into a format convenient for 
importing into a spreadsheet application

For this example, the multi-scenario output feature can also be used to simplify exporting the output data 
to a spreadsheet application. This feature allows the output from multiple scenarios to be viewed sim-
ultaneously. Load the 1000 m-ton per hr scenario that is under the Cvd = 0.15 scenario. Open the Out-
put Control window and select the Multi-Scenario tab. Under Display Type, click Selected Scenarios 
and the Select Scenarios window appears. Check the box beside each scenario for which data is to be 
displayed in the Output, as shown in Figure 11. 84 of 92 scenarios should be selected. Click OK when fin-
ished.

Under Scenario Name Format, select Show Scenario Ancestral Name. Under Display Current Scen-
ario, select In the Order Listed, if not selected already. Click the Clear All Colors button to make all 
scenario rows white.

This information should now appear, as shown in Figure 12. Close the Output Control window by clicking 
OK.
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Figure 11: Multiple scenarios can be selected for display in the Output window
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Figure 12: The Output Control window can be used to display the output from multiple scenarios sim-
ultaneously

 Step 10. Run the Model

All of the different cases that have been set up for this example in each of the scenarios must now be run 
so the results can be examined. Because there are so many scenarios, the  Batch Run feature in the File 
menu can be used to make running all of the different scenarios much easier.

From the File menu, select Start Batch Run. Under Batch Run Type, Scenarios In Current Model should 
be selected. Click Add Scenarios, and in the Select Scenarios window, select all 84 of the scenarios to be 
run, then click OK. All of the selected scenarios will be displayed in the Scenarios to Run list, as shown in 
Figure 13.  

Click Start Run to start the analysis. The batch run manager will load and run each of the listed scenarios 
sequentially. 
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Figure 13: The Batch Run Manager is used to automatically run multiple scenarios

 Step 11. Examine the Output

Once the batch manager has finished running all of the selected scenarios, load the scenario in which 
the multi-scenario output was set up (1000 m-ton per hr scenario that is under the Cvd = 0.15 scenario).

The Output window contains all the data that was specified in the Output Control window. Because the 
multi-scenario output feature was selected, it will also display the calculated output for each of the selec-
ted scenarios simultaneously. Figure 14 shows the multi-scenario output on the Slurry tab.



Slurry System Feasibility Study - SSL

- 316 -

Figure 14: The Output window shows the Slurry results table in the center Pipes section for multiple scen-
arios

 Step 12. Transfer the Output Data to a Spreadsheet

The information displayed on the Slurry tab in the Output window can be copied and pasted directly into a 
spreadsheet application, such as Excel, as shown in Figure 15.  If the scenarios and the output were set 
up carefully, the data will already be formatted in such a way that graphing the information using the 
spreadsheet graphing features can be extremely straightforward.

Using the data in the spreadsheet, plot the Jm vs. velocity data for the three lines of constant solids con-
centration, and the three lines of constant solids throughput, as shown in Figure 16.
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Figure 15: The Slurry results table in the Output window can be copied and pasted into a spreadsheet applic-
ation in order to utilize the graphing features of the spreadsheet to generate the slurry system curves

 Step 13. Analyze the Results

The results are shown in Figure 16. The solid lines refer to the constant solids concentration cases, and 
the broken lines refer to the constant throughput cases.
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Figure 16: Slurry system curves for Slurry System Feasibility Study example

The arrows on the graph indicate the proposed operating conditions for the system on the 4000 m-ton/hr 
constant throughput line. 

It is evident from the system characteristics that the proposed operating point Condition B, with the lower 
specific energy consumption, does not represent a feasible operating point for this slurry system. The 
system characteristics show the Jm decreasing as the mean velocity increases, so the operation would 
be unstable.

Even the first proposed operating condition, Condition A, is marginal. If the pump has a variable speed 
drive, and the solids concentration of the system does not fluctuate very much, this operating point could 
be used. However, as Figure 16 shows, if the concentrations vary from 3500 m-ton/hr to 4500 m-ton/hr, 
then the system operation is close to unstable for Condition A as well. 

In order to allow for fluctuations in solids concentrations during system operations, and still maintain 
stable operation, it would be better to operate closer to the standard velocity. The standard velocity point 
is also shown in Figure 14 at about 7.5 m/s.

For this case, if operability is also considered, lower slurry concentrations, and higher energy con-
sumption should be used to ensure system stability. Further, as discussed in the original reference, a dif-
ferent diameter pipe can be considered. The original reference suggests 0.55 m pipe as a better option 
than 0.65 m pipe because of operation closer to the standard velocity and lower capital cost.
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Automated Network Sizing (ANS) Examples
The examples below utilize the Automated Network Sizing module.

Fathom ANS Examples

Example Complexity Fluid Pipes Pumps Description

Beginner - 
Three-Reser-
voir Model

Beginner Water 3 0

Learn the basics of the ANS 
module such as defining all 
panels in the Sizing window to 
achieve a minimum flow 
volume objective

Control Valve Beginner Water 2 0

Learn how to use the ANS 
module and how Common 
Size Groups work to minimize 
the pipe weight of a system.

Cooling Sys-
tem, Creating 

Libraries
Intermediate Water 21 2

Learn how to build cost lib-
raries and engineering lib-
raries for use with the ANS 
module. See how to use Scale 
Tables for defining pump or 
bend costs, how to specify 
material versus installation 
costs, and how to define costs 
for pipes. 

Cooling System Intermediate Water 21 2

Learn how to use the ANS 
module to minimize monetary 
cost based on initial cost and 
recurring costs. See how to 
use the Assign Cost Libraries 
panel and the Sizing Summary 
panel. Explore how the system 
life and the sizing objective 
impacts the optimal pipe sizes.

Cooling Sys-
tem, Multiple 

Design Cases
Intermediate Water 21 2

Learn how to use the ANS 
module to define and size a 
system based on a dependent 
design configuration, called a 
Dependent Design Case.

Hot Water Sys-
tem Intermediate Water 24 3

Learn how to use the ANS 
module to define a system with 
multiple specific design 
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Example Complexity Fluid Pipes Pumps Description

requirements and minimize ini-
tial and recurring costs. See 
how to use a Dependent 
Design Case to see how a sys-
tem configuration affects the 
system sizing.

Variable Drive Intermediate Lube Oil 23 2

Learn how to use the ANS 
module to see the life cycle 
cost savings in a sized system 
using a Variable Frequency 
Drive instead of a Control 
Valve. 

Housing Project Advanced Water 25 0

Learn how to use the ANS 
module to size a system with 
more than one Dependent 
Design Case with unique 
design requirements for each 
dependent case. 

Beginner - Three Reservoir Problem - ANS 

Summary

The objective of this example is to familiarize the user with the panels in the ANS module. We will apply 
automated sizing to determine the ideal pipe sizes from our previously built three-reservoir model to 
reduce costs while meeting certain requirements.

Note: This example can only be run if you have a license for the ANS module.

Topics Covered

 l Minimizing the flow volume to minimize cost
 l Specifying Pipe Design Requirements
 l Choosing Candidate Sets

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
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watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Beginner - Three Reservoir.fth
 l Metric - Beginner - Three Reservoir - ANS.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the model

Open the Metric - Beginner - Three Reservoir Problem.fth example file and save it as a new file. 

We will be using the Base Scenario to compare the original results without Sizing to the results with Siz-
ing. Create a child scenario named Sized.

The workspace should look like Figure 1 below:

https://www.aft.com/products/fathom/video-tutorial-series
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Figure 1: Layout of Three Reservoir Model in Workspace

 Step 3. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate ANS and select Network to enable the ANS module for use. A 
new group will appear in Analysis Setup titled Automatic Sizing. Click OK to save the changes and exit 
Analysis Setup. A new Primary Window tab will appear between Workspace and Model Data titled Siz-
ing. Open the Analysis menu to see the new option called Automatic Sizing. From here you can quickly 
toggle between Not Used mode (normal AFT Fathom) and Network (ANS mode).

Figure 2 below shows the Analysis menu options when ANS is activated.
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Figure 2: Activating Network Sizing from the Analysis menu

 Step 4. Configure Sizing Settings

Here we will pursue a brief introduction to some of the sizing capabilities in the ANS module. A more 
complete discussion is given in the AFT Fathom Help file. 

The Sizing window is comprised of multiple panels which can be accessed using the buttons on the Siz-
ing Navigation panel along the bottom of the window, as shown in Figure 3. The sizing panels can be 
accessed in any order, though it is easiest to enter the information by navigating the panels from left to 
right, since the input on panels such as the Sizing Objective and Sizing Assignments panels will affect 
the options available on later panels. Depending on the type of sizing being done, some panels may be 
disabled or unused.

Each panel button contains either a green checkmark or red circle which denotes the completion status 
of that panel. If the minimum required information is present to run the model, the symbol will be green, 
whereas the red symbol represents incomplete input. The amount of information required will vary based 
on whether the Sizing Level Status (located on the Sizing Objective panel) is set to Perform Sizing, Cal-
culate Costs, or Do Not Size. A detailed summary of the items which have been completed and the items 
which are still incomplete can be seen in the Sizing Status panel, opened from the Sizing Toolbar.

Note that some panels will always be shown as complete since the model can be run without any addi-
tional information entered on them, such as with the Design Requirements panel. However, in order to 
find the best system design it will often be necessary to enter more than the minimum information 
required by the solver.

The Lock Panel toggle located on the Sizing Toolbar prevents changes to the current panel when it is 
enabled. This is primarily useful to prevent editing once a scenario has been run, since any changes that 
are made to a scenario which has output will cause all output to be erased. By default, the ANS module 
will lock all panels after a sizing run is completed, requiring panels to be unlocked before any changes 
can be made. This setting can be changed on the Sizing Objective panel. All panels can be locked or 
unlocked simultaneously by using the Lock/Unlock All Panels buttons on the Sizing Toolbar. 
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Figure 3: Sizing Window showing common sizing panel features

A. Sizing Objective

The Sizing Objective panel is used to set the Sizing Option, which is the type of calculation that will be 
performed, and to select an Objective which will be used in the sizing process.

For the Sizing Option, Perform Sizing should generally be selected, since this is the primary function of 
the ANS module. However, the other two options may be used for troubleshooting or informational pur-
poses. For example, the Calculate Cost, Do Not Size option may be useful to calculate an initial cost for 
the system, or to verify your cost libraries. The Do Not Size option allows the model to be run normally in 
AFT Fathom without requiring any cost or sizing information. This is useful to preserve the information 
already entered in the Sizing window.

ØSelect Perform Sizing (if not already selected) to begin configuring the sizing settings.

Note: The Sizing Option can always be seen on the box on the left of the Sizing Navigation panel. 
Clicking this box will bring you to the Sizing Objective panel, where this status can be changed.

The easiest way to size the system is to set the objective to a non-monetary value such as pipe weight or 
flow volume rather than directly analyzing monetary cost. Here we will minimize flow volume. The flow 
volume is merely the sum of the internal volumes of all sized pipes. As the flow volume is minimized, the 
pipe material, and therefore cost, is minimized along with it. Typically it is recommended to use the pipe 
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weight option, as this will have the best correlation to cost. However, certain systems, such as ducts may 
be better sized using flow volume.

Although we will not do so here, the ANS module can also minimize the monetary cost of the system. 
This is more powerful than sizing for flow volume, but also requires more time investment in setting up 
cost libraries.

ØFor the Objective, choose Flow Volume, and make sure Minimize is selected from the drop-down 
list. The Sizing Objective panel should now appear as shown in Figure 4.

Figure 4: Sizing Objective set to minimize flow volume

B. Sizing Assignments

On the Sizing Navigation panel at the bottom of the window select the Sizing Assignments button. The 
Sizing Assignments panel allows the user to define what objects will be sized in the model, and what will 
be included in the cost calculation without being sized. Common Size Groups for pipes, or Maximum 
Cost Groups for pumps/control valves can be created on this panel as well when appropriate.

Let's consider the Sizing Assignments for the pipes, which should be displayed by default when we open 
this panel. 

In the Sizing and Volume Options table there are several options under the categories to Automatically 
Size, or Do Not Size the pipe.

If an Automatically Size option is selected, the ANS module will treat the pipe diameter as a variable and 
vary it according to certain criteria that will be discussed shortly. 
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For a new system, typically all pipes will be desired to be sized and included in the cost, which is being 
calculated in terms of volume in this case. If you are instead analyzing the possible replacement of exist-
ing pipes, it may be better to size the pipes, but only include the cost if the size changes from that which 
exists.

If Do Not Size is selected, the pipe will retain the settings currently set in the Workspace. Why would one 
choose to not size a pipe? There could be a number of reasons, but one good reason is that the pipe rep-
resents a pipe in an existing system and the design does not allow the replacement of that pipe with a 
new one. Therefore its diameter is fixed, and sizing the pipe would serve no purpose.

Another reason may be if a certain size is necessary for the design due to certain requirements, in which 
case the pipe cost can be included without sizing the pipe by choosing Include in Cost.

This model is a new system, so all pipes will be sized and included in the cost.

ØSelect Always Include in Volume for all three pipes (Figure 5).

Since we want to size the pipes independently in this model, we do not need to make any changes to the 
Pipe Grouping section of the table, so this panel is complete.

Note: For models which have junctions that can be sized, a Junctions button at the top of this panel 
will be available to set the Junctions Sizing Assignments. In this case we have chosen to ana-
lyze flow volume. While this value can easily be calculated for the pipes, Fathom does not have 
enough information to calculate a flow volume for the branch or the reservoirs, which means 
that they cannot be sized using this method, and the Junctions tab is unavailable. This same lim-
itation exists when using other non-monetary objectives as well, such as pipe weight. If the size 
of a junction will have a large impact on the system cost, such as a pump, Monetary Cost should 
be used as the Objective.

Figure 5: Sizing Assignments panel for Three Reservoir model

C. Candidate Sets

Click on the Candidate Sets button to open the Candidate Sets panel.
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Since commercial piping is limited to certain sizes, the ANS module needs a list of possible sizes from 
which to choose. This list is called a Candidate Set.

So as not to limit the sizing unnecessarily, the candidate sets should include both smaller and larger 
pipes than your anticipated final size. If you make the candidate set too small, you may limit the ability of 
the ANS module to find the best sizing. It is better to make the candidate set too large than too small. 
Experience applying the ANS module to actual systems will help you choose appropriate candidate sets. 
If after obtaining a solution you find that one or more of the sized pipes is at the extreme of the candidate 
set a warning will appear, and it is recommended to expand the defined candidate set.

To create a Candidate Set, do the following:

 1. Under Define Candidate Sets, click New.
 2. Give the set the name All STD and click OK.
 3. From the drop down list choose Steel - ANSI if it is not already selected.
 4. At the bottom of the Select Pipe Sizes window, make sure the Sort option selection is Type, 

Schedule, Class.
 5. In the Available Material Sizes and Types list on the left, select (not expand) STD so that the 

schedule name is now highlighted.
 6. Click Add to add all STD pipe sizes to the list on the right.
 7. Click OK.

The All STD set will now appear.

We will apply the All STD set shortly. First, let’s take a moment to understand what we have just done. 
We have created a candidate set that includes all pipe sizes in the library that are Steel - ANSI STD. At 
the low end this includes 1/8 inch pipe, and at the high end 48 inch pipe. This candidate set contains pipe 
sizes from a library of steel ANSI pipe, and not just specific pipes from the model. After we apply this can-
didate set to a specific pipe in the model and the sizing is run, the ANS module will select the best pipe 
size from this set of pipe sizes to achieve the objective.

We now need to define which pipes will use this Candidate Set during the sizing calculation. Each pipe 
that is being sized must have a Candidate Set assigned to it. Under Assign Candidate Sets to Pipes, set 
each pipe in the model to use All STD by selecting the radio button under this candidate set for each 
of the pipes. The Candidate Sets should now be fully defined and assigned to the appropriate pipes, as 
can be seen in Figure 6.
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Figure 6: Candidate Sets window fully defined for the Three Reservoir model

D. Design Requirements

Select the Design Requirements button. If we do not define any design requirements for the model, the 
ANS module will automatically choose the smallest pipe size in the Candidate Set, since it has the smal-
lest flow volume. Along with the smallest pipes we may get unacceptably low flow rates, or unacceptably 
high velocities and pressure drops. To maintain acceptable system operating conditions, we need to set 
design requirements. 

We are going to define two design requirements for this case. Before adding any requirements, let’s look 
more closely at the results of the model we are starting with. All pipe diameters are nominal 8 inch, and 
the results show that the water flows from reservoir J1 to reservoirs J2 and J3. The flowrate out of J1 is 
542.3 m3/hr, and the flowrates to J2 and J3 are 171.3 and 371.0 m3/hr, respectively. Let’s assume that 
there is a requirement to draw a minimum of 600 m3/hr from J1, and to deliver at least 150 m3/hr each to 
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J2 and J3. What is the combination of pipe sizes which achieve the desired objective while still meeting 
these demands? In our case, we are defining the objective as minimizing the internal volume of the pipes 
(i.e., length times internal cross-sectional area).

We need to create two Design Requirements that represent the flow requirements at the reservoirs in 
order to answer this question. We will do this by defining Design Requirements for the inlet/outlet 
flowrates of the pipes where they connect to each of the Reservoirs. To do this:

 1. Make sure that the Pipes button is selected.
 2. Click New under Define Design Requirements.
 3. Enter a name when prompted: Min Flow Supply. Click OK.
 4. A new row will appear in the Pipe Design Requirements table. In this row, select Volumetric Flow 

Rate as the Parameter.
 5. Choose Minimum for Max/Min.
 6. Enter 600 m3/hr.
 7. Now repeat the above process to define Min Flow Delivery with a Volumetric Flow Rate Min-

imum of 150 m3/hr.

To be functional, we need to apply these Design Requirements to the correct pipes. There are no limits to 
the number of Design Requirements that can be defined and applied.

In the Assign Design Requirements to Pipes section, expand the pipe list. Select the check box for Min 
Flow Supply next to pipe P1, and Min Flow Delivery next to pipes P2 and P3. This will set the minimum 
flow rate coming out of Reservoir J1 and going into Reservoirs J2 and J3 as described above. The fully 
defined and assigned Design Requirements are shown in Figure 7.
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Figure 7: Design Requirements window with the minimum flow requirements defined

E. Assign Cost Libraries

When the Sizing Objective has been defined as Monetary Cost, it is necessary to create and assign cost 
libraries for the automated sizing, which can be done in the Assign Cost Libraries panel. Since we have 
defined the objective as Pipe Flow Volume, we will not need to assign any cost libraries, and this button is 
grayed out.

F. Sizing Method

Select the Sizing Method button to go to the Sizing Method panel.

The Sizing Method panel is used to set up the calculation methods for sizing the system. You can select 
whether discrete or continuous sizing will be used, and which method will be applied.

If Continuous Sizing is selected, the ANS module will ignore the defined Candidate Sets and report the 
ideal hydraulic diameter for the pipes being sized, which will likely not match any of the possible chosen 
commercial sizes. While this is not useful as a final solution, this may be helpful as a baseline to check 
the final solution using the provided discrete methods. Discrete Sizing will typically perform a continuous 
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sizing calculation as a basis, after which multiple discrete sizes above and below this solution will be eval-
uated to find the ideal sizing based on the provided Candidate Set.

ØFor this model, use Discrete Sizing.

For the Search Method, the ideal method will often change based on the number of independent pipe 
sizes (shown in the Sizing Assignments panel on the bottom right), number of Design Requirements, and 
feasibility of the initial system design. The Help file provides more information on the strengths and weak-
nesses of each method. It is generally recommended to run the sizing with more than one method, as it is 
often not obvious which method will be most effective for each system. The suggest Method button can 
be used as a guide for which method to start with.

For a simple model such as this one, the MMFD or SQP method should be appropriate since there are 
only a few Design Requirements, and only three pipes are being varied.

ØChoose the default Modified Method of Feasible Directions (MMFD).

 Step 5. Run the Model

Select Run from the Analysis menu. While the model is running, the Solution Progress window shows the 
Sizing Calls to Solver. This is how many times a complete hydraulic analysis was run.

The solver also displays the Current Cost and Best Feasible Cost, which will display the last calculated 
value for the cost, as well as the Best Feasible Cost which has been found so far (Figure 8). The solver 
will continue to iterate using the defined method until it finds the ideal sizing. For the selected method, the 
solver will first perform a continuous sizing to find a starting point, then test discrete solutions close to this 
continuous solution to find the final, discrete solution.

Note: At any time during the run, the user can pause the solution and use the Other Actions button to 
accept the currently displayed Best Feasible Cost as the final solution. For this example the solu-
tion is found and displayed quickly, but for larger systems with many pipes being sized, it may 
be more productive to pause the solution and accept the current solution in order to save time, 
especially if the displayed cost does not appear to be decreasing much further.



Automated Network Sizing (ANS) Examples

- 332 -

Figure 8: Solution Progress Window showing the progress of the sizing calculation

 Step 6. Review the Sized Results

Click the View Output button to see the results. The General section shows the Cost Report, which indic-
ates the volumes for the final solution. As shown in Figure 9, the minimum total volume identified by the 
ANS module was 55 meters3. In the Pipes section of the output on the Sizing tab, the final pipe sizes of 
10, 6, and 8 inches are shown (Figure 9). 

Now switch to the Pipe Design Requirements tab in the Pipe section (Figure 10). We can confirm that the 
calculated design is feasible, since all of the Design Requirements were met. That is, the flow from J1 (as 
shown in pipe P1) exceeded 600 m3/hr, and the flows to J2 and J3 exceeded 150 m3/hr. Notice that 
some of the Design Requirements are highlighted, indicating that they were active. An active design 
requirement is defined as a requirement that had an impact on the solution. If an active design require-
ment were disabled,  a different solution would be found. Yellow highlights indicate that the design 
requirement was active in the final solution, while blue highlights indicate that the requirement was active 
when the continuous sizing was performed, but became inactive when the solver switched to discrete siz-
ing.

You can also display the adjusted pipe sizes and resulting flow rates in the Visual Report.
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Figure 9: Output Window with Cost Report and Pipe Sizes for Three Reservoir Model

Figure 10: Design Requirements results for Three Reservoir Model

Transferring Sized Results

When performing sizing, the Transfer Results to Initial Guesses feature on the Output window Edit menu 
takes on new meaning. When used in a non-sizing context, this feature takes the solved hydraulic results 
(i.e., pressures, flows rates, etc.) and assigns them to the initial guess values for the pipes and junctions.

When you select Transfer Results to Initial Guesses after automated sizing, you will see a dialog window 
appear like that shown in Figure 11. The ANS module allows you to transfer the hydraulic results, the 
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sized pipe diameters, or both. If you transfer the sized pipe diameters, each pipe's input diameter (back 
on the Workspace) will become the sized diameter.

This feature allows the sizing results to be saved to the model for use in further analysis as needed.

Figure 11: After sizing, the Transfer Results to Initial Guesses feature transfers both the hydraulic results and 
sized pipe size results

Conclusion

You have now used performed a network sizing to minimize flow volume with the ANS module.
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Control Valve - ANS 

Summary

This example will show how to use the ANS module to size a system based on pipe weight. For many 
systems the necessary cost data is not available to directly minimize cost, so minimizing system para-
meters such as weight or flow volume is useful. By minimizing parameters such as these we minimize 
pipe diameter, which directly correlates to minimizing pipe costs.

We will create a system that feeds water from an elevated reservoir to a lower reservoir at a specified 
flow rate. A control valve will be used to control the flow rate and can be placed anywhere within the line. 
We will need to determine what size of piping to use in order to achieve a minimum pressure drop of 82 
kPa across the control valve.

Note: This example can only be run if you have a license for the ANS module.

Topics Covered

 l Sizing using pipe weight
 l Creating a Common Size Group
 l Defining Control Valve Design Requirements

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition, it is assumed that the user has worked through the Beginner - Three-Reservoir - ANS 
example, and is familiar with the basics of ANS analysis.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Control Valve - ANS - Initial.fth
 l Metric - Control Valve - ANS - Final.fth

https://www.aft.com/products/fathom/video-tutorial-series


Control Valve - ANS

- 336 -

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the model

Open the Metric - Control Valve - ANS - Initial.fth example file. The workspace should look like Figure 
1 below:

Figure 1: Control Valve System Layout

 Step 3. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate ANS and select Network to enable the ANS module for use. A 
new group will appear in Analysis Setup titled Automatic Sizing. Click OK to save the changes and exit 
Analysis Setup. A new Primary Window tab will appear between Workspace and Model Data titled Siz-
ing. Open the Analysis menu to see the new option called Automatic Sizing. From here you can quickly 
toggle between Not Used mode (normal AFT Fathom) and Network (ANS mode).
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 Step 4. Configure Sizing Settings

In this model we are going to perform sizing to minimize the pipe weight (therefore minimizing cost), while 
maintaining a minimum pressure drop of 82 kPa across the control valve. 

To do this, first go to the Sizing window by clicking on the Sizing tab, or from the Windows menu.

A. Sizing Objective

The Sizing Objective panel should be selected by default from the Sizing Navigation Panel along the bot-
tom of the window. Input the following:

 1. Sizing Option = Perform Sizing
 2. Objective = Pipe Weight
 3. Option = Minimize

B. Sizing Assignments

On the Sizing Navigation Panel at the bottom of the window select the Sizing Assignments button.

In this case we are sizing a new pipeline, so we want to size all pipes in the model.

ØUnder Automatically Size select Always Include in Weight next to both pipes.

For this system it is required that both pipes be the same size. We will need to add both pipes to a Com-
mon Size Group to specify this. Do the following:

 1. Click New above Pipe Grouping
 2. Enter the a name Main Pipes and click OK. A new section will now appear with the Main Pipes 

group listed under Common Size Groups. 
 3. Add both pipes to this group by clicking the corresponding radio buttons (Figure 2).

Note that as many Common Size Groups as necessary can be created. Selection tools are available at 
the bottom of the window to help assign multiple pipes to a Common Size Group for larger models. Addi-
tionally, pipes can only be assigned to a group once they are set to be included in sizing. 
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Figure 2: Pipes P1 and P2 settings in the Sizing Assignments window

C. Candidate Sets

Click on the Candidate Sets button to open the Candidate Sets panel.

 1. Under Define Candidate Sets, click New.
 2. Give the set the name STD Pipes and click OK.
 3. In the Select Pipe Sizes window, choose Steel - ANSI from the drop-down menu if not already 

selected.
 4. Make sure the Sort selection is for Type, Schedule, Class at the bottom of the window.
 5. In the Available Material Sizes and Types on the left, expand the STD pipe sizes list.
 6. Double-click each of the sizes from 1 inch to 12 inch to add them to the list on the right.
 7. Now click OK.

The STD Pipes set will now appear as a Candidate Set at the top.

We now need to define which pipes will use this Candidate Set during the sizing calculation. 

ØUnder Assign Candidate Sets to Pipes, set the Main Pipes Common Size Group to use the STD 
Pipes Candidate Set. The Candidate Sets are now fully defined and assigned to the appropriate pipes, 
as can be seen in Figure 3.

 
Figure 3: Candidate Sets panel fully defined for the Control Valve model

D. Design Requirements

Select the Design Requirements button.

For this model we only have one Design Requirement, which is for the minimum pressure drop across 
the Control Valve. To define this requirement:



Control Valve - ANS

- 339 -

 1. Select the Control Valves button at the top of the window.
 2. Click New under Define Control Valve Design Requirements.
 3. When prompted, enter the name Min Pressure Drop.
 4. Next to Min Pressure Drop in the table, select Pressure Drop Static as the Parameter.
 5. Choose Minimum as the Max/Min option.
 6. Enter 82 kPa.

Now we need to apply the defined Design Requirement to the Junction.

ØCheck the box next to the Control Valve J2 in the Assign Design Requirements to Control Valves 
section.

Note: Control valves must always have a design requirement specified for the minimum pressure 
drop/head, or the maximum Cv/percent open at the valve to ensure that reasonable operating 
conditions exist at the control valve. If no Design Requirements are applied, the ANS module 
will allow the control valve to control to any pressure required to meet the control setpoint, even 
if this requires the control valve to add pressure to the system. To avoid this in the final solution, 
a Design Requirement should be applied.

E. Assign Cost Libraries

When the Sizing Objective has been defined as Monetary Cost, it is necessary to create and assign cost 
libraries for the automated sizing, which can be done in the Assign Cost Libraries panel. Since we have 
defined the objective as Pipe Weight, we will not need to assign any cost libraries, and this button is 
grayed out.

F. Sizing Method

Select the Sizing Method button to go to the corresponding panel.

Make sure Discrete Sizing is selected, since we are sizing based on commercial pipe sizes.

For the Search Method in a simple model such as this one, the MMFD or SQP method should be appro-
priate since there is only one Design Requirement, and only one pipe size is being varied. Choose the 
default Modified Method of Feasible Directions (MMFD).

 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 
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 Step 6. Review the Sized Results

The output is shown below in Figure 4. We have shown all three sections of the output window with the 
General, Pipes, and Junctions sections. In the General Section, the Cost Report tab shows the min-
imized pipe weight for each of the pipes that were sized based on the design requirements. 

In the pipe section, the Sizing tab is selected to show the final pipe sizes that were chosen. The ideal pipe 
size was found to be 6 inch pipe for this case. In the Junction section, the CV Design Requirements tab is 
shown. It can be seen that the Control Valve Design Requirement was met. The Design Requirement is 
colored blue, indicating that it was active in the final solution.

Figure 4: Output window for Control Valve Sizing 

 Step 7. Change the Control Valve Location

Now we would like to try something to further improve the system. For the first cut, we assumed that the 
control valve was in the middle of the pipe and that the pipes had to be the same size. If the pipes do not 
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have to be the same length or size, we can further minimize the pipe weight and theoretically the cost of 
the piping. 

To do this we will create another scenario. 

 1. In the Scenario Manager, create a child from the Base Scenario and name it Unequal Pipes. 
There should now be a check mark icon next to the scenario name to show that it is active.

 2. On the Workspace open the Pipe Properties window for pipe P1 and change the length to 45 
meters. 

 3. Open the Pipe Properties window for pipe P2 and change the length to 15 meters. 
 4. Go to the Sizing tab and click the Sizing Assignments button in the Sizing Navigation panel.
 5. In the Pipe Grouping section of the table set both pipes to Not in Group. This will allow their sizes 

to be varied separately.

The scenario is now complete.

 Step 8. Run New Scenario and Review Results

Now, we will run this scenario and see if we have minimized the pipe weight further. Select Run from the 
Analysis menu and allow the ANS module to size the system. When the analysis is complete, select Out-
put to view the results.

The output window is shown below in Figure 5. We can see that pipe 1 was now chosen as 5 inch but 
pipe 2 was still chosen as 6 inch. Since pipe 1 was smaller the pressure drop across the pipe was 
greater, so the pressure drop across the valve was reduced from 85.53 to 82.22 kPa. The pipe weight 
was reduced from 1,694 to 1,402 kg. 
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Figure 5: Output window for Unequal Pipes Scenario

Conclusion

This example has demonstrated how simple it is to perform an automated sizing to design a system for a 
set of requirements. Pipe weight may not be directly proportional to pipe cost but it can be implemented 
very quickly when cost data is not available. 
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Cooling System - Creating Libraries - ANS 

Summary

This example focuses on creating Engineering and Cost Libraries for a system, then connecting the lib-
raries to the model in order to obtain accurate results based on the cost data.

Note: This example can only be run if you have a license for the ANS module.

Topics Covered

 l Using external libraries
 l Building engineering and cost libraries
 l Using Scale Tables for cost
 l Connecting and using existing engineering and cost libraries

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

This example is an addendum to the Cooling System - ANS example, but can be worked separately from 
the example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Cooling System.fth
 l Metric - Cooling System Libraries - ANS.fth
 l Creating Libraries - Cost Templates.xlsx - template file for building cost libraries
 l Creating Libraries.dat - completed engineering library
 l Creating Libraries Costs.cst - completed cost library for Creating Libraries.dat
 l Steel - ANSI Pipe Costs.cst - completed cost library for Steel - ANSI pipes

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the model

Open the Metric - Cooling System.fth example file and save it as a new file. We will not need the exist-
ing child scenarios for this example: right click on the Base Scenario in the Scenario Manager and select 
Delete All Children.

For the analysis we will be creating the library files for a completed model file to focus solely on using lib-
raries as part of the costing and/or sizing process.

 Step 3. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate ANS and select Network to enable the ANS module for use. A 
new group will appear in Analysis Setup titled Automatic Sizing. Click OK to save the changes and exit 
Analysis Setup. A new Primary Window tab will appear between Workspace and Model Data titled Siz-
ing. Open the Analysis menu to see the new option called Automatic Sizing. From here you can quickly 
toggle between Not Used mode (normal AFT Fathom) and Network (ANS mode).

 Step 4. Creating an Engineering Library

If it is desired to size any of the junctions in the system, such as the pumps or elbows, the first step is to 
create an engineering library containing information for each of the junctions that will be sized. This engin-
eering library can later be used to attach a cost library for the junctions. Engineering libraries can also be 
connected to future models to reuse any of the junctions in future systems.

Note: This step is not required if it is only desired to include pipe costs for the pipe material information 
included in Fathom, since the cost libraries for the pipes can be built off of the default Fathom 
Pipe Material Libraries.

To add a junction to an engineering library:

 1. Define the junction in the workspace. 
 2. Select the junction, go to the Library menu, and choose Add Junction to Library. 
 3. Give the junction a meaningful name and add it to the desired library by selecting it from the list. 

For the purpose of this example the model has already been fully defined, so we will just need to add the 
junctions to the library which we will be calculating the cost for. Follow the steps above to add Pump J4 
and Bend J3 to the LOCAL USER LIBRARY. Give the pump the name Sizing 680 m3/hr and the bend the 
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name STD Bend. In this case only one of each junction needs to be added to the library, since each of 
the pumps and bends in the model are identical. If we had multiple pump models, bend types, etc. then 
we might need to add multiple pumps, bends, etc.

The local user library is the default location where user junctions are placed for the local machine. If the 
junctions are stored in the local user library, it is possible to run all of the calculations, and attach a cost 
library for the junctions. However, this restricts the use of the saved data, as the local user library cannot 
be shared with other users or be moved to different machines. This is why it is often preferred to place the 
junctions into an external library. Follow the steps below to move the junctions:

 1. Go to the Library menu and open the Library Manager. 
 2. At the bottom, select Create New Library, and give it the filename Creating Libraries. It is import-

ant to use a descriptive filename to avoid confusion later if the library needs to be reconnected, or 
sent to someone else.

 3. Enter a Library Description. This is the name that will be displayed within the Library Manager 
itself. The description may be different from the file name, but it is typically recommended to make 
these the same to avoid confusion later. Use the name Creating Libraries for the description.

 4. In the LOCAL USER LIBRARY, expand the Junctions option. The window should appear similar 
to Figure 1.

 5. For both junctions that we added earlier, right-click the name, then click Move Content. In the 
Select Library window, click Creating Libraries and then click Select. This moves the junction from 
the local user library to the new external library. The pump and bend should now be visible within 
their respective sections on the right side of the window.

 6. Select Close to complete the process. If you open the folder where the library was created in Step 
4, the library file should now be available.

We are now ready to enter the cost data for the junctions in the model.
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Figure 1: Edit Library tab in the Library Manager with a new external library created for the junctions to be 
added to
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Figure 2: Library Manager showing the junctions moved to the new external library from the local user library

 Step 5. Creating a Cost Library for the Equipment

Go to the Library menu and select Cost Library to open the Edit Cost Library window, which is used to 
create and view cost libraries. This window can also be accessed from the Sizing window on the Assign 
Cost Libraries panel. In this case we need to enter new cost data that we have obtained, so click New.

The list of Available Libraries should now be displayed as shown in Figure 3. Every cost library must be 
built off of an existing engineering or pipe material library. Browse to the newly created library, Creating 
Libraries. You may need to use the Browse button to find it if the library is not shown in the list. After you 
click the library to highlight it, click Select.
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Figure 3: The Available Engineering Libraries list which can be used to build a cost library

From here we will be brought to the General tab. The description field is used as the name displayed 
within the Library Manager, similar to with the engineering library.

The Notes field can be used to provide information on references, or other details which may be useful 
for tracking purposes. Notes can be seen when reviewing library contents later using Browse Library Con-
tents.

The other item of note is the Multipliers table. This can be useful to apply multipliers to account for infla-
tion or uncertainty, without needing to calculate the costs directly. Note that multipliers can also be 
applied within the Assign Cost Libraries panel, so be cautious to avoid duplicate multipliers.

ØIn the Description field enter Creating Libraries Costs, as seen in Figure 4. Now let’s move on to 
entering cost data. Click the Junctions tab to view the Junctions overview.



Cooling System - Creating Libraries - ANS

- 349 -

Figure 4: The General tab within the Edit Cost Library window

Within the Junctions tab each individual library item can be viewed under each Junction type. First 
expand the Pump section by clicking the +, and select the Sizing 680 m3/hr junction that was added 
earlier.

ØClick New Cost to add an item to the table. By default, a cost item will be added that is configured for 
cost entry per item. Costs can be categorized as Material, Installation or Maintenance Cost Type. This 
categorization becomes useful if it is desired to exclude certain costs from the calculation or the sizing, 
but otherwise does not impact how the costs are calculated.

Separately open up the Excel spreadsheet titled Creating Libraries - Cost Templates.xlsx found in the 
Examples folder, and go to the Junction Costs (Metric) tab. The cost data for the pumps and bends can 
be seen here, categorized by cost type.

In this case we are sizing the pump, so rather than having a cost for a specific pump model, we have a 
range of costs specified based on the power requirement for the pump. We will need to enter this data 
into the Tables tab first before we can define the cost item on the Junctions tab. Back in AFT Fathom in 
the Edit Cost Library window, click on the Tables tab at the top of the window.

ØClick New Table to begin defining the data table, and name it Metric - Pump Material. Multiple Table 
Types are offered as the dependent variables for the table, which can either be plotted against a set of 
multipliers which will be applied to a specific data point, or directly against cost, as can be seen in Figure 
5.

The data we have available is the cost for pumps over a range of different power requirements, so 
choose Power and Cost as shown below, then click OK.



Cooling System - Creating Libraries - ANS

- 350 -

Figure 5: Table type and formatting options when creating a cost library

The new table name will now appear in the Tables list, and an entry section for Power vs Cost will 
become available. Copy the data in the Excel spreadsheet for Pump Material, then click the Edit Table 
button and choose Paste. Make sure that the table Units have been set to kW. Repeat this process of cre-
ating a new table for the pump installation costs using the data from the spreadsheet.

Now that the data tables have been created, we must assign them to the pump junction in the Junctions 
tab. Click on the Junctions tab and make sure that the Sizing 680 m3/hr pump model has been selec-
ted, then enter the cost information as follows:

 1. Description = Purchase
 l This row is optional, but can be useful to provide clarification on the source of the entered 

cost.
 2. Cost Type = Material (NR)

 l Note that NR denotes a non-recurring cost type, while R denotes a recurring cost type.
 3. Use Size Table = Table of Costs
 4. Multiplier = 1
 5. Size Scaling Table = Metric - Pump Material

Click New Cost to create a second cost item for the pump and enter the cost information as follows

 1. Description = Installation
 2. Cost Type = Installation (NR)
 3. Use Size Table = Table of Costs
 4. Multiplier = 1
 5. Size Scaling Table = Metric - Pump Installation

We have specified the cost types for each of the pump data tables, and have assigned them to our Sizing 
680 m3/hr model contained in the engineering library. However, we still need to input the data for the 
Bends.
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On the Tables tab, follow the same process as outlined above to create two more tables containing the 
cost information for the bends contained in the spreadsheet. Both tables will use cost for the Table 
Format, with Diameter as the Table Type. Be careful when filling in the table data to be sure that the cor-
rect units are applied for each table. When you are finished there should be four tables total, as shown 
below in Figure 7.

To assign the tables, return to the Junctions tab. Select the Bend and add two cost items, one apply-
ing the material costs table, and one for the installation costs table. When you are done the Bend should 
have two costs, as shown in Figure 8.

Figure 6: Pump Material and Installation costs assigned using cost tables
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Figure 7: Complete tables list with material and installation cost tables for each of the junctions being ana-
lyzed

Figure 8: Completed cost items for the bend material and installation costs
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Click Save, and give the cost library a name. We will use Creating Libraries Costs.cst in this case. It is 
often useful to give the cost library a similar name to the engineering library to make transferring and 
reconnecting the library faster. Once you have finished saving the library, click Close.

 Step 6. Create Cost Library for Pipes

We now have costs for the equipment, but we still need costs for the pipes. In the Sizing tab in the model, 
go to the Candidate Sets panel by clicking the button. By expanding the existing Candidate set, it can be 
seen (as stated in the name) that we will need cost information for all STD Steel – ANSI pipe sizes from 1 
inch to 36 inches.

 1. Return to the Edit Cost Library window by going to the Library menu and selecting Cost Library, 
then click New.

 2. From the Available Engineering Libraries list, click Steel - ANSI, which is the default AFT Steel-
ANSI pipe materials library.

 3. Click Select to choose this library. You should now be on the General tab of the Edit Cost Library 
window.

 4. In Description, give the new pipe cost library the name Steel - ANSI Pipe Costs.
 5. Go to the Pipe Materials tab. In the list section, we will be able to view all of the sizes and types 

for the Steel - ANSI material. Under Sort choose Material, Type or Schedule, Nominal Size so 
that they will be sorted by type rather than size.

 6. Expand the Steel - ANSI list, then expand the STD list (Figure 9).

Figure 9: Pipe Materials tab in the Cost Library window showing the available STD sizes
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If a size from the list is selected, the hydraulic diameter is displayed, along with a summary of the mater-
ial, size, and type. The New Cost button will also become active (Figure 9). There are a few methods 
available when adding the pipe costs. We could individually add the Material and Installation costs for 
each pipe size by selecting each size from the pipe materials list, then using the New Cost button to add 
these costs to the table individually. Alternatively, the pipe costs can be entered into a template in Excel, 
then imported to the Cost Library all at once. 

In this case, we have the Pipe costs available in a spreadsheet, so we will use the Excel import/export 
option. To do this we will first export a template for the desired pipe sizes, then we will enter the cost 
information in the template and import the updated file as detailed below.

 1. Make sure that the STD pipe material type is highlighted in the list, then click Export to Excel on 
the right side of the window. The Excel Export window should be shown as in Figure 10, with all 
Steel-ANSI STD pipe sizes displayed.

 2. Click Export, name the sheet, and save it to an easy to find location. The name does not matter, 
but we will need to be able to find this spreadsheet later to import back into the cost library.

 3. When Fathom has finished the export a message will be displayed notifying the user of a suc-
cessful transfer. Click OK, then browse to the exported worksheet and open it. The exported work-
sheet should contain a list of the selected pipe sizes, with empty columns where the cost per unit 
length can be entered for each cost type, as shown in Figure 11.

 4. Open the Creating Libraries - Cost Template.xlsx spreadsheet with the costs for this example. 
Navigate to the Pipe Costs tab, and copy the Material and Installation costs for the 1 inch to 36 
inch pipe sizes into the worksheet that we just exported. Ensure that data is entered for material 
and installation for each of the sizes from 1 to 36 inch, and that the length units are listed as feet in 
the worksheet, since these were the length units used by the manufacturer for their pricing. 

 5. Save and close the worksheet.

Note: The length units used for the spreadsheet are taken from the default model units, which can be 
changed from User Options in the Tools menu.
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Figure 10: Excel Export window showing pipe items that will be included in the Excel sheet

Figure 11: Initial Excel sheet after exporting template for the STD Steel-ANSI pipe sizes

Back in Fathom in the Cost Library window, click the Import from Excel button, then browse to the work-
sheet we just updated and open it. When the Import has finished click OK on the notification from 
Fathom, then click the 1 inch pipe size under the Steel - ANSI STD pipe type. The Material and Install-
ation costs should now be filled in, as shown in Figure 12. Click Save to save the cost library with a 
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unique file name Steel - ANSI Pipe Costs.cst, select Yes to make the library connected, then close the 
window.

Note: When using the Export/Import features for the cost library, it is not required to enter information 
for every size that was exported in order to import the worksheet. It is important to not delete any 
headings or descriptive information for the pipe data that was included in the template. Work-
sheets can be exported /imported as many times as desired, but whatever data is in the spread-
sheet will overwrite anything existing in the library, meaning that if the costs are left blank for a 
size, any cost information will be deleted for that pipe size in the library. Due to this fact it is 
recommended to export the current information in the library first before importing any change 
information so that an accidental overwrite does not occur.

In the Library Manager, the new cost library should now be shown  for the Steel - ANSI pipes, as shown in 
Figure 13, indicating that the pipe cost library was automatically connected.

Figure 12: The Pipe Materials tab in the Cost Library window, showing the data recently imported
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Figure 13: Library Manager after creating a engineering and cost libraries

 Step 7. Define the Sizing window

To make use of the newly creating engineering and cost libraries, a few inputs are required in the Sizing 
window. Go to this window now. 

A. Sizing Objective

By default, you should be on the Sizing Objective panel. For the Objective, select Monetary Cost. Then 
select Calculate Cost, Do Not Size. 

B. Size/Cost Assignments

On the Size/Cost Assignments panel, make sure the Pipes button is selected at the top. Click All on the 
bottom left then click Always Include in Cost at the top to add all pipes to the Include in Cost list.
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Click the Pumps button at the top to go to the pump size/cost assignments page. Select the radio button 
for both Pump 4 and 5 to Include in Cost Report Only.

Finally, go to the General Junctions button and add all four bends to the Include in Cost Report Only 
list.

C. Assign Cost Libraries

Go to the Assign Cost Libraries panel. All 22 pipes should assigned to the Steel - ANSI Pipe Costs lib-
rary, as shown in Figure 14. Check the Pumps and General Junctions pages as well to confirm that 
those junctions are connected to the Creating Libraries Costs, as shown in Figure 15
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Figure 14: The Assign Cost Libraries panel with the new pipe cost library applied
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Figure 15: Applying the newly built cost library for the pumps and bends on the Assign Cost Libraries panel

In order to link our libraries to specific junctions in the model, we will need to apply the Engineering 
Library to the junctions in the Workspace. Open each of the pump junctions and select the Sizing 680 
m3/hr item from the Library Jct list. Repeat this process for the four bend junctions in the model. Note 
that in this case the only thing that should change in the properties windows will be the name of the item 
from the Library list, since we created the library junctions based off of the junctions already defined in 
this model.
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As a quick summary, we first connected the new libraries using the Library Manager. We then connected 
the junctions to the Engineering Library by using the Library Jct selection in each of the properties win-
dows. In the Sizing tab we used the Assign Cost Libraries panel to select the corresponding Cost Library 
for each pipe and junction. The Assign Cost Libraries section is now complete.

 Step 8. Run the Model and Check Output

Click Run from the toolbar or Analysis menu. Before the solver runs, the Model Diagnostics window will 
appear. Because there was no design requirements specified for the control valves, the control valves 
will add pressure if necessary. Typically, these messages should not be ignored. However, we will see 
from the output that the control valves will not add pressure. Therefore click Close on this message to dis-
miss it.

When the solver finishes, go to the Output window. On the Cost Report tab, the total cost should be 
$35,261. In the Library Sources tab in the Junction section, each of the Bends and Pumps should list the 
Creating Libraries Costs as their library source as shown in Figure 16. The Library Sources in the Pipes 
section should similarly show the pipe cost library Steel - ANSI Pipe Costs for both Material and Install-
ation.

Figure 16: Output tab showing the current Library sources used in the model calculations



- 362 -

Cooling System - ANS 

Summary 

This example focuses on a closed loop cooling system that demonstrates some key features in using 
ANS to size a piping system. An existing model is used to investigate four potential sizing cases:

 1. Size system for initial cost with a 10-year operating period
 2. Size system for life cycle cost with a 10-year operating period
 3. Size system for life cycle cost with an initial cost limit for a 10-year operating period
 4. Size system for life cycle cost using a manufacturer's pump curve and with a 10-year oper-

ating period

The existing model was used to demonstrate AFT Fathom's capabilities for modeling closed-loop sys-
tems, pump curves, heat exchanger resistance curves, and fixed pressure drop control valves. This 
example will demonstrate how a system like the one built before can be seamlessly scaled up, meet 
design requirements, and minimize cost. For instance, the flow rate through the system will increase from 
200 in the original model and system to 1,360 m3/hr. The pipes must be sized and their costs minimized 
accordingly.

Note: This example can only be run if you have a license for the ANS module.

Topics Covered

 l Connecting and using existing engineering and cost libraries  
 l Sizing for initial or life cycle cost
 l Using an initial cost limit with life cycle cost sizing
 l Sizing a pump and sizing piping for the chosen pump
 l Interpreting Cost Reports

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition, it is assumed that the user has worked through the Beginner - Three-Reservoir - ANS 
example, and is familiar with the basics of ANS analysis.

Model Files

https://www.aft.com/products/fathom/video-tutorial-series
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This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Cooling System.fth
 l Metric - Cooling System - ANS.fth
 l Cooling System.dat - engineering library
 l Cooling System Costs.cst - cost library for Cooling System.dat
 l Steel - ANSI Pipe Costs.cst - cost library for Steel - ANSI pipes

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the model

Open the Metric - Cooling System.fth example file and save it as a new file. We will not need the exist-
ing child scenarios for this example: right click on the Base Scenario in the Scenario Manager and select 
Delete All Children.

Although the model is fully defined, a few alterations are necessary for this example to scale up the sys-
tem. First make sure that the Workspace looks like Figure 1 below:

Figure 1: Workspace for Cooling System model



Cooling System - ANS

- 364 -

 Step 3. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate ANS and select Network to enable the ANS module for use. A 
new group will appear in Analysis Setup titled Automatic Sizing. Click OK to save the changes and exit 
Analysis Setup. A new Primary Window tab will appear between Workspace and Model Data titled Siz-
ing. Open the Analysis menu to see the new option called Automatic Sizing. From here you can quickly 
toggle between Not Used mode (normal AFT Fathom) and Network (ANS mode).

 Step 4. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C

 Step 5. Define the Pipes and Junctions Group

As an initial guess to the scaled up system, we will change all pipe sizes to 36 inch. This should satisfy all 
Design Requirements and be a feasible solution, therefore it should be an acceptable initial guess for the 
system. Similar the junctions will be updated for the scaled up system.

Pipe Properties

Make the following changes to all pipes

 1. Pipe Model tab
 a. Size = 36 inch
 b. Type = STD

Junction Properties

Make the following changes to these junctions.

 1. J1 Reservoir 
 a. Liquid Surface Elevation = 9 meters
 b. Liquid Surface Pressure = 0 barG (0 kPa (g))
 c. Pipe Elevation = 0 meters

 2. J11 & J12 Control Valves
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 a. Valve Type = Flow Control (FCV)
 b. Control Setpoint = Volumetric Flow Rate
 c. Flow Setpoint = 450 m3/hr
 d. Always Control (Never Fail) = Unchecked

 3. J13 Control Valve
 a. Valve Type = Constant Pressure Drop (PDCV)
 b. Control Setpoint = Pressure Loss
 c. Pressure Drop = 0.345 bar (34.5 kPa)

 4. J14-J16 Heat Exchangers

 a. Enter Curve Data = 

Volumetric Pressure

m3/hr bar

0 0

450 3.45

900 13.8

 Step 6. Overview of Sizing Systems with Pumps

A centrifugal pump can be modeled with either the Pump Curve or Sizing Analysis Type. Generally if a 
specific pump has been identified the Pump Curve type would be chosen, whereas the Sizing option is 
useful during the selection stage in order to identify the pumping requirements for the system. In some 
cases even though the specific pump has not been chosen several candidate pumps are available. For 
this third case it would be best to model each candidate pump as a pump curve using separate scenarios 
for each pump.

Sizing a Pump

The pumps in our cooling water case are being sized, so the Sizing Analysis Type was used with 
assigned flows of 680 m3/hr. In order to allow the pumps to be defined as fixed flows the flow control 
valve at J17 has been defined at a fixed pressure drop of 0.345 bar to ensure that the minimum pressure 
drop requirement for this valve is met during the sizing stage. This model thus represents a first cut 
model where, based on the results, the two pumps will become actual pumps with pump curves, and con-
trol valve J17 will become a flow control valve controlling to 680 m3/hr, similar to control valves J9 and 
J13.

As already stated, when a pump is modeled as an assigned flow, it is not a specific pump from a specific 
manufacturer. Thus, the costs for the pump can only be approximated. To a first approximation, it should 
be possible to estimate the non-recurring cost (i.e., material and installation cost) for the pump as a func-
tion of power requirements. For instance, a typical one horsepower pump may cost $2000, and a ten 
horsepower may cost $4000. Other typical costs for different power requirements can be approximated. 
The actual cost for the pump will, of course, highly depend on the application. Pumps for special 
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applications such as corrosive fluids or high temperatures may have different cost structures, but a reas-
onable approximation of cost for various power usage levels should be possible. These costs are entered 
into a cost library, and are accessed by the solver. As ANS evaluates different combinations of pipe 
sizes, each combination will require a certain power from the pump. With a cost assigned to this power, 
ANS can obtain a cost to enter into the objective function that it minimizes. Later in this example, we will 
look at the costs for the pumps.

In addition to non-recurring costs, recurring costs can also be estimated. Specifically, the cost of the 
power used by the pump over a period of time can be determined. All ANS needs is an overall pump effi-
ciency to determine an actual power from the ideal power. Again, since we do not have a specific pump 
selected yet, the efficiency can only be approximated. ANS calls this the Nominal Efficiency. In addition, 
users can provide a Nominal NPSHR. 

One may ask how important it is to choose appropriate values at this level. It depends. If the model only 
sizes for non-recurring costs, then the nominal efficiency will affect the actual power requirement of the 
pump, and hence the cost obtained from the cost library. If the cost of the pump is large compared to the 
cost of the piping, the specified nominal efficiency will likely play a significant role in the system selection. 

In addition, for models that include energy costs in the objective, the energy cost may be a minor or major 
portion of the overall system cost. If it is a major portion, the results of the sizing will likely be very sens-
itive to the specified nominal efficiency.

Therefore, it is recognized that at this first cut phase the values for nominal efficiency and nominal 
NPSHR are imprecise and users may need to go through a few iterations to arrive at satisfactory results.

Modeling Pumps with a Pump Curve

When one is modeling a pump curve, accurate NPSHR and efficiency (or power) requirements can be 
specified for the pump. The cost data for that pump can also be accurately specified. During the auto-
mated sizing run the impact of the pump on the system sizing will be in the area of energy costs and in 
the requirement to satisfy the pump's design requirements.

First, let's discuss the issue of recurring cost. The non-recurring costs for the pump will be fixed, and will 
therefore not impact the sizing process. However, energy costs will vary with the power required for the 
pump. Thus including energy cost in the sizing will influence the pipe size selection.

Second, the specific pump has certain design requirements. For example, the sized network will be of no 
value if the NPSHR is violated. Thus, the pipes have to be selected by ANS in such a way as to satisfy 
all pump design requirements. 

Since a specific pump is not input for our cooling water model (yet), no specific pump selection can hap-
pen at this point. It may frequently be the case that, based on the results of modeling the pump as an 
assigned flow pump, several candidate pumps may exist. The best approach is to create a scenario for 
each of these pumps, and rerun the sizing for each candidate pump. This will yield an ideal candidate 
pipe system for each candidate pump, from which an educated choice can be made for the system 
design. All else being equal, the selection would be the candidate pipe system that offers the lowest cost. 
When approached in this manner, one is selecting the pump and the piping system as an entire system, 
which offers improved matching of the pump to the system, and also offers significant opportunity for cost 
reduction.

Summarizing the Pump Selection Process
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Based on the preceding discussion, we can outline a process for selecting a pump that offers a matched 
pump and piping system at the lowest possible cost. This discussion is an extension of the discussion in 
the Fathom Help file regarding sizing pumps and pipes concurrently. Here, we will augment that dis-
cussion with the considerations that are relevant to sizing.

 1. Phase 1: Size the pump
 a. Model the pump (or pumps) as assigned flow pumps using the Sizing Analysis Type. If flow 

control valves exist, select the one that offers the lowest pressure drop margin (as dis-
cussed in the AFT Fathom Help file), and set that one to a pressure drop control valve at 
the minimum required pressure drop.

 b. The largest uncertainty at this point is the cost of the pumps. Based on actual pump cost 
data, specify the approximate cost of pumps of different power levels for different flow 
rates. This is entered into a cost library. 

 c. Along with the design flow rate, specify a nominal efficiency that is consistent with the 
application and your experience. If you are unsure, take a guess and, after completing 
Phase 1, return to this step and improve your guess.

 d. If you have a reasonable idea of what the NPSHR will be, specify that in the nominal 
NPSHR. If you are unsure, ignore nominal NPSHR and proceed. After completing Phase 
1, check the NPSHA and make sure that pumps are available at the head requirements 
obtained from the ANS results that have sufficient NPSHR margin.

 e. Determine whether the design goal is to minimize initial cost or life cycle cost, and select 
the appropriate objective in the Sizing Objective panel.

 f. Run the model and review the results. Take note of the relative cost difference between the 
piping and the pump(s). If the pump costs are a significant percentage, then continued iter-
ation on Phase 1 will likely be worthwhile. Continued iteration would involve obtaining more 
precise cost information for pump(s) at the flow, head and power usage levels obtained 
from the Phase 1 results. It would also involve obtaining more precise information on nom-
inal efficiency and nominal NPSHR.

 2. Phase 2: Select a pump 
 a. Phase 1 worked with approximate cost and engineering data for your pump. With that 

information ANS sized the network for an optimal pipe and pump system combination. At 
this point, that optimal system should be viewed as preliminary. Based on the pump oper-
ating point from Phase 1, identify some candidate pumps that match the requirements.

 b. Change any flow control valves set to pressure drop control valves (as specified in Phase 
1a) back to flow control valves.

 c. Identify the operational requirements for the flow control valves, such as minimum pressure 
drop, and enter those as Control Valve Design Requirements.

 d. For each candidate pump, create a child scenario. Each child scenario should be created 
below the scenario that has the flow control valves as discussed in Phase 2a and 2b.

 e. Enter the pump head, NPSHR and efficiency (or power) curve. Enter the actual pump cost 
as well into a cost library.

 f. Run each scenario. All else being equal, the scenario with lowest cost will be the preferred 
design. The pipe sizes obtained from this final solution may differ slightly from those 
obtained Phase 1. If there are significant pipe size differences between Phase 1 and Phase 
2, it may indicate that the actual pump was not matched very well to the Phase 1 require-
ments. It could also mean that there was an error somewhere in the process.
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 g. In Phase 2f, it may not be true that all else is equal. For example, even if one design offers 
lower cost, you may prefer a higher cost system because your experience suggests the 
pump is more reliable. On another note, if it is possible to quantify the cost reliability, this 
can be included in the cost of the junction and the automated sizing process.

For this example, we will be completing the pump selection process above considering the objective of 
minimizing initial cost, then minimizing life cycle cost.

 Step 7. Configure Sizing Settings

Load the Base Scenario. The hydraulic model is already defined for a regular Fathom run, but we need to 
complete the sizing settings before running the analysis. Navigate to the Sizing window by clicking the 
Sizing tab at the top.

A. Sizing Objective

The Sizing Objective window should be selected by default from the Sizing Navigation panel along the 
bottom. For this analysis, we are interested in sizing the system considering the monetary cost for the ini-
tial costs only.

 1. Sizing Option = Perform Sizing
 2. Objective = Monetary Cost
 3. Option = Minimize
 4. Options to Minimize Monetary Cost = Size for Initial Cost, Show Energy Costs

 l This will update the cost table to include both initial costs in the sizing calculation, and 
moves the Energy costs to be included in the Cost Report so that we can later compare the 
costs in this scenario to one where the Energy costs are included for the sizing. We do not 
have any information on Maintenance cost, so we will leave this cost in Ignore Cost.

 5. System Life = 10 years

 6. Energy Cost = 0.11 U.S. Dollars Per kW-hr

 l Note this assumes the pump will run all day, every day, for the entire 10 years. Alternatively, 
we could have created an Energy Cost Library, which would be connected in the Assign Cost 
Libraries section. An Energy Cost Library allows variable energy costs to be used to account 
for varying prices during different times of day, different seasons, etc. For now, we are sim-
plifying the input by using a fixed cost.

The Sizing Objective window should now appear as shown in Figure 2.
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Figure 2: Sizing Objective panel setup for the initial cost analysis

B. Size/Cost Assignments

On the Sizing Navigation panel select the Size/Cost Assignments button. For this example we are sizing 
both the pipes and pumps for a new system, so we will need to calculate and minimize cost for all related 
objects in the model.
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ØClick All under the table to select all of the pipes, then click the Always Include in Cost button next to 
Move to. This will move all of the pipe selections to the corresponding column to be sized.

To decrease the run time and reduce complexity, as well as to enforce some design uniformity, it is useful 
to create Common Size Groups to link the pipes in different sections of the model. 

For example, if all the 22 pipes are selected to be Not In Group, then 22 unique pipe sizes will be selected 
by the automatic sizing engine. That could potentially mean, for example, different suction pipe dia-
meters in pipes 1 and 2. A similar thing would happen for discharge pipe diameters. If one wanted the 
suction pipes 1 and 2 to be sized to the same diameter, one would group them into a Common Size 
Group. To see how this works, in this model all suction and discharge piping for both pumps will be put 
into a Common Size Group. What this means is that there will be one unique diameter chosen for this 
group of pipes, rather than potentially six different diameters.

For this system we will define five groups to be sized in this model. To set the groups, it is standard to 
select pipes which must have the same size due to their placement relative to other pipes and junctions, 
such as pipes at the entrance and exit of valves. In Figure 3 we have identified the five sections of the 
model to group the pipes.

Figure 3: Workspace with separate sections identified to create Common Size Groups

First let’s create a Main size group for pipes 1 and 22, which are red in Section A. We would expect these 
lines to be sized the same, as the inlet and outlet for the cooling reservoir.

Note: If desired, the coloring and annotations in Figure 3 and in the completed model file can be recre-
ated using Workspace Layers.

ØClick New above the Pipe Grouping section to create the group, and name it Main. Select the radio 
buttons under Main next to 1 and 22 to add them to the group. Alternatively, both pipes could be selected 

Workspace-Layers.html
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in the Workspace, then be added to a new group by right-clicking the Workspace and choosing Add Pipe
(s) to Common Size Group.

Now let’s repeat this process for the piping in Section B around the pumps and control valves. Since this 
section contains identical pumps operating in parallel, we would expect the pipes in this section to have a 
common size. Similar to above, create a new group called Pump Station, and add pipes 2-7 as shown in 
orange in Figure 3 in section B to the new group by selecting them in the Workspace, or using the radio 
buttons.

Next, let’s consider Section C-E, the piping near the coolers. In this case we have three coolers in par-
allel, with several segments of pipe connecting the cooler piping segments. We would expect the pipes 
directly connected to the coolers to have a common size, but the header piping (9, 10, 20, 21) would 
likely need to be larger, so we will group them separately. Create three Common Size Groups as follows:

 1. Header 1 with 9 and 21 (Section C, lime green)
 2. Header 2 with 10 and 20 (Section D, magenta)
 3. Cooler Piping with 11-19 (Section E, blue)

The completed Size/Cost Assignments can be seen in Figure 4. Note that pipe 8 should be the only pipe 
not included in a group. This leaves six different pipe sizes that the ANS module will independently solve 
for during the automated sizing, one for each of the groups, and one for pipe 8. This is indicated in the bot-
tom right of the Size/Cost Assignments panel, which shows that six independent pipe sizes exist for this 
configuration.

Note: Pipes in the Size/Cost Assignments table can be sorted by Common Size Group instead of sort-
ing by number by clicking on the Pipe Grouping header. Clicking on the header for a particular 
group will sort the pipes in that specific group to the top of the window.

Figure 4: Size/Cost Assignments panel with Common Size Groups defined as outlined above
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ØClick the Pumps button to switch to view the Pump Size and Cost Assignments. Select the option to 
Include in Cost Report and Sizing for both pumps so that the ANS module will size the pumps along with 
the pipes as shown in Figure 5.

Similar to the Common Size Groups for pipes, Pumps can be placed into Maximum Cost Groups based 
on monetary cost. If pump costs are added to a Maximum Cost Group, the ANS module will determine 
the pump in the group with the maximum costs, and set all pumps in the group to use the largest cost. In 
this case we will allow the pumps to be sized independently, so no groups need to be created.

We also want to include the Bends in the sizing for this model.

ØClick the General Junctions button and change each of the Bends (3, 6, 10, and 19) to Include in 
Cost Report and Sizing (Figure 6)

Figure 5: Size/Cost Assignments panel defined for the pumps
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Figure 6: Size/Cost Assignments panel defined for the General Junctions

C. Candidate Sets

Click on the Candidate Sets button to open the Candidate Sets panel.

Click New under Define Candidate Sets and name it STD Steel 1"-36". In the Select Pipe Sizes window, 
select Steel - ANSI from the dropdown menu, expand the STD group (make sure the Sort selection on 
the bottom is Type, Schedule, Class), then add all pipes from 1 inch to 36 inch to the Candidate Set list 
on the right. Click OK to close the Select Pipe Sizes window.

In the bottom section of the window, assign each of the Common Size Groups and pipe P8 to the STD 
Steel 1"-36" Candidate Set. The window should appear as shown in the figure below.
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Figure 7: Candidate Sets panel fully defined for the model

D. Design Requirements

Select the Design Requirements button from the Sizing Navigation Panel.

For this model we have multiple requirements for the system:

 1. Max Velocity: All pipes have a maximum velocity of 3.66 meters/sec
 2. Min Pressure: All pipes have a minimum static pressure requirement of 1 bar
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 3. NPSH Margin: All pumps must have a minimum NPSH Margin of 3 meters  (for this system the 
nominal NPSHR is 15 meters)

 4. Design DP: All control valves must have a minimum static pressure drop of 0.345 bar
 5. All heat exchangers must receive a minimum flow of 430 m3/hr

Define and assign the first two requirements listed above as Pipe Design Requirements as shown in Fig-
ure 8, and item 3 as a Pump Design Requirement as shown in Figure 9. Notice that we have accounted 
for the minimum flow requirement in this system by using flow control valves at each of the heat 
exchangers. By using assigned flow pumps and flow control valves at the heat exchangers (we will do 
this later) we will incorporate the necessary flow rate as a boundary condition, so we do not need to apply 
a Design Requirement to account for this item.

For Control Valves 11 and 12 define and apply the minimum pressure drop requirement in the Control 
Valves section as shown in Figure 10. Note that for pump sizing purposes as discussed earlier Control 
Valve 13 has been defined as a Constant Pressure Drop valve, so the pressure drop Design Require-
ment does not need to be applied to this valve.

Figure 8: Design Requirements panel for pipes
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Figure 9: Design Requirements panel defined for the pumps
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Figure 10: Design Requirements panel defined for the control valves

E. Assign Cost Libraries

Select the Assign Cost Libraries button. For this model the engineering and cost libraries have already 
been created, but we will need to connect and apply them.

Note: The Cooling System, Creating Libraries - ANS example provides instructions on how to build 
the libraries for the first part of this example, and may be completed later for practice with cre-
ating libraries. The provided pre-built libraries will be needed to obtain the pump curve data for 
Step 16 of this example.

ØOpen the Library Manager by opening the Library menu and selecting Library Manager. The AFT 
INTERNAL LIBRARY,  LOCAL USER LIBRARY, and the pipe material libraries should be available and 
connected by default. Available libraries will be shown based on libraries that Fathom has identified on 
your machine. The default connected libraries will be visible here, and additional libraries may be visible 
from other example files or from libraries previously built and used on your machine.

This example uses one user-defined engineering library Cooling System.dat, which contains the data 
for the pumps and bends. There are also two cost libraries, Cooling System Costs.cst and Steel - 
ANSI Pipe Costs.cst, which contain the cost data for the junctions and the pipe materials, respectively. 
Cooling System Costs.cst was built off of the engineering library Cooling System.dat, and Steel - 
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ANSI Pipe Costs.cst was built off of the Steel - ANSI Pipe Material Library. To connect these libraries, 
do the following:

 1. Click Add Existing Library.
 2. Browse to the Fathom 13 Examples folder (located by default in C:\AFT Products\AFT Fathom 

13\Examples\), and open the file titled Cooling System.dat.
 3. Repeat the above steps, but choose Add Existing Cost Library to browse for Cooling System 

Costs.cst, then Steel - ANSI Pipe Costs.cst.

Note that it may be possible that the model file already has the cooling system libraries connected, in 
which case you will be notified that the library you are trying to add is already available. If the libraries are 
available, you will simply need to make sure they are connected by ensuring a checkmark is next to the 
name. There should be a library titled Cooling System  with two sub libraries: Junctions and Cost (Cost 
should have a cost file titled Cooling System Costs beneath it. Additionally a Cost sub library should 
appear subordinate to the Steel - ANSI, the library Steel - ANSI Pipe Costs should appear beneath it.

Note: When a library is selected in the Library Manager, the filename and location can be viewed in 
the Selected Content Information section.

Once you have confirmed that the necessary libraries are connected, click Close to exit the Library Man-
ager.

Figure 11: Library Manager with Cooling System junction libraries connected
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Since we are connecting a pre-built engineering library, we will need to take an additional step to confirm 
that the junctions in the Workspace are linked to the Cooling System engineering library that we added.

 1. Go to the Workspace, and open Pump J4
 2. From the Library Jct list, select Pump 680 m3/hr. The pump input should change, and Fathom will 

recognize that this junction is connected to the engineering and cost library for this pump. Click 
OK.

 3. Repeat step 2 for Pump J5.
 4. Open each of the Bends (junctions 3, 6, 10, and 19), and select STD Elbow for each from the 

Library Jct list, and click OK.

We have now re-connected the junctions that will be considered for the Cost Report and Sizing Cal-
culations to the engineering library. This is important, since a junction must be connected to an engin-
eering library before a cost can be assigned for it. Let's now return to the Sizing tab.

Back in the Assign Cost Libraries panel for the Pipes, All should be selected for the STD Steel 1"-36" inch 
Candidate Set with only the Steel - ANSI Pipe Costs library shown. The user can create and connect as 
many cost libraries as desired, which can be useful to easily update the cost of individual objects, rather 
than having to keep all of the costs in one large library. If multiple cost libraries are assigned to a Can-
didate Set, then the costs will be stacked to find a cumulative cost. 

ØClick on the Pumps button to view the cost library assignments for the Pumps. The only visible lib-
rary should be the Cooling System Costs library, as this was the only cost library connected for the asso-
ciated engineering library. Make sure that the checkboxes are selected under the library name so that the 
cost data will be applied for each of the pumps. To review the cost data for the Bends click the General 
Junctions button to verify that the Cooling System Costs are being applied to each of the bends. 

F. Sizing Method

Select the Sizing Method button to go to the Sizing Method panel.

ØChoose Discrete Sizing, if not already selected, since it is desired to select discrete sizes for each of 
the pipes in the model.

For this model we have six independent pipe sizes as mentioned earlier (five Common Size Groups and 
pipe 8), and 48 design requirements (2 pipe design requirements applied to all of the pipes, the pump 
NPSH requirement, and the minimum pressure drop for control valves).  Due to the number of inde-
pendently sized pipes, it would be recommended to try the MMFD or SQP search method.

Select Sequential Quadratic Programming (SQP) for the sizing method.

Note: Search Methods can give different results in certain cases. It may be prudent to try several meth-
ods and to proceed with the one that yields optimal results.

G. Sizing Summary

From the Sizing Navigation Panel select the Sizing Summary button.

The Sizing Summary panel allows the user to view all of the sizing input for the model in a tree view lay-
out, which is shown in Figure 12. Items can be organized by sizing parameters (Design Requirements, 

SearchMethods.html
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Candidate Sets, etc.), or information can be viewed based off an individual pipe. For clarity these cat-
egories can be shown/hidden using the check boxes at the top of the panel.

Each tree node can be expanded/collapsed individually by using the ‘+’ and ‘-‘ buttons on the node. 
Alternatively, the buttons on the bottom of the panel can be used to collapse/expand all items. Right-click-
ing on the nodes provides additional options to collapse/expand items, view related nodes, or to copy 
information to the clipboard. The Sizing Summary panel can be printed from the printer button at the bot-
tom of the panel.

Figure 12: Sizing Summary panel layout with the Size/Cost Assignments expanded. The number of children 
nodes for each item can be seen in parentheses.

 Step 8. Set up the Scenario Manager

To compare the four potential sizing cases, child scenarios will be set up in the Scenario Manager. Go to 
the Scenario Manager now and create the following child scenarios based on Figure 13 below. These will 
include the Not Sized scenario and the four potential sizing cases: Initial Cost, Life Cycle Cost, Initial 
Cost Limit, and Actual Pump Curve.
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Figure 13: Scenario Manager showing the child cases for the Cooling System ANS example

 Step 9. Set up the Not Sized scenario

Load the Not Sized scenario by double-clicking on it in the Scenario Manager.

Navigate to the Sizing window and go to the Sizing Objective panel. Select Calculate Cost, Do Not 
Size. In the Options to Minimize Monetary Cost, the selection should be User Specified. Make sure that 
the radio buttons for Material, Installation, and Energy are selected for Cost Report Only, while Main-
tenance should have Ignore Cost selected.

This will calculate the life cycle cost of the system before any sizing is performed. This cost will be used 
as a comparison to the sized scenarios.

 Step 10. Run the Model

Select Run Model in the Analysis menu or click Run Model in the Common Toolbar. This will open the 
Solution Progress window. This window allows you to watch as the Fathom Solver and ANS module con-
verge on a solution. 

After the run has been completed, the results can be reviewed clicking the Output button at the bottom of 
the solution progress window. 
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 Step 11. Review the Not Sized results

The Cost Report is shown in the General Section of the Output window (see Figure 14). No sizing was 
performed, so all cost values will appear in the Items Not In Sizing row. The total cost for this system is 
$2,491,404. This includes all costs over 10 years. The initial cost is the total of the material and install-
ation cost: $436,603. The energy cost for the system is $2,054,800. 

Figure 14: The Cost Report in the Output window shows the total and individual costs (in U.S. Dollars) for the 
sized system

With this basis, we will move on to the Initial Cost scenario.

 Step 12. Run the Initial Cost scenario and review the  results

Load the Initial Cost scenario using the Scenario Manager. This scenario should have all the inputs 
already specified, so no action is required besides running the model.

Click Run Model on the toolbar or from the Analysis menu. When finished, view the results by clicking the 
Output button at the bottom of the Solution Progress window. 

Go to the Cost Report, as shown in Figure 15. ANS shows all costs in the Cost Report, including those 
that were not used in the automated sizing. The total cost for this system is $2,365,110. This includes all 
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costs over 10 years. The initial cost, which was the basis for the automated sizing, was the total of the 
material and installation ($161,251). This total is listed as the total for the Items in Sizing row, since it was 
specified to only include the Initial Cost for material and installation on the Sizing Objective section. Indi-
vidual items that were included in the automated sizing have their costs highlighted in green.

Other costs that are displayed in the Cost Report are Items Not in Sizing. These are items that have costs 
associated with them, but were not included in the automated sizing. 

Note that the Items Not in Sizing total to $2,203,859. Looking across at the subtotal one can see that all 
of this cost is in Operation/Energy (i.e., pump power costs). The TOTAL cost is the sum of the Non-Recur-
ring Sub Total and the Recurring Sub Total. For the next scenario this operation/energy cost will be 
included in the automated sizing.

Figure 15: The Cost Report in the Output window shows the total and individual costs (in U.S. Dollars) for the 
sized system

In the Pipes section of the Output window the final pipe sizes from the automated sizing can be seen, 
along with the Design Requirements status. For this model, the final system used pipe sizes varying from 
10 to 16 inches, as seen in Figure 16. The information for the pumps can be seen in the Pump Summary 
tab in the General Section, which is also shown in Figure 16.

When a monetary cost objective is selected, additional tabs are available that display the Library Sources 
used for the Cost Report for each of the pipes/junctions. In this case both the Pipe Material and Pipe 
Installation costs for all of the pipes came from the Steel - ANSI Pipe Costs library which was connected 
earlier. Information for the Pumps and Bends came from the Cooling System Costs library. If multiple 
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cost libraries are used for a category they will all be listed separated by commas. The Library Sources for 
the Pipes can be seen in Figure 17.

Figure 16: Pump and Pipe Sizes after automated sizing is performed
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Figure 17: Library Sources for the Pipes in the Cost Report

Within the General tab of the Output window at the bottom of the report, the initial  cost of the items 
included in the sizing can be seen, which was $436,603 for this design, showing that the initial costs 
changed to $161,251, a 63% reduction! We can also see that the initial design was feasible, meaning all 
of the design requirements were  met (Figure 18). The ANS module both kept all design requirements sat-
isfied, as well as minimized the initial cost, all in under 3 seconds.

Although there was a 63% reduction in initial costs, the total cost decreased by 5%. Next, we will see how 
much more the total cost can be reduced by doing a life cycle system sizing.
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Figure 18: General section of Output window showing initial status of Items in Sizing

 Step 13. Size System for Life Cycle Cost over 10 Years

Load the Life Cycle Cost scenario from the Scenario Manager. Go to the Sizing window, and make sure 
that the Sizing Objective panel is opened. Under Options to Minimize Monetary Cost, choose Size for Ini-
tial and Recurring Costs. This will move the Energy costs selection to Include in Sizing Objective. The 
scenario is now complete.

ØClick Run from the Analysis menu to run the automated sizing. When the calculations have finished, 
click Output to view the results.

 Step 14. Compare the Sizing Results

After viewing the Cost Report, it can be seen that the total cost is now $2,295,100. The Items Not in Siz-
ing row now has zero values, and the Energy columns are highlighted green, reflecting the changes 
made to include these costs in the objective to minimize monetary cost. The Cost Report is shown in Fig-
ure 19.

Taken on its own, this new cost represents a savings of $196,304 (8%) compared to the Not Sized scen-
ario. Compared to the Initial Cost scenario, which was sized to minimize initial cost only, this new scen-
ario represents a savings of $70,010. This represents a total 3% cost reduction. In the Initial Cost 
scenario, the non-recurring cost was $161,251, while the overall cost was $2,365,110. Now the non-
recurring cost is $199,356 while the overall cost is $2,295,100. The initial cost thus increased by $38,105 
in order to reduce the operating cost from $2,203,859 to $2,095,743 (a reduction of $108,116). The 
source of the operating cost is the cost of power for the pumps. To reduce pump power usage, it makes 
sense to increase the pipe size and thus reduce frictional losses. The larger pipe sizes can be reviewed 
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by looking at the Sizing tab in the Pipe Output section. From the Pump Summary tab it can be seen that 
the pump power usage decreased slightly from 114 kW to 109 kW at each of the pumps, which is approx-
imately a 5% power requirement decrease at each pump. The Pump Summary and final pipe sizes can 
be seen in Figure 20.

Considering this cost breakdown between the scenarios highlights the importance of choosing to include 
the energy costs in the initial cost scenario. If they were not in the Cost Report of the initial cost scenario, 
the total cost would be $161,251. Since the life cycle cost scenario total cost is nearly ten times larger, it 
would appear (at first glance) to be a significant cost increase. However, this would be misleading, since 
the energy costs still exist in both scenarios, though they are only being minimized in one case. To get a 
clear comparison between designing for initial cost and life cycle cost one needs to make an apples-to-
apples comparison, including all relevant costs in each case, as is done for this example.

By performing both analyses the designer has quantitative data on the impact of initial cost design on 
operational costs of the system, and can make an informed design choice.

Figure 19: Cost Report for the network after sizing for life cycle cost
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Figure 20: Pump and Pipe Sizes after automated sizing is performed for life cycle cost

 Step 15. Size System for Life Cycle Cost with Initial Cost Limit

While the energy cost savings from life cycle cost sizing are desirable, the budget for the project may not 
support the higher initial cost that is required. In that case, we can apply an initial cost limit to the life cycle 
cost sizing. 

Load the Initial Cost Limit scenario from the Scenario Manager.

ØReturn to the Sizing Objective panel and select the option for Size for Initial and Recurring Costs 
and check the box next to Initial Cost Limit. We will set the limit as $175,000, which is slightly more than 
the initial cost of the scenario that minimized initial cost at the expense of an increased life cycle cost. 
Run the model and go to the Output tab.

A summary of the results with the initial cost limit compared to each of the initial and life cycle cost sizing 
scenarios for a 10 year life cycle can be seen in Table 1.  Notice that while the material and installation 
costs were limited to $175,000, the total costs over a 10 year lifetime are decreased by about $48,392 
compared to the Initial Cost scenario. The initial cost increased from $161,251 to $175,158: a $13,907 
increase. Therefore, a $13,907 initial cost increase leads to a life cycle decrease of $48,392. This sav-
ings comes from the reduction pump energy costs. These reduced energy costs were achieved by 
increasing the Main pipes (P1 & P22), pipe P8, and the Header pipes  while decreasing the pipes in 
Cooler Piping. 
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Figure 21 shows a comparison of the pipe sizes throughout the system for the Initial Cost scenario, the 
Life Cycle Cost scenario, and the Life Cycle Cost with Initial Cost Limit scenario. Note that this diagram 
was generated outside of AFT Fathom, but sized results can be shown for each scenario individually 
using Workspace Layers.

 

Table 1: Cost Summary of Sizing Runs for Cooling System

Scenario Material Installation
Non-Recur-
ring Sub 

Total
Operation/Energy TOTAL Reduction

Not Sized 334,783 101,820 436,603 2,054,800 2,491,404 -

Initial Cost 107,158 54,093 161,251 2,203,859 2,365,110 126,294

Life Cycle 
Cost 135,634 63,723 199,356 2,095,743 2,295,100 196,304

Initial 
Cost Limit 117,815 57,343 175,158 2,141,559 2,316,718 174,686

Figure 21: Pipe sizes selected by the ANS module for the life cycle cost and life cycle cost with an initial cost 
limit compared to sizing for initial cost only

 Step 16. Automated Sizing with Pump Curve Data

As discussed in the section Summarizing the pump selection process, once the pump is sized then 
actual pumps can be modeled. The actual pump should closely match the sizing results in the following 
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areas: generated head at the design flow, efficiency at the design flow, and cost. We will apply a pump 
curve for the case that was sized for life cycle cost to complete  the pump selection process.

Reviewing the results for the life cycle cost scenario one can see that the sized system calls for a pump of 
about 109 kW that generates about 41 meters of head at 680 m3/hr. The nominal efficiency used in the 
sizing part of the analysis was 70%. The material cost for such a pump was about $22,800 and the install-
ation cost was about $7,400. Note that if no actual pump can be found that reflects these requirements, 
then the phase 1 of the pump selection process described above should be repeated with better per-
formance and/or cost data for the pump. 

Based on the sizing analysis, we will choose a pump from the (fictitious) PowerFlow Pump Company. Its 
model JW120 is a close match for the requirements of a 10-year life cycle design. The model JW120 has 
the following characteristics: at 680 m3/hr its head is 45 meters and efficiency is 70%. Its material cost is 
$25,000 and installation cost is $8,000. To set up a new scenario for the system with the candidate pump 
data:

 1. Load the Actual Pump Curve scenario and go to the Output window. Currently it should be 
identical to the parent scenario Life Cycle Cost. Run the scenario.

 2. Open the Edit menu and select Transfer Results to Initial Guesses. When the Transfer Results 
Options window appears, select Calculated Pipe Sizes Only and hit OK.

Note: The pipe sizes in Model Data are now equal to the pipe sizes selected by ANS for the Life 
Cycle Cost scenario. Starting from a more optimal solution can aid convergence and in 
this case will improve solver execution time.

 3. Go back to the Workspace. In the properties window for each of the pumps select PowerFlow 
Pump JW120 from the Library Jct list to import the pump data from the library as shown in Figure 
22, then click OK.

 4. In the Control Valve properties window for J13, change the Valve Type to Flow Control (FCV), 
and enter a Flow Setpoint of 450 m3/hr. Uncheck Always Control (Never Fail), Now that we have 
changed the control valve model, we will need to add a new Design Requirement in order to 
account for the minimum pressure drop.

 5. Go to the Sizing window, navigate to the Design Requirements panel, select the Control 
Valves button at the top of the window, and apply the Design DP design requirement to J13.
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Figure 22: Pump Properties window with the PowerFlow Pump JW120 selected

The necessary changes are now complete to size the system with the updated pump and flow control 
valve data.

ØSelect Run from the Analysis menu to perform the automated sizing - this may take some time.

When the solver has finished, click Output to review the results. The overall cost for the system is about 
$2,476,563. Clicking the Pump Summary tab shows that the operating point with the actual pump curve 
is similar to the sizing scenario.

Now we have sized the system for use with an actual pump.
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Figure 23: Cost Report for system with actual Pump and FCV data sized for 10 year life cycle cost
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Cooling System, Multiple Design Cases - ANS 

Summary 

Some pipe system designs have multiple operating conditions to satisfy. For instance, the cooling water 
example discussed in the previous example may have a requirement that it operate with one of the 
pumps turned off. This can be modeled in the ANS module by taking advantage of its ability to model mul-
tiple systems concurrently. 

Note: This example can only be run if you have a license for the ANS module.

Topics Covered

 l Defining dependent Design Cases 
 l Using Duplicate Special to create Dependent Designs
 l Specifying fractional pump costs with Dependent Design Cases
 l Using multiple Dependent Design Cases

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition, it is assumed that the user has worked through the Beginner - Three-Reservoir - ANS 
example, and is familiar with the basics of ANS analysis.

Since this example is a continuation of the Cooling System - ANS example, it is recommended to com-
plete that example first before beginning this example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Cooling System - ANS.fth
 l Metric - Cooling System Multiple Design Cases - ANS.fth
 l Cooling System.dat - engineering library
 l Cooling System Costs.cst - cost library for Cooling System.dat
 l Steel - ANSI Pipe Costs.cst - cost library for Steel - ANSI pipes

https://www.aft.com/products/fathom/video-tutorial-series
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 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the model

Open the Metric - Cooling System - ANS.fth example file and save it as a new file. Delete the annota-
tions and hide the layers for Section A through E. The Workspace should look like Figure 1 below.

Browse to the Life Cycle Cost scenario in Scenario Manager. Create a child scenario from this called 
Dependent Design Cases to work in for this example.

Figure 1: Workspace for Cooling System model

 Step 3. Enable Dependent Design

When modeling multiple design cases, the different cases need to be broken up into a primary design 
case, of which there is one, and dependent design cases, of which there can be any number.

The primary design case can be any of the design cases that are being addressed in your model. Typ-
ically, it will represent the primary operating condition of the pipe system. The dependent design cases 
represent the same physical operating system, but are used to represent differing operating conditions. If 
it is not clear which case should be the primary case, just pick any of the cases and call that the primary 
one. Design cases other than the primary case are referred to as dependent design cases. The reason 
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why we choose a primary case and refer to the other cases as dependent cases will become clearer as 
we progress through this topic.

For this example the primary design case is the system running with all pumps turned on. We want to 
also consider the case where only one pump is running. The one pump running case will be created as a 
dependent design case.

Dependent design case modeling is enabled in the Sizing Objective panel.

ØIn the Dependent Design Case scenario go to the Sizing window and to the Sizing Objective 
panel. Check the box next to Enable Dependent Design Cases. A new button will now be available for 
the Dependent Design Cases panel in the Sizing Navigation Panel as shown in Figure 2.

Figure 2: The Dependent Design Cases panel is enabled from the Sizing Objective panel

 Step 4. Setting up the Dependent Design Case

A. Using Duplicate Special

The easiest way to set up a dependent design case once it has been enabled is to use Duplicate Special, 
which will allow us to make an exact duplicate of the model in order to setup the additional operating 
cases. Note that you should fully define the model and all the sizing settings for the primary case before 
creating the dependent cases, as has been done in this model.

To create the dependent cases:



Cooling System, Multiple Design Cases - ANS

- 396 -

 1. Make sure that the scenario where the dependent cases will be created is loaded. In this case, 
you should have the Dependent Design Cases scenario loaded.

 2. Go to the Workspace. 
 3. Go to the Edit menu and choose Select All.
 4. Go to the Edit menu again and choose Duplicate Special (see Figure 3).
 5. Choose an increment for the pipe and junction numbers. The number should be large enough to 

avoid conflicts with numbers used for other pipes and junctions in this and all other scenarios. In 
this case use 100.

 6. Select the Make Dependent Design Case check box.
 7. Click OK and move the duplicated version of the primary design case to an open area in the Work-

space. The model should now appear similar to Figure 4.

Note that Duplicate Special also allows you to do the following:

 l Create a group for the dependent design case. This can simplify managing the pipe and junction 
objects in the design case.

 l Hide the pipe and junction in the output. You may want to do this for reasons to be discussed later 
in this topic.

 l Copy Layer Style Settings From Original Objects. If the visibility of the Section A through E layers 
is toggled back on, they will apply the same colors to both the duplicate and original model if this 
option was checked while creating the duplicate.

 l Keep Common Size Groups. This feature is useful when using Duplicate Special for reasons other 
than dependent case creation, and can't be used when making a dependent design case.

 l Clear the Design Requirements. For reasons to be discussed, frequently dependent design cases 
will employ different design requirements than the primary design case. This option allows you to 
clear all the current requirements, so new ones can be assigned.

Figure 3: Duplicate Special simplifies creation of dependent design cases
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Figure 4: Workspace with the Dependent Design Case created for the Cooling System model

B. Apply the Dependent Design Operating Conditions

The dependent design case capability takes advantage of the ANS module's ability to run multiple mod-
els in the same Workspace. The pipes and junctions in Figure 4 that are numbered greater than 100 (i.e., 
the dependent design case) represent the same pipes and junctions as those numbered less than 100 
(i.e., the primary design case). It is therefore critically important that only certain data in the dependent 
case is changed. 

Frequently the Design Requirements or Special Conditions on the pipes or junctions will be changed. 
However, data such as a pipe's length or pump's performance should never change. The reason is that 
once this kind of data is changed, the pipe or junction is no longer the same pipe or junction, and thus the 
purpose of the dependent link is invalidated. The ANS module does not prevent changing data that 
should not be changed, but when the model is run it will check to make sure all data that should be the 
same actually is the same.
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In this example we are analyzing the case where one pump in the system is shut off, so we will use Spe-
cial Conditions on the pump. With one pump shutoff we will not have enough flow to supply all three heat 
exchangers, so we will also close one of the heat exchangers as well as a control valve.

ØChange the Special Conditions of J105 to Pump Off No Flow.

ØChange the Special Conditions of J111 to Closed.

Selecting these junctions on the Workspace and using the F4 keyboard shortcut is an option for applying 
these special conditions quickly. The dependent case should now appear as shown in Figure 5.

Figure 5: Flow off for Pump 105 and Control Valve 111 in the Dependent Design Case

We will now need to adjust the Design Requirements for the model. Go to the Design Requirements 
panel on the Sizing window.

Currently it can be seen that Duplicate Special maintained all of the same design requirement applic-
ations from the primary case in the dependent case. While most of the design requirements used in the 
primary case still apply, we will need to remove the Design Requirements from the closed sections of the 
model. If the model were run without making any changes, the ANS module would not be able to find a 
feasible system, since it is impossible to achieve a minimum flow of 450 m3/hr in Heat Exchanger 114 
now that it has been forced closed. A similar problem exists with the minimum NPSH margin being 
applied to Pump 105, which is also closed.

The flow requirements for Heat Exchanger 115 and 116 will also need to be reconsidered. Since there is 
only one pump running a lower supply flow rate is expected, so the minimum flow rate required by the 
coolers should be lowered to 340 m3/hr.

The pressure drop across the control valves still needs to be a minimum of 0.345 bar. For J112, this is 
accomplished by using a Design Requirement whereas J113 is defined as a constant pressure drop con-
trol valve (PDCV) with the required pressure drop.

Apply the changes as follows:

 1. Click the Pumps button to go to the pump Design Requirements
 2. Uncheck the box next to J105 to remove the NPSH requirement from Pump 105 in the dependent 

case (Figure 6).
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 3. Click the Control Valves button to go to the control valve Design Requirements.
 4. Uncheck the box next to J111 to remove the pressure drop requirement from the closed control 

valve (Figure 7).
 5. Return to the Workspace and open the Control Valve Properties window for J112.
 6. Change the Flow Setpoint to 340 m3/hr(Figure 8).

No other changes are needed, so the Dependent Design Case scenario is now complete. 

ØSelect Run from the Analysis menu to perform the automated sizing, and go to the Output window 
once the run is complete to view the results.

Figure 6: Pump Design Requirements for the dependent design case
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Figure 7: Control Valve Design Requirements for the dependent design case
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Figure 8: Flow Setpoint adjusted in the dependent design case for FCV J112

Summary

The cost report for the Dependent Design Case scenario can be seen in Figure 9 below.

Note that the pipes and junctions in the dependent case are separate entities for modeling purposes, but 
represent the same pipes and junctions as the primary case. Thus when performing automated sizing, 
we only count the cost of the pipes and junctions once. This occurs in the primary design case, which in 
our model is the two pumps running case. This is why only the primary design case pipes are shown in 
the cost report.

With one exception, it is not possible for a model that includes a dependent design case to yield a better 
design than the primary case alone. At best, it can yield the same design, such as in this scenario. This is 
due to the fact that the dependent design case imposes additional restrictions on the solution by adding 
additional design requirements. If the design for the primary design case is not sufficient for the depend-
ent design case, then the design must be changed, which will increase cost in some manner.

Turning off Pump 105 in this scenario required no adjustments in the pipe sizes, so the initial sizing res-
ults remained unchanged.
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Figure 9: Cost Report for the Dependent Design Case scenario
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Hot Water System - ANS 

Summary

This example will take an existing hot water system design, scale it up, and size the pipes to meet a set of 
system requirements at a minimal cost. The system cost is included to demonstrate the need for sizing. 
The system must meet the following requirements:

 l Minimum 0.7 bar (70 kPa) drop across flow control valves in all cases
 l Maximum 2.5 meters/sec velocity in all pipes in all cases 
 l No NPSH violations
 l All pumps must operate between 80% to 100% of the BEP (Best Efficiency Point)
 l System must also function with Pump A turned off with no BEP restrictions
 l The flow rate through the heat exchangers is controlled by FCVs set to 680 m3/hr.

Note: This example can only be run if you have a license for the ANS module.

Topics Covered

 l Defining pump Design Requirements
 l Sizing the system to minimize initial costs
 l Using Dependent Design Cases

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition, it is assumed that the user has worked through the Beginner - Three-Reservoir - ANS 
example, and is familiar with the basics of ANS analysis.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Hot Water System.fth
 l Metric - Hot Water System - ANS.fth

https://www.aft.com/products/fathom/video-tutorial-series
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 l Hot Water System.dat - engineering library
 l Hot Water System Costs.cst - cost library for Hot Water System.dat
 l Steel - ANSI Pipe Costs.cst - cost library for Steel - ANSI pipes

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the model

Open the Metric - Hot Water System.fth example file and save it as a new file. We will not need the 
existing child scenarios for this example: right click on the Base Scenario in the Scenario Manager and 
select Delete All Children.

Although the model is fully defined, a few alterations are necessary for this example to scale up the sys-
tem. Open the Workspace Layers tab in the Quick Access Panel and load the Layer Preset ANS Sizing 
Group View to display the sizing group colors. The Workspace should now appear as shown in Figure 1 
below. Colors for each sizing group can be toggled individually by toggling their respective layer.

Figure 1: Workspace for the hot water system model with Common Size Groups indicated by color
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 Step 3. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate ANS and select Network to enable the ANS module for use. A 
new group will appear in Analysis Setup titled Automatic Sizing. Click OK to save the changes and exit 
Analysis Setup. A new Primary Window tab will appear between Workspace and Model Data titled Siz-
ing. Open the Analysis menu to see the new option called Automatic Sizing. From here you can quickly 
toggle between Not Used mode (normal AFT Fathom) and Network (ANS mode).

 Step 4. Define the Pipes and Junctions Group

For this example, the existing system is being scaled up. As an initial design, set all pipe diameters to 20 
inches and increase the flow setpoints of the control valves to 680 m3/hr.

Make the following changes to these pipes junctions

 1. All Pipes
 a. Size = 20 inch
 b. Type = STD (schedule 20)

 2. J14 & J17 Control Valves
 a. Flow Setpoint = 680 m3/hr

 Step 5. Configure Sizing Settings

We will need to define the sizing settings to account for the three given Design Requirements while min-
imizing the initial costs for the system. To do this, we will follow the Sizing steps as outlined below.

A. Sizing Objective

The Sizing Objective panel should be selected by default in the Sizing Navigation panel.

Select Perform Sizing.

For the Objective, make sure that Monetary Cost is selected, and Minimize is chosen from the drop-
down.

We will also need to specify which types of monetary cost we want to size for. Choose Size for Initial 
and Recurring Costs, if not selected already, to move the Material and Installation costs to the column 
to be sized.

Set the System Life to 10 years.

Under Energy Cost, select Use This Energy Cost Information and enter 0.12 U.S. Dollars Per kW-hr.

B. Size/Cost Assignments
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On the toolbar at the bottom of the window select the Size/Cost Assignments button. The Size/Cost 
Assignments window allows the user to define what will be sized in the model.

To increase the analysis speed and reduce complexity, it is useful to create Common Size Groups to 
group the pipes in different sections of the model. For this system we have defined 5 groups to be sized, 
as can be seen in Figure 2. We do not want to size pipe P1, but we will include it in the cost calculation for 
the sake of comparison later.

ØCreate the Common Size Groups shown in Figure 1 and Figure 2 in the model by either using the 
radio buttons in the table, or by selecting the pipes in the Workspace and adding them to groups from the 
right click menu.

Figure 2: Size/Cost Assignments using Common Size Groups to simplify calculations

Besides the pipes, it is also desired to include the pumps in the sizing.

ØSelect the Pumps button then set each of the pumps to be included in the Cost Report and Sizing.

C. Candidate Sets

Click on the Candidate Sets button to open the Candidate Sets panel.

Click New under Define Candidate Sets and name it STD Steel 1"-36". In the Select Pipe Sizes window, 
select Steel - ANSI from the dropdown menu, expand the STD group (make sure the Sort selection on 
the bottom is Type, Schedule, Class), then add all pipes from 1 inch to 36 inch to the Candidate Set list 
on the right. Click OK to close the Select Pipe Sizes window.

In the bottom section of the window, check that each of the Common Size Groups  have been assigned to 
use the existing Candidate Set.

D. Design Requirements
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Select the Design Requirements button.

For this model we only have three given Design Requirements which will need to be applied for the pipes, 
control valves, and pumps. We will start with the pipes:

 1. Ensure the Pipes button at the top of the window is selected.
 2. Click the New button under Define Pipe Design Requirements.
 3. Enter a name when prompted: Max Pipe Velocity.
 4. In the table, select Velocity as the Parameter.
 5. Choose Maximum for Max/Min, and enter 2.5 meters/sec.

Now that the requirement is defined, make sure that it has been applied to all pipes in the model by check-
ing the box next to each of the Common Size Groups in the bottom section of the window, as shown in 
Figure 3.

Repeat the same process as above by clicking the Pumps, then Control Valves button to apply the 
Design Requirements for the Pumps and Control Valves as follows, and as is shown in Figure 5 and Fig-
ure 4 respectively.

 l All of the Pumps must have a minimum % Flow of BEP of 80% and a maximum % Flow of BEP of 
100%

 l Both Control Valves must have a minimum stagnation pressure drop of 0.7 bar (70 kPa)

Note: The Design Requirements are not enforced when the model is not being sized. Instead, the 
design requirements are treated as Design Alerts, which is useful to assess the feasibility of the 
initial design.
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Figure 3: Pipe Design Requirements
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Figure 4: Pump Design Requirements
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Figure 5: Control Valve Design Requirements

E. Assign Cost Libraries

Select the Assign Cost Libraries button. For this model the engineering and cost libraries have already 
been created, but we will need to check that they have been connected and applied properly.

ØOpen the Library Manager by clicking the Library Manager button to see which libraries are con-
nected. The AFT INTERNAL LIBRARY and LOCAL USER LIBRARY should be available and connected. 
The AFT internal library also has a cost library associated with it.  This example uses the engineering lib-
rary Hot Water System.dat and two cost libraries, Hot Water System Costs.cst and Steel - ANSI 
Pipe Costs.cst which are linked with the Hot Water System engineering library and the pipe material lib-
rary for Steel - ANSI, respectively. If the libraries are connected, there will be a check in the box next to 
their name, as shown in Figure 6.

If they are not in the available library list, add them from the Examples folder in the AFT Fathom 13 folder. 
Click Add Existing Library to navigate to and select the library Hot Water System.dat. Next, click Add 
Existing Cost Library and add Hot Water System Costs.cst and Steel - ANSI Pipe Costs.cst.

The Metric - ANS Hot Water Heat Exchanger junction will only be used for the heat exchanger resistance 
curve. The Metric - ANS Hot Water Pump junction will be used for the three pumps. These are the only 
junctions in this library that will be used in this example.
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Once they have been added to the  list, check to see that they are also connected. If they are not auto-
matically connected, click the check box next to their name to connect them as seen in Figure 6. Click 
Close.

Figure 6: Library Manager with Hot Water Pumps connected

Back in the Assign Cost Libraries window for the Pipes, the STD Steel Pipe 1"-36" Candidate Set 
should now show the Steel - ANSI Pipe Costs library applied to it.

Navigate to the Workspace and connect all three pump junctions to the Metric - ANS Hot Water Pump 
library junction by opening the pump properties window and selecting Metric - ANS Hot Water Pump 
from the Library Jct  list. Do the same for both Heat Exchanger junctions, selecting Metric - ANS Hot 
Water Heat Exchanger.

Back in the Sizing window on the Assign Cost Libraries panel, click on the Pumps button to view the cost 
library assignments for the Pumps. Similar to the Pipes, the Hot Water System Costs library should be 
selected for Pumps 4, 7, and 10, showing that it is being applied.

F. Sizing Method

Select the Sizing Method button from the Sizing Navigation panel.

Make sure that Discrete Sizing is selected for the Sizing Type.
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For this model both the Modified Method of Feasible Directions (MMFD) and the Sequential Quad-
ratic Programming (SQP) methods will produce the same results, but MMFD is much faster. Select 
MMFD for the Search Method.

Figure 7: Sizing Method Settings to discretely size the system

 Step 6. Create Scenarios

For this system we would like to get a baseline cost for the current design to compare against the sizing 
results.

In the Scenario Manager in the Quick Access Panel create two scenarios and name them Before Sizing 
and After Sizing.

Load the Before Sizing scenario if it is not already active by double-clicking the scenario name in the 
Scenario Manager. We need to set this scenario to calculate costs without sizing the system.

In the Sizing window go to the Sizing Objective panel, then select Calculate Cost, Do Not Size. 

 Step 7. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 



Hot Water System - ANS

- 413 -

 Step 8. Review the Results

The Cost Report for the initial design can be seen in Figure 8. The total cost comes out to $2,132,398. In 
the pipe output section there is a Pipe Design Requirements tab and in the junction output section there 
is a Pump Design Requirements and Control Valve Design Requirements tab. These tabs will show if the 
current model fulfills the Design Requirements. We can investigate the design requirement tabs and see 
that the initial system meets all of the Design Requirements, meaning that it is a feasible solution; 
however, a lower cost system can likely be found by sizing the system.

Figure 8: Cost Report for the initial system design before sizing

 Step 9. Run the Model and View Results

Switch to the After Sizing scenario in the Scenario Manager. This scenario should already be fully 
defined for sizing.

Select Run from the Analysis menu to perform the automated sizing calculations. Using the 
MMFD method, the automated sizing takes about 2 minutes, depending on your machine. When the run 
has completed click Output to view the results, as shown in Figure 9.

The automated sizing has given us savings of about $183,000 overall on material, installation, and oper-
ation costs over the lifespan of the system. This is a 9% reduction.
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Figure 9: Sizing output based on the initial cost of the system with all pumps operating

 Step 10. Create Dependent Design Case

We also want the system to function with one pump turned off. To size a system with two different oper-
ating cases, we can create a Dependent Design Case that has the exact same pipes and junctions as the 
primary design but has a different set of requirements. 

Create a new child of the After Sizing scenario in the Scenario Manager, and name it Sizing with Pump A 
off.

Here are the steps to create this Dependent Design Case:

 1. Go to the Sizing Objective panel and check the box next to Enable Dependent Design Cases 
option.

 2. Go to the Dependent Design Cases panel. You should now see instructions displayed to create 
the Dependent Design Case, along with a summary table of dependent design settings. Now go to 
the Workspace and choose Select All from the Edit menu.

 3. Open Duplicate Special from Edit menu, enter an increment of 100 and select Make Depend-
ent Design Case.

 4. Click OK, then paste the duplicated model so that it does not overlap the original.
 5. When the Workspace has been duplicated, select the Pump A from the Dependent Design Case 
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(J104). In the Pump Properties window select the Optional tab and check the Pump Off No 
Flow radio button under Special Conditions. This will turn Pump A off.

We have now made all of the changes required in the Workspace. We will also need to make some 
adjustments to the Design Requirements for our Dependent Design Case. With Pump A turned off we no 
longer require any of the pumps to operate between 80% and 100% of BEP. We will therefore need to 
remove the Pump Design Requirements.

ØGo to the Design Requirements panel and select the Pumps button. In the Assign Design Require-
ments to Pumps section, remove the Design Requirements for all of the dependent design pumps by 
unchecking the boxes as is shown in Figure 10.

Once this is done run the model again and go to the Output window.

Figure 10: Pump Design Requirements defined for the Dependent Design Case pumps

Summary

Table 1 compares the results for each of the scenarios. The final design is the lowest cost that meets all 
the requirements. It can be seen that in order to meet the system requirements for the case where Pump 
A is turned off, slightly larger pipe sizes are used, resulting in a higher system cost.

The Final Design provides a $165,412 (8%) cost reduction from the Initial Design while still meeting all 
design requirements.
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Table 1: Summary of costs for Hot Water System scenarios

Design Stage Initial Design Design Final Design

Scenario Before Siz-
ing After Sizing Sizing with 

Pump A off

Meets all Require-
ments Yes Yes Yes

Material 393,463 252,323 265,590

Installation 192,331 150,296 154,765

Non-Recurring Sub 
Total 585,794 402,620 420,355

Operation/Energy 1,546,604 1,546,644 1,546,631

TOTAL 2,132,398 1,949,264 1,966,986
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Summary

As seen in other examples, the ANS module can be used to size a system for life cycle cost. The ANS 
module will size the complete system, pumps and pipes to minimize the total cost of operating the system 
for the life of the system. Often sizing the pumps and pipes is not enough because the control system is 
often a large portion of the initial cost and the method of control, flow control valves (FCV) or variable fre-
quency drives (VFD), can have a large impact on the system energy usage. This example will demon-
strate how to size pumps and control valves in parallel and then will investigate the savings of using a 
VFD to control flow instead of a FCV. 

Note: This example can only be run if you have a license for the ANS module.

Topics Covered

 l Using Scenarios to size a system for two different sets of system requirements
 l Using Common Size Groups and observing their effect on how well the ANS module can size a 

system

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition, it is assumed that the user has worked through the Beginner - Three-Reservoir - ANS 
example, and is familiar with the basics of ANS analysis.

Since this example employs many concepts from the Cooling System - ANS example, it is recom-
mended to complete that example first before beginning this example.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Variable Drive - ANS.fth
 l Variable Drive.dat - engineering library
 l Variable Drive - Pump Costs.cst - cost library for Variable Drive.dat

https://www.aft.com/products/fathom/video-tutorial-series
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 l Variable Drive - VFD Costs.cst - cost library for Variable Drive.dat
 l Variable Drive - Pipe Costs.cst - cost library for Steel - ANSI pipes

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Set up Library Manager

This example uses engineering and cost libraries. It is important that these libraries are added and con-
nected to Fathom for defining the pipes and junction.

Go to the Library menu and open Library Manager. Click Add Existing Library and navigate to the 
AFT Fathom 13 Examples folder. Select the library Variable Drive.dat and click Open. Make sure that 
the Variable Drive engineering library in Library Manager has a check mark next to it. The cost libraries 
will be added later during the Sizing steps.

 Step 3. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate ANS and select Network to enable the ANS module for use. A 
new group will appear in Analysis Setup titled Automatic Sizing. Click OK to save the changes and exit 
Analysis Setup. A new Primary Window tab will appear between Workspace and Model Data titled Siz-
ing. Open the Analysis menu to see the new option called Automatic Sizing. From here you can quickly 
toggle between Not Used mode (normal AFT Fathom) and Network (ANS mode).

 Step 4. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = User Specified Fluid
 b. Name = Lube Oil
 c. Density = 0.7 S.G. water
 d. Dynamic Viscosity = 0.29 kg/sec-m

 Step 5. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
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fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.

Figure 1: Layout of Generator Lube Oil System

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 6 inch 
 d. Type = schedule 40
 e. Friction Model Data Set = Standard
 f. Lengths =

Pipe Length (meters)

1 6

2-4 3

5-6 2

7 1

8 5

9-14 3

15-22 6

23 15

Junction Properties



Variable Drive - ANS

- 420 -

 1. J1 Reservoir
 a. Name = Lube Oil Supply Tank
 b. Liquid Surface Elevation =  6 meters
 c. Liquid Surface Pressure = 1 atm
 d. Pipe Depth = 3 meters

 2. J2 Valve
 a. Name = Isolation Valve
 b. Inlet Elevation = 0 meters
 c. Valve Data Source = User Specified
 d. Loss Model = K Factor
 e. K = 0.15

 3. All Branches
 a. Elevation = 0 meters

 4. J4 & J5 Pumps
 a. J4 Name = Primary Pump
 b. J5 Name = Auxiliary Pump
 c. Library Jct = Pump 450 m3/hr Sizing
 d. Inlet Elevation = 0 meters
 e. J5 Special Condition = Pump Off No Flow

 5. J7 Control Valve
 a. Name = 450 m3/hr Control
 b. Inlet Elevation = 0 meters
 c. Valve Type = Constant Pressure Drop (PDCV)
 d. Control Setpoint = Pressure Loss
 e. Pressure Drop = 70 kPa

 6. J11 & J19 Bend
 1. Inlet Elevation = 0 meters
 2. Type = Standard Elbow (knee, threaded)
 3. Angle = 90 Degrees

 7. J12-J15 General Components
 a. J12 Name = Generator #1
 b. J13 Name = Generator #2
 c. J14 Name = Generator #3
 d. J15 Name = Generator #4
 e. Library Jct = Metric - Generator
 f. Inlet Elevation = 0 meters

 8. J20 Reservoir
 a. Name = Return Tank
 b. Liquid Surface Elevation = 5 meters
 c. Liquid Surface Pressure = 1 atm
 d. Pipe Depth =  5 meters
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The system supplies lube oil to a bank of four generators. Each generator requires a flow rate of 115 
m3/hr. The auxiliary pump will not be turned on but the material and installation pump costs will be 
included in the cost report and automated sizing.

The system uses the following specifications:

 1. Minimum 70 kPa drop across the flow control valve
 2. Flow rate at each generator must be between 100 and 125 m3/hr
 3. The cost of the auxiliary pump and piping must be included in the sizing.
 4. The pump is expected to be about 80% efficient.
 5. The system uses lube oil with a specific gravity of 0.7 and viscosity of 0.29 kg/s-m.

 Step 6. Configure Sizing Settings

We want to first size our system to determine the required pump parameters, which will then be used to 
choose a pump model and perform a final sizing calculation.

To start, set up the model to size the pump system for life cycle cost. Select the Sizing tab.

A. Sizing Objective

The Sizing Objective panel should be selected by default from the navigation panel. Choose the settings 
as follows:

For the Sizing Option choose Perform Sizing.

For the Objective, choose Monetary Cost, and select the Minimize option from the drop-down list.

Under Options to Minimize Monetary Cost, choose Size for Initial and Recurring Costs. This should 
automatically configure the Cost Objective table to include the material, installation, and energy costs in 
the sizing.

Define a 10 year System Life.

For the Energy Cost area choose Use This Energy Cost Information, with a cost of 0.12 U.S. Dollars 
Per kW-hr.

B. Size/Cost Assignments

On the Sizing Navigation panel go to the Size/Cost Assignments panel.

We are designing a new system, so we want to include all of the pipes in the model for sizing.

ØSelect the All button at the bottom of the panel to select all pipes, then click Always Include in Cost 
at the top of the table to move all pipes to be included in the sizing calculation.

To decrease the analysis speed and reduce complexity, it is useful to create Common Size Groups to 
group the pipes in different sections of the model. For this system we want to create six groups to be 
sized, as can be seen in Figure 2 based on the pipe coloring, and Figure 3 based on the table. The 
groups were chosen by considering sections of pipe which would logically have similar demands due to 
the flow capacity and connected junctions.
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Create each of the groups by selecting the appropriate pipes in the Workspace, then right-clicking on the 
Workspace and choosing Add Pipes to Common Size Group -> New Group and giving the group a name. 
Alternatively the groups can be created on the Sizing window by clicking New to create and name the 
group, then adding pipes to the group using the radio buttons. The Size/Cost Assignments panel should 
appear as shown in Figure 3.

Figure 2: Workspace showing pipe groups by color

Figure 3: Size/Cost Assignments using Common Size Groups to simplify calculations

ØClick the Pumps button at the top of the panel to switch to the Pump Size and Cost Assignments. As 
stated earlier, we want to size both pumps, even though the Auxiliary Pump is not in use, so select 
Include in Cost Report and Sizing for each of the Pump junctions. Since the pumps are in parallel in 
this model, it is desired for the pumps to be the same size. This means that they will have the same mater-
ial and installation costs, though the maintenance cost will be different since the Auxiliary Pump is not reg-
ularly used, unlike the Primary Pump. To account for this we will need to create a Maximum Cost Group, 
which will set both pumps to use the cost information for the most expensive pump in the group. If a Max-
imum Cost Group is not used, then the Auxiliary Pump will have its material and installation costs set to 
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the lowest possible cost. (The cost at the pump is estimated using power, and the power at the Auxiliary 
Pump is set at zero since it is not in use during normal operation.)

ØCreate a New Maximum Cost Group named Pumps, and add the Material and Installation costs to it 
for each of the pumps, but under Maintenance, make sure to leave both pumps in the Not in Group 
column. The Pumps Size/Cost Assignments should appear as shown in Figure 4.

Figure 4: Pump Size/Cost Assignments with Maximum Cost Groups assigned

C. Candidate Sets

Go to the Candidate Sets panel.

For this system we will consider a range of Steel-ANSI schedule 40 pipes as candidates. To define this in 
Fathom, create a new Candidate set as follows:

 1. Create a new set by clicking New, and name the set Galvanized Steel Pipe 1-18 in.
 2. Select Steel - ANSI as the material from the drop-down list
 3. In the Available Material Sizes and Types, expand the sizes for schedule 40, then add each of the 

sizes from 1 inch to 18 inch by double clicking the names or selecting them and clicking Add>>.
 4. Click OK to finish editing the set.

In the bottom section of the panel, assign each of the Common Size Groups to the Galvanized Steel Pipe 
1-18 in Candidate Set. The panel should appear as shown in Figure 5.
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Figure 5: Candidate Sets panel fully defined for the model

D. Design Requirements

Go to the Design Requirements panel.

As can be seen above, this model has three given Design Requirements which need to be applied for the 
generators and control valve. Since we are not able to directly apply a flow rate design requirement on 
the generators, we will instead apply the flow rate requirements for the generators to the pipes adjacent 
to the generators. To do this:

 1. Make sure the Pipes button at the top of the window is selected.
 2. Click New under Define Pipe Design Requirements.
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 3. Enter the name Maximum Generator Flow.
 4. In the table for Parameter, select Volumetric Flow Rate.
 5. For Max/Min, choose Maximum, and enter 125 m3/hr.
 6. Repeat the process from steps 1-5 to define a Design Requirement for a Minimum generator flow 

rate of 100 m3/hr.

Now that the generator flow rate requirements are defined, apply them to the common size groups for the 
generator piping (Gen 1, Gen 2, Gen 3 and Gen 4) by checking the appropriate boxes in the Assign 
Design Requirements to Pipes section.

Click on the Control Valves button and create a New requirement named Minimum Pressure Drop to set 
the Pressure Drop Stagnation parameter to a Minimum of 70 kPa. Apply the Design Requirement to 
Control Valve J7.

E. Assign Cost Libraries

Go to the Assign Cost Libraries panel. For this model, the engineering and cost libraries have already 
been created, but we will need to check that they have been connected and applied properly.

ØOpen the Library Manager, and check that the engineering library Variable Drive is connected, indic-
ated by a check mark next to its name. If it is not connected, then check the box next to its name.

Next, connect to the three cost libraries. Click Add Existing Cost Library and navigate to the AFT Fathom 
13 Examples folder and add the cost libraries Variable Drive - Pump Costs.cst, Variable Drive - VFD 
Costs.cst, and Variable Drive - Pipe Costs.cst. The two cost libraries, Variable Drive - Pump Costs 
and Variable Drive - VFD Costs should be shown indented below the engineering library Variable Drive, 
and the Variable Drive - Pipe Costs library should be indented below Steel - ANSI. Once all of the neces-
sary libraries have been connected, click OK.

In the Assign Cost Libraries panel for the Pipes, All should be selected for the Galvanized Steel Pipe 1-18 
in Candidate Set, with the Variable Drive - Pipe Costs library being applied.

ØClick on the Pumps button to view the cost library assignments for the Pumps. We will only be using 
Variable Drive - Pump Costs for this scenario, so check the box for this cost library for both J4 and J5 to 
make sure that we are not applying any extra costs.

F. Sizing Method

Select the Sizing Method button to go to the corresponding panel.

ØChoose Discrete Sizing, since it is desired to select discrete sizes for each of the pipes in the model.

This model contains six design variables and 18 design requirements, so the best methods to choose 
from will be the MMFD or SQP method. 

ØSelect the default method, Modified Method of Feasible Directions (MMFD).
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 Step 7. Create Scenarios

Before running the model, create two child scenarios, one named Calculate Costs, Do Not Size and the 
other named Flow Control Valve Initial Cost Sizing. This will provide a comparison of the initial cost of the 
model without sizing, to the cost of the sized system.

Load the Calculate Costs, Do Not Size scenario and go to the Sizing window, then to the Sizing Objective 
panel. Select Calculate Costs, Do Not Size. We will run this scenario first.

 Step 8. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

 Step 9. Review the Not Sized and Initial Cost Sizing results

With all the pipes set to 6 inches the design requirements are met and the system is in a reasonable 
state. Navigate to the Cost Report tab and note that the total cost is $790,488.

Now load the Flow Control Valve Initial Cost Sizing scenario and go to the Sizing window to the Siz-
ing Objective panel. Under Options to Minimize Monetary Cost, choose Size for Initial Cost, Show 
Energy Costs. The scenario is now ready to be run.

Run the model, then click the Output button once the automated sizing is completed. 

After sizing the model for Initial Cost, the total cost over 10 years is now calculated as $728,970. The new 
pipe sizes and cost totals can be seen in Figure 6 below. 

Although this sized system uses larger pipe sizes, and therefore increased material and installation cost, 
than the initial design (4-8 inch versus only 6 inch), the savings comes from a the sized pump requiring 
much less power to operate. In one short simulation, the system was sized to meet all design require-
ments and reduce the cost by close to $60,000. 
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Figure 6: Pipe Sizes based on automated sizing for Initial Costs

 Step 10. Size the system based on lifetime cost

In the Scenario Manager on the Quick Access Panel, make a child scenario from the Base Scenario 
named Flow Control Valve Life Cycle Sizing. Load then run this scenario.

On the Output tab in the Cost Report, it can be seen that the total cost for this case is $613,160 using 
pipe sizes ranging from 8 inches to 12 inches, as can be seen in Figure 7. Though not shown, the Pump 
section of the Cost Report shows that the two pumps have been set to the same Material and Installation 
costs due to the Maximum Cost Group that was defined on the Size/Cost Assignments panel. Since the 
Initial Cost sizing results in a lifetime cost increase of about $50,000, the Life Cycle sizing results will be 
used for the pump configuration information to choose a pump from a manufacturer.
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Figure 7: Pipe Sizes based on automated sizing for Life Cycle Costs

 Step 11. Choose an Actual Pump for the System

Create a child scenario from the Flow Control Valve Life Cycle Sizing scenario, and name the new scen-
ario Flow Control Valve Real Pump. We will now need to update the Pumps and Control Valve with the 
settings for the proposed system. Load the new Flow Control Valve Real Pump scenario using the Scen-
ario Manager, then make the following changes:
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 1. For each of the pumps open the Pump Properties window and select Pump 450 m3/hr Real from 
the Library Jct list. This will copy the Pump Curve data into the pump. Click OK. Make sure to do 
the same for the second pump.

 2. Open the Control Valve and change the Valve Type to Flow Control (FCV) with a Volumetric 
Flow Rate of 450 m3/hr. Click OK

The model should now be ready for analysis. Run the model once more and go to the Output window to 
review the results, as can be seen in Figure 8 and Figure 9. Note that this scenario does take a bit longer 
to run than the sizing scenario. With data for the actual pump, the automated sizing finds a slightly more 
efficient design for the Life Cycle cost analysis by using 6 inch lines at some of the generators rather than 
8 inch lines, which provides approximately $20,000 reduction in cost from the sizing scenario. Note that 
the Overall Efficiency is 83% for the real pump compared to the assumed 80% of the original sizing 
pump.

Figure 8: Pump Summary for operation of actual pump

Figure 9: Output for automated sizing with actual pump curve entered
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 Step 12. Compare Cost Using a VFD Pump

As a final step we will compare an alternate VFD model for the pump to analyze the cost savings which 
can be achieved by using a VFD instead of using a flow control valve. To start, make an additional child 
scenario from the FCV Life Cycle Sizing scenario, and name it VFD Pump. Complete the following steps 
to update the model:

 1. Go to the Workspace. For each of the pumps, open the Pump Properties window and choose the 
Pump 450 m3/hr VFD Real pump from the Library Jct list. Click OK

 2. Open the Control Valve Properties window. On the Optional tab set the Special Condition to Fully 
Open - No Control. Click OK.

 3. Go to the Sizing window, and go to the Design Requirements panel. For the Control Valve 
uncheck the box for the minimum pressure drop requirement, since the control valve is not active.

 4. Navigate to the Assign Cost Libraries panel. We will need to represent the additional Mater-
ial/Installation costs for the VFD, so change the Libraries to All so that all libraries will be applied 
for each of the pumps.

The changes for this scenario should now be complete. Run the model once more and go to the Output 
window to review the results. With the VFD Pump being used, the sizing for the pipes is actually the 
same as the FCV Life Cycle Sizing scenario. However, the cost is significantly decreased to $485,016. 
This is primarily due to the decreased speed of the pump, as can be seen in Figure 10.

Figure 10: Pump summary for operation of VFD pump

Summary

A summary of the total costs for each of the scenarios can be seen in Table 1. It can be seen from the 
table that this particular system over its 10 year life span is heavily weighted towards operational costs; 
as the operational costs are further decreased the overall cost for the system decreases, even though 
the initial costs may be increased.
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Table 1: Summary of Automated Sizing Results for Lube Oil System in thousands of dollars

Life Cycle 
Cost (U.S. 
Dollars)

Feasible? Material Installation Total Non-
Recurring Operation/Energy

Total 
Life 

Cycle

Calculate 
Costs, Do 
Not Size

Yes 34,598 14,148 48,746 741,742 790,488

Flow Con-
trol Valve Ini-

tial Cost 
Sizing

Yes 33,148 12,698 45,846 683,124 728,970

Flow Con-
trol Valve 
Life Cycle 

Sizing

Yes 44,778 16,407 61,185 551,975 613,160

Flow Con-
trol Valve 

Real Pump
Yes 46,190 16,073 62,182 530,726 592,908

Variable Fre-
quency 

Drive Pump
Yes 46,190 16,073 62,182 422,834 485,016
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Housing Project - ANS 

Summary

This example will size the pipes for a water supply system to a housing development. This example has 
three operating states. These states are the following:

 1. No fire hydrants open, supply to each house is 2.5 m3/hr with a minimum pressure of 4.0 barG 
(400 kPa(g)). 

 2. North Hydrant open with 20 m3/hr at 6.2 barG (620 kPa(g)), supply to each house is 0.5 m3/hr, no 
minimum pressure. 

 3. South Hydrant open with 20 m3/hr at 6.2 barG (620 kPa(g)), supply to each house is 0.5 m3/hr, no 
minimum pressure. 

For this example, we will evaluate all three conditions. First, we will use the ANS module to size the sys-
tem assuming a requirement to use only one pipe size throughout. After this we will size the pipes assum-
ing the pipes can be three different sizes. 

Note: This example can only be run if you have a license for the ANS module.

Topics Covered

 l Using Dependent Design Cases to satisfy multiple operating modes for a system 
 l Using the Scenario Manager to size a system for multiple sets of system requirements 
 l Understanding the effects of Common Size groups on sizing 

Required Knowledge

This example assumes the user has already worked through the Walk-Through Examples section, and 
has a level of knowledge consistent with the topics covered there. If this is not the case, please review 
the Walk-Through Examples, beginning with the Beginner - Three Reservoir example. You can also 
watch the AFT Fathom Quick Start Video Tutorial Series on the AFT website, as it covers the majority of 
the topics discussed in the Three-Reservoir Model example.

In addition, it is assumed that the user has worked through the Beginner - Three-Reservoir - ANS 
example, and is familiar with the basics of ANS analysis.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

https://www.aft.com/products/fathom/video-tutorial-series
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 l Metric - Housing Project.fth
 l Metric - Housing Project - ANS.fth
 l Housing Project Costs.cst - cost library for PVC - ASTM pipes

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Open the model

Open the Metric - Housing Project.fth example file and save it as a new file. We will not need the exist-
ing child scenarios for this example: right click on the Base Scenario in the Scenario Manager and select 
Delete All Children. Make sure that the Workspace looks like Figure 1 below:

Figure 1: Model layout for normal system operation

This example consists of a reservoir that supplies water to 10 houses and two fire hydrants. All the pipes 
in the system are Schedule 40 PVC pipe. The supply line to each house is set to 1 inch PVC. The auto-
mated sizing of this system will only be used to size the supply line from the reservoir, the neighborhood 
mains and hydrants.
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As mentioned in the introduction, the supply to each house with no fire hydrants open (i.e., the Normal 
Flow case) is 2.5 m3/hr with a minimum pressure of 4.0 barG (400 kPa(g)). The model can be set up in 
two ways; 

 1. Each house could be represented as an assigned flow with a minimum pressure constraint placed 
on the supply pipe to each house (as done here), or, 

 2. Each house can be represented as an assigned pressure with a minimum flow constraint placed 
on the pipe. 

The first option was chosen because with either fire hydrant open, there is still an assigned flow on each 
house but there is no minimum pressure.  

 Step 3. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate ANS and select Network to enable the ANS module for use. A 
new group will appear in Analysis Setup titled Automatic Sizing. Click OK to save the changes and exit 
Analysis Setup. A new Primary Window tab will appear between Workspace and Model Data titled Siz-
ing. Open the Analysis menu to see the new option called Automatic Sizing. From here you can quickly 
toggle between Not Used mode (normal AFT Fathom) and Network (ANS mode).

 Step 4. Configure Sizing Settings

For this system we will be sizing the neighborhood mains for three different operating cases, one for nor-
mal operation, and two different cases with hydrants in use. When modeling multiple design cases, the 
different cases need to be broken up into a primary design case, of which there is one, and dependent 
design cases, of which there can be any number.

The primary design case can be any of the design cases that are being addressed in your model. Typ-
ically, it will represent the primary operating condition of the pipe system. If it is not clear which case 
should be the primary case, just pick any of the cases and call that the primary one. Design cases other 
than the primary case are referred to as dependent design cases. This naming convention is used since 
the dependent design cases are built and defined by duplicating the primary design case, as will be dis-
cussed later. The normal flow case will be used as the primary design case, so we will start setting up the 
sizing settings based on the requirements for normal operation.

A. Sizing Objective

Go to the Sizing window and the Sizing Objective panel should open by default. For this analysis, we are 
interested in sizing the system considering the monetary cost for the initial costs only.

 1. Set the Sizing Option to Perform Sizing, if not already.
 2. For the Objective, choose Monetary Cost, and make sure Minimize is selected from the drop-

down list.
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 3. Under Options to Minimize Monetary Cost, choose Size for Initial Cost. This will update the cost 
table to include both initial costs in the sizing calculation while ignoring the recurring costs.

The Sizing Objective window should now appear as shown in Figure 2.

Figure 2: Sizing Objective window setup for an Initial Cost analysis

B. Size/Cost Assignment
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On the toolbar at the bottom of the window select the Size/Cost Assignments. For this scenario we will 
size the neighborhood mains, system supply line and hydrant supply lines assuming that they are all the 
same size. The supply lines to the houses must be 1" PVC so they will not be sized, but we will still cal-
culate the costs, since we will need to purchase that piping as well.

 1. Go to the Workspace, and select the lines that will be sized as shown in Figure 3. 
 2. Right click the Workspace and choose Add Pipe(s) to Common Size Group, and select New 

Group. Give the group the name Neighborhood Mains. Click OK on the Information window that 
appears.

 3. Return to the Sizing window. The neighborhood mains, supply line, and the hydrant supply lines  
should now all be included in the new pipe group, and should be moved to Always Include in Cost 
as shown in Figure 4.

 4. Move each of the house supply lines to Do Not Size - Include in Cost. All of the pipes can be 
moved at once by using the shift key to highlight all of the rows, then clicking the Include in Cost 
button.

We are not considering any of the junctions as part of the sizing, so the Size/Cost Assignments are com-
plete for now.

Note: Though the hydrant supply lines are closed in the primary design case, we need to include them 
in the Common Size Group so that they will be sized when we create the dependent design 
cases for the open hydrant cases.

Figure 3: Workspace with pipes selected to add to the Common Size Group
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Figure 4: Size/Cost Assignments window with Common Size Groups defined as outlined above

C. Candidate Sets

Click on Candidate Sets to open the Candidate Sets panel. In this case we will be considering schedule 
40 PVC pipe within the range of 1" to 10".

 1. Select New, and name the candidate set PVC sch 40.
 2. Choose PVC - ASTM from the material list.
 3. At the bottom of the window select to sort by Type, Schedule, Class (if not already selected).
 4. Expand the schedule 40 type, then double click each of the sizes from 1 inch to 10 inch to add 

them to the Candidate Set.
 5. Click OK to accept the defined set.

In the bottom section of the window make sure that the Common Size Group is assigned to use the new 
PVC sch 40 Candidate Set. The window should appear as shown in Figure 5.
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Figure 5: Candidate Sets window fully defined for the model

D. Define Design Requirements

Select Design Requirements.

For the standard operation scenario the only design requirement is for the minimum supply pressure of 
4.0 barG (400 kPa(g)) to each of the houses. With the Pipes button selected click New to add a House 
Supply Design Requirement specifying the Pressure Static at the Outlet of the pipe to a Minimum 
value of 4.0 barG (400 kPa (g)). 

Click New again to create a second Design Requirement named Fire Supply specifying the Pressure 
Static at the Outlet of the pipe to a Minimum value of 6.2 barG (620 kPa (g)). We will apply this require-
ment later when the dependent design cases are created.

In the bottom section of the window, make sure that the House Supply Design Requirement is applied to 
only the supply lines to the houses and not the Neighborhood Mains, as shown in Figure 6. 
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Figure 6: Design Requirements defined for the primary design case

E. Assign Cost Libraries

Select Assign Cost Libraries. For this model the pipe cost library has already been created, but we will 
need to connect and apply it.

ØOpen the Library Manager by clicking the Library Manager button to see which libraries are con-
nected.

This example uses a pre-built cost library for the pipes containing the PVC material costs. To connect the 
library do the following:

 1. Click Add Existing Cost Library.
 2. Browse to the Fathom 13 Examples folder (located by default in C:\AFT Products\AFT Fathom 

13\Examples\), and open the file titled Housing Project Costs.cst. 

The new library should now be visible in the  list and be connected to the model, indicated with a box 
checked next to the name, as shown in Figure 7. The cost library for the pipes should appear with the 
name Housing Project Costs.cst and be indented under the PVC - ASTM library within the standard 
pipe material library list.

Once you have confirmed that the library is connected, click Close to exit the Library Manager.
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Figure 7: Library Manager with Housing Project Costs library connected

Back in the Assign Cost Libraries panel for the Pipes, the Housing Project Costs library should be the 
only available cost library, and should be selected to show that it is being applied to the candidate set and 
to each of the house supply lines.

F. Sizing Method

Select Sizing Method to go to the Sizing Method panel.

Ensure that Discrete Sizing is chosen with the Modified Method of Feasible Directions (MMFD) for 
the Search Method.

G. Dependent Design Cases

We have now set up the system to be sized for the primary design case, but we will also need to account 
for the cases where either the north or south hydrant are in use. There are a few changes that occur for 
each of these cases where a hydrant is in use:

 1. The flow rate at each of the houses decreases to 0.5 m3/hr
 2. The minimum inlet pressure for each of the hydrants must be 6.2 barG (620 kPa(g))
 3. The minimum pressure for each of the houses is removed
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We will create two dependent design cases to account for the scenarios where the North Hydrant or the 
South Hydrant is open. To make the dependent design cases complete the following:

 1. Go to the Sizing Objective panel and click the box next to Enable Dependent Design Case. A 
new button will now be available for the Dependent Design Cases panel in the Sizing Navigation 
panel.

 2. Navigate to the Dependent Design Case panel. You should now see instructions displayed to cre-
ate Dependent Design Cases, along with a summary table of dependent design settings. We will 
now need to use the Duplicate Special feature to create the dependent design cases.

 3. Go to the Workspace and go to the Edit menu and choose Select All.
 4. Go to the Edit menu again and select Duplicate Special, enter an increment of 400 and click the 

boxes next to Make Dependent Design Case and Clear Design Requirements (Figure 8). Click 
OK. 

 5. Move the duplicated pipes and junctions below the original ones on the Workspace to distinguish 
them from the Primary Design Case. Click Paste.

 6. Select only the primary design case model and repeat steps 4 and 5 to create a second depend-
ent design case (increment the pipe numbers by 1000 to avoid conflicting pipe numbers). There 
should now be two copies of the original model in the Workspace which will be used to represent 
the alternate operating cases.

 7. Open the J599 and J1299 hydrants by selecting them and toggling the Special Condition to 
None so that the North Hydrant is open in the second case and the South Hydrant is open in the 
third case.

 8. Use Global Junction Edit to change all 20 of the Assigned Flow junctions at the Dependent 
Design Case homes (junctions 500's, 600's, 1100's, and 1200's) to an Outflow of 0.5 m3/hr (see 
Figure 9). Make sure to not change the Assigned Flow junctions that represent the hydrants.

 9. In the Sizing window navigate to the Design Requirements panel. Assign the Fire Supply 
Design Requirement created earlier to pipe P599 and P1299 by checking the adjacent boxes.

Return to the Dependent Design Cases panel.

When Duplicate Special was performed with Dependent Design Case (DDC) selected, each of the duplic-
ated pipes was created with a special type of grouping. For example, pipes 401 and 1001 were grouped 
with pipe 1 as DDC pipes (see Figure 10). This type of assignment allows the dependent design pipes to 
be sized, but to not be counted in the cost so that the cost will not be duplicated.
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Figure 8: Duplicate Special settings to create a dependent design case
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Figure 9: Global Junction Edit is used to change the flows in the homes for the dependent cases
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Figure 10: Pipes in Dependent Design Cases have a special grouping relationship with pipes in the primary 
case

 Step 5. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 
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 Step 6. Review the Sized Results

After the run finishes, examine the final pipe sizes calculated by the ANS module. The results for pipe 
size and overall cost are shown in Figure 11. One can see that the resultant size is 4-inch pipe. The lines 
to the houses are listed as N/A on the sizing output since they were not included in the sizing.

The cost for all sized pipes is $63,892. This is the cost for Items in Sizing. Since we did not size the pipes 
to the homes (because these were fixed at 1- inch), there is an additional cost of $7,161 for Items Not In 
Sizing. The pipes that were sized will be distinguished in the Cost Report by having a green background 
color. The total cost is merely the sum of the two: $71,053.

It should be noted that if we did not have monetary cost information for the pipes in this example, we 
could get nearly identical sizing results for this system by choosing a non-monetary objective. A mon-
etary cost objective is primarily necessary in order to size equipment like pumps, control valves, etc. with 
the pipes.
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Figure 11: Cost summary and final pipe sizes

 Step 7. Increase the Independent Pipe Sizes

To increase savings in the system we can remove some of the pipes from the Common Size Group, 
which will allow them to be varied separately and increase the number of Independent Pipe Sizes for the 
model.

Let's create a child scenario to see how much savings can be found. 

In the Scenario Manager, right-click the Two Hydrants scenario, click Create Child, and name it 3 Pipe 
Sizes. Navigate to the Size/Cost Assignments panel in the Sizing window. Unlock the panel if it has 
been locked and move pipe P1 to Not in Group. Lastly, create a new Common Size Group by clicking 
New, naming it Hydrant Pipes, and moving pipes P199 and P299 to the new group.

Run the scenario and go to the Output to view the results.

The Cost Report and pipe size results for the 3 Pipe Sizes scenario shown in Figure 12. The total cost is 
the cost per unit length for material and installation multiplied by the length of each section. The cost data 
does not include excavation costs. Even with these rough costs, significant savings can be achieved. If 
the developer is willing to use three pipe sizes, the savings will be approximately $2,500 or 3.5% of the 
total cost. 

With this example, we can see that the limitations placed on the system by Common Size Groups can 
impact the sizing results. 

In theory, to obtain the best possible sizing results, one can ungroup all the pipes in the neighborhood 
and allow each pipe to be sized independently. However, in practice this can result in increased fittings, 
installation, and maintenance costs, which is why common size groups are desirable.
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Figure 12: Cost Report and pipe sizes for the system with three independently varied pipe sizes
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Combined Modules Examples
The examples below utilize multiple AFT Fathom modules.

Combined Module Examples

Example Complexity Fluid Pipes Pumps Description

Fixed Head Sup-
ply Tank Advanced Water 3 1

Learn how to use the GSC 
module, XTS module, and 
cost calculations together to 
model system performance 
over time.

Fixed Head Supply Tank - GSC XTS 

Summary

Previous examples have illustrated how to use each of the AFT Fathom modules by themselves. 
However, AFT Fathom also allows you to use the modules together, in any combination you choose. This 
allows even greater flexibility in the types of analyses that can be accomplished using AFT Fathom.

This example shows how the GSC and XTS modules and cost calculations can be performed sim-
ultaneously by examining a fixed head supply tank system.

A process plant requires the delivery of water at a fixed head, regardless of the system demand. This is 
accomplished by pumping the water to a supply reservoir, and maintaining a constant fill-level by varying 
the supply pump speed as the process demands change. Throughout any 24-hour period the process 
demands vary from as little as 115 m3/hr to peak demands of 570 m3/hr.

Use the GSC and XTS modules to analyze the system performance over a 24-hour period. Perform cost 
calculations to determine the energy costs for the pump with this daily operation over one year.

Note: This example can only be run if you have licenses for the GSC and XTS modules.

Topics Covered

 l Using the GSC and XTS modules and performing cost calculations simultaneously

Required Knowledge

This example assumes the user has already worked through the Beginner - Three Reservoir example, or 
has a level of knowledge consistent with that topic. You can also watch the AFT Fathom Quick Start 
Video Tutorial Series on the AFT website, as it covers the majority of the topics discussed in the Three-
Reservoir Problem example.

https://www.aft.com/products/fathom/video-tutorial-series
https://www.aft.com/products/fathom/video-tutorial-series
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In addition, it is assumed that the user has worked through the Beginner -Filling a Tank - XTS example, 
the Beginner - Heat Transfer in a Pipe - GSC example, and the Beginner - Cost Calculation example and 
is familiar with the basics of GSC, XTS module, and cost calculation analyses.

Model Files

This example uses the following files, which are installed in the Examples folder as part of the AFT 
Fathom installation:

 l Metric - Fixed Head Supply Tank - GSC XTS.fth

 Step 1. Start AFT Fathom

From the Start Menu choose the AFT Fathom 13 folder and select AFT Fathom 13.

To ensure that your results are the same as those presented in this documentation, this example should 
be run using all default AFT Fathom settings, unless you are specifically instructed to do otherwise.

 Step 2. Define the Modules Panel

Open Analysis Setup from the toolbar or from the Analysis menu. Navigate to the Modules panel. For this 
example, check the box next to Activate GSC and Activate XTS. Make sure Use is selected for GSC and 
Transient is selected for XTS. Two new groups will appear in Analysis Setup titled Goal Seek and Control 
and Transient Control. Click OK to save the changes and exit Analysis Setup. Open the Analysis menu to 
see the two new options called Goal Seek & Control and Time Simulation. From here you can quickly 
toggle between Ignore (normal AFT Fathom) and Use (GSC mode) for GSC and between Steady Only 
(normal AFT Fathom) and Transient (XTS mode).

 Step 3. Define the Fluid Properties Group

 1. Open Analysis Setup from the toolbar or from the Analysis menu.
 2. Open the Fluid panel then define the fluid:

 a. Fluid Library = AFT Standard
 b. Fluid = Water (liquid)

 i. After selecting, click Add to Model
 c. Temperature = 21 deg. C

 Step 4. Define the Pipes and Junctions Group

At this point, the first two groups are completed in Analysis Setup. The next undefined group is the Pipes 
and Junctions group. To define this group, the model needs to be assembled with all pipes and junctions 
fully defined. Click OK to save and exit Analysis Setup then assemble the model on the workspace as 
shown in the figure below.
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Figure 1: Fixed Head Supply Tank model layout

Pipe Properties

 1. Pipe Model tab
 a. Pipe Material = Steel - ANSI
 b. Pipe Geometry = Cylindrical Pipe
 c. Size = 5 inch 
 d. Type = STD (schedule 40)
 e. Friction Model Data Set = Standard
 f. Lengths =

Pipe Length (meters)

1 9

2 150

3 30

Junction Properties
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 1. J1 Reservoir

 a. Tank Model = Infinite Reservoir
 b. Liquid Surface Elevation = 9  meters
 c. Liquid Surface Pressure = 0 barG
 d. Pipe Depth =  9 meters

 2. J2 Pump
 a. Inlet Elevation = 0 meters
 b. Pump Model = Centrifugal (Rotodynamic)
 c. Analysis Type = Pump Curve
 d. Enter Curve Data = 

Volumetric Head Efficiency

m3/hr meters Percent

0 150 0

280  60

570 145 80

850  70

1135 75 40

 e. Curve Fit Order = 2

 3. J3 Reservoir

 a. Name = Supply Tank
 b. Tank Model = Finite Open Tank
 c. Known Parameters Initially = Both Parameters (Liquid Surface Level & Surface Pressure)
 d. Cross-Sectional Area = Constant,  29 meters2
 e. Liquid Level Specification = Height from Bottom
 f. Liquid Height =  5 meters

 g. Liquid Surface Pressure = 0 barG
 h. Tank Height =  6 meters
 i. Pipe Depth = 5 meters
 j. Tank Bottom Elevation =  6 meters

 3. J4 Assigned Flow

 1. Elevation = 0 meters
 2. Type = Outflow
 3. Flow Specification = Volumetric Flow Rate
 4. Flow Rate = 115 m3/hr
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 Step 5. Define the Goal Seek and Control Group

Specify the variables and goals for the model.

Variables Panel

Open the Variables panel in the Goal Seek and Control group in Analysis Setup. For this example, we will 
be adding one pump variable: pump speed.

Click New Variable and change the Junction Type to Pump. By default, J2 (Pump) and Variable Speed 
will be selected for Object Number and Name and Variable Parameter, respectively. The Variables panel 
should look now like Figure 2.

Figure 2: Defined Variables panel

Goals Panel

Navigate to the Goals panel. The desired goal is for the net volumetric flow rate into the junction to be 
zero, which will keep the water level in the tank constant.

Click New Goal and change the Object Type or Reservoir. By default, Vol. Flow Rate New Into Jct 
should be the selected Goal Parameter. Enter 0 as the Goal Value and select J3 (Supply Tank) for the 
Object ID. The Goals panel should now look like Figure 3.
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Figure 3: Defined Goals panel

 Step 6. Define the Transient Control Group

The XTS module is used to model the process demand changes over the 24-hour analysis period. Nav-
igate to the Simulation Duration panel in the Transient Control group to view the Transient Control set-
tings. Change the Start Time units to hours and enter a Stop Time of 24. For Time Step, changes the 
units to minutes and enter 10. The Simulation Duration panel should now look like Figure 4. The tran-
sient analysis is now set to run for a period of 24-hours with a time step of 10 minutes. Click OK to save 
and close Analysis Setup.

Figure 4: Transient Control settings for a 24-hour period
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 Step 7. Junction Transient Data

The flow variation in this model is driven by the J4 Assigned Flow junction. Open the J4 Assigned Flow 
Properties window and select the Transient tab. The process flow demands are modeled as time-varying 
flows. The flow profile over the 24-hour period is defined in the Transient Data table. Use Table 1 below 
to fill in the Transient Data table. Then, click Show Graph and make sure the Junction J4 Transient Data 
graph matches Figure 5.

Note that the time units are in seconds. Alternatively, you can change the preferred time units in User 
Options from seconds to hours to change the units of this table, then enter the values in this table in 
hours instead. However, to keep to the default units, this table is provided in time units of seconds.

Table 1: Transient Data table for J4 Assigned Flow

Data Point Time (seconds) Vol. Flow (m3/hr)

1 0 115

2 7200 115

3 14400 340

4 25200 450

5 28800 450

6 32400 570

7 43200 230

8 50400 115

9 57600 115

10 64800 340

11 68400 450

12 75600 450

13 82800 230

14 86400 115
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Figure 5: Flow demand over 24 hours at the J4 junction

In addition, the J3 Reservoir junction is modeled as a finite reservoir (Figure 6). The J3 Reservoir can 
potentially drain and fill, and the varying pump speed (and, hence, flow) is what will keep its liquid level at 
15 feet. No further input is required for the Supply Tank.
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Figure 6: J3 Reservoir junction is finite, which means it can drain and fill

 Step 8. Cost Settings

For this problem, the pump energy cost for the 24-hour analysis period is entered as a fixed energy cost 
on the Cost Settings panel. Open the Cost Settings panel from the Analysis Setup window to view the 
energy cost settings.

For Cost Calculation, select Calculate. Under Cost Definitions, check the box for Operation/Energy 
because that is the only cost of interest for this example.

Set the Cost Time Period System Life to 1 year. The 24-hour operation is assumed to repeat every day 
for this one-year period, and the total energy cost will be calculated assuming the 24-hour operation 
repeats non-stop throughout the year. More complicated cost variation is possible when using energy 
cost libraries.

For Energy Cost, make sure Use This Energy Cost Information is selected and enter a Cost of 0.12 
U.S. Dollars Per kW-hr.

The Cost Setting panel should now look like Figure 7 below.
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Figure 7: Cost Settings window applies Operation/Energy cost, can set the energy cost, and specifies the 
cost time period

Return to the Workspace and open the properties window for Pump J2. Navigate to the Cost tab and 
under Cost Report, select Include Cost in Report. Click OK.

 Step 9. Run the Model

Click Run Model on the toolbar or from the Analysis menu. This will open the Solution Progress window. 
This window allows you to watch as the AFT Fathom solver converges on the answer. Now view the res-
ults by clicking the Output button at the bottom of the Solution Progress window. 

Note: When the GSC and XTS modules are used simultaneously, the GSC module is rerun for each 
time step. The GSC module variables are recalculated for the system conditions at each time 
step to ensure the specified goals are always met. This will typically result in longer run times, 
due to the increase in solution iterations that must be solved for each time step analysis.

 Step 10. Examine the Output

When using multiple modules, the goal seek, transient and cost analysis results are shown in the Output 
window in the same manner as when they are used individually.

First open Output Control and go to the Format & Action tab. In the Time Simulation Formatting section, 
change the units to hours. Now all time units for XTS related output parameters will be shown using time 
units of hours.

The GSC variable and goal results in the General Output section can be viewed for each time step by 
using the slider bar at the bottom of the Output window, as shown in Figure 8.
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Figure 8: The slider bar at the bottom of the Output window can be used to view the transient results at any 
time step, including the GSC module variable and goal results. The GSC variable results for Time = 0 hours 

and Time = 12 hours are shown

Cost data is displayed in the Cost Report in the General Output section, as shown in Figure 9. The one-
year energy cost for the supply pump in this example was $76,457.

Figure 9: The cost data is shown in the Cost Report in the General Output section of the Output window

Figure 10 shows how the GSC module varied the pump's speed over time with the varying process flow 
rate. 

Figure 11 shows that the water level in the process supply tank changes little over time because the net 
volumetric flow is held constant. The pump speed changes to increase and decrease the flow in order to 
keep the net flow into the Supply Tank zero. The minor changes in tank level are a result of the Forward 
Difference tank level calculation and can be reduced using the Central Difference method and a finer 
time step. These can be adjusted within the Transient Control section of Analysis Setup.
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Figure 10: The GSC module varies the supply pump speed as the process flow rate changes over time (top)
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Figure 11: The water level in the process supply tank (left axis) remains relatively constant over time and the 
net volumetric flow rate (right axis) remains exactly at zero due to the variation in the pump speed

Summary

Individually, the AFT Fathom modules provide you with powerful analytical tools to assist you in the 
design of your pipe systems. The ability to combine the capabilities of these tools provides you with even 
greater and more powerful modeling capabilities.
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